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Preface
This guide explains how to install and use the Sun StorageTek RAID Manager
software, as well as the Adaptec BIOS RAID configuration utility. You can use this
software to manage Intel Adaptec host-bus adapters (HBAs) and create RAID
volumes and arrays.

Terminology Used in This Guide
Many of the terms and concepts referred to in this document are known to computer
users by multiple names. In this document, this terminology is used:
■

HBA (also known as adapter, controller, board, or card)

■

Disk drive (also known as hard disk, hard drive, physical drive, or hard disk
drive)

■

Logical drive (also known as logical device)

■

System (also known as a server, workstation, or computer)

■

Enclosure (also known as a JBOD, storage enclosure, or disk enclosure)

■

Internal RAID storage (also known as direct-attached storage or DAS)

xxv

Documentation, Support, and Training
Sun Function

URL

Documentation

http://www.sun.com/documentation/

Support

http://www.sun.com/support/

Training

http://www.sun.com/training/

Sun Welcomes Your Comments
Sun is interested in improving its documentation and welcomes your comments and
suggestions. You can submit your comments by going to:
http://www.sun.com/hwdocs/feedback
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I

Sun StorageTek RAID Manager Software

This part describes how to use the Sun StorageTek RAID Manager software. It
includes the following chapters:
■

“Introduction” on page 1-1

■

“Installing and Starting the Software” on page 2-9

■

“Exploring the Software” on page 3-23

■

“Building a Storage Space” on page 4-35

■

“Customizing the Software” on page 5-51

■

“Managing Logical Drives and Hot-Spares” on page 6-63

■

“Protecting Data” on page 7-89

■

“Monitoring Storage Space” on page 8-93

■

“Managing Tasks” on page 9-121

■

“Working with Display Groups” on page 10-131

■

“Managing HBAs, Disk Drives, and Enclosures” on page 11-137

■

“Configuring SNMP Support” on page 12-153

■

“Troubleshooting” on page 13-157

■

“Frequently Asked Questions” on page 14-175

■

“Buttons and Icons At-a-Glance” on page 15-185

CHAPTER

1

Introduction
This chapter describes the Sun StorageTek RAID Manager graphical user interface
(GUI) software and its agent, explains the concept of a storage space, and provides a
list of getting-started tasks. The chapter contains the following sections:
■

“Getting Started Tasks” on page 1

■

“About the GUI Versus the BIOS Utility” on page 2

■

“About the Sun StorageTek RAID Manager GUI Software” on page 2

■

“About the Agent” on page 3

■

“Growing Your Storage Space With the Software” on page 4

■

“System Requirements” on page 8

Getting Started Tasks
The following tasks enable you to get started with the Sun StorageTek RAID
Manager software:
1. Familiarize yourself with the software and its agent.
For more information, see the remainder of this chapter.
2. Install the software on every system that will be part of your storage space.
3. Start the software, or the agent only, on those systems.
For more information, see “Installing and Starting the Software” on page 9.
4. Explore the features of the software.
For more information, see “Exploring the Software” on page 23.
5. Build your storage space.
For more information, see “Building a Storage Space” on page 35.
1

6. Optionally customize the software and the agent.
For more information, see “Customizing the Software” on page 51.

About the GUI Versus the BIOS Utility
You can use the Sun StorageTek RAID Manager GUI or the BIOS Configuration
Utility to build your storage space. The Sun StorageTek RAID Manager is a software
application that enables you to create and manage your storage space and then
monitor the storage from a single location. The BIOS Configuration Utility is a BIOSbased utility that enables you to create and manage controllers, disk drives, and
arrays.
If you use the BIOS Configuration Utility to create arrays, the Sun StorageTek RAID
Manager GUI detects those arrays and displays them as logical drives in the GUI.
For more information about the BIOS utility, see the Sun StorageTek SAS RAID HBA
Installation Guide Eight-Port, Internal HBA or Sun StorageTek SAS RAID HBA
Installation Guide Eight-Port, External HBA.

Note – The Sun StorageTek RAID Manager GUI is not supported with the VMware
technology. To configure your storage space with the VMware technology, use the
command-line interface (CLI) and the BIOS Configuration Utility. The CLI is
installed as part of the Sun StorageTek RAID Manager software installation. For
more information about the CLI, see the Uniform Command-Line Interface User’s Guide
at: http://docs.sun.com/app/docs/prod/stortek.raid.hba#hic

About the Sun StorageTek RAID
Manager GUI Software
The Sun StorageTek RAID Manager software is a graphical user interface (GUI) that
helps you build a storage space for online data, using RAID HBAs, disk drives, and
enclosures. Your storage space can include direct-attached—or internal
RAID—storage.
With the Sun StorageTek RAID Manager software, you can group disk drives into
logical drives and build in redundancy to protect your data and improve system
performance. You can also use the software to monitor and manage all the HBAs,
enclosures, and disk drives in your storage space from a single location.
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About the Agent
You can use the Sun StorageTek RAID Manager software to manage both internal
and external RAID storage. This document describes how to install and use the Sun
StorageTek RAID Manager software to build and manage internal RAID storage in
systems similar to the basic configurations shown in these figures:
FIGURE 1-1

RAID HBA Configuration

When the Sun StorageTek RAID Manager software is installed on a system, the Sun
StorageTek RAID Manager Agent is also installed automatically. The Agent is like a
service that keeps the storage space running. It’s designed to run in the background,
without user intervention, and its job is to monitor and manage system health, event
notifications, tasks schedules, and other on-going processes on that system. It sends
notices when tasks are completed successfully, and sounds an alarm when errors or
failures occur on that system.
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The Agent uses less memory than the full application. If your storage space includes
systems that are not connected to monitors (and therefore do not require the user
interface described in this document), you can choose to run the Agent only on those
systems instead of the full application (see “About the Agent” on page 3). You may
want to do this if system resources are limited, or if you want more system resources
available for other tasks.

Note – On Linux or UNIX systems: If your storage space includes systems without
X-Windows installed or running, you can run the Agent, even though you cannot
run the full Sun StorageTek RAID Manager software application.
You can manage and monitor systems running the Agent only by logging into them
as remote systems (see “Logging Into Remote Systems” on page 51).
You can also customize the Agent settings to suit your storage space requirements
(see “Customizing the Agent” on page 58).

Growing Your Storage Space With the
Software
As your requirements change, the Sun StorageTek RAID Manager software grows
with your storage space as you add more HBAs, more disk drives, more logical
drives, and more data protection.

A Simple Storage Space
This example shows a simple storage space that might be appropriate in a home
office or for a small business. This storage space includes one RAID HBA and three
disk drives installed in a server. For data protection, the disk drives have been used
to build a RAID 5 logical drive.

4
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FIGURE 1-2

Simple Storage Space Configuration

An Advanced Storage Space
This example shows how you can grow storage space to meet the expanding
requirements of your business. On the first server, segments of space from each disk
drive have been used to build two RAID 5 logical drives. A second server connected
to two 12-disk-drive enclosures has been added. The additional storage space has
been used to create two RAID 50 logical drives. The Administrator of this storage
space can create and modify logical drives and monitor both HBAs, disk drives, and
enclosures from a single system, called the local system (see “Logging Into Remote
Systems” on page 51).
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FIGURE 1-3

Advanced Storage Space Configuration

Continuing to Grow Your Storage Space
As your needs change, the Sun StorageTek RAID Manager software will help you
grow storage space to include multiple HBAs, storage enclosures, and disk drives in
multiple locations.
In this example, multiple systems, servers, disk drives, and enclosures have been
added to the storage space. The Administrator can create and modify logical drives
and monitor all the HBAs, enclosures, and disk drives in the storage space from the
local system (see “Logging Into Remote Systems” on page 51).
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FIGURE 1-4

Multisystem Storage Space Configuration
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System Requirements
To install the Sun StorageTek RAID Manager software and create a RAID storage
space, each system in your storage space must meet these requirements:
■

Computer with 1.2 GHz processor, or equivalent

■

1 GB of RAM, at minimum

■

100 MB of free disk drive space

■

256-color video mode

■

One of these OS with the minimum specified versions:
■

Microsoft Windows Server 2003, Standard Edition, 32-bit or 64-bit

■

Microsoft Windows Server 2003, Enterprise Edition, 32-bit or 64-bit

■

Red Hat Enterprise Linux (RHEL) 4 ES, 32-bit and 64-bit

■

RHEL 4 AS Update 5, 32-bit and 64-bit

■

RHEL 5 Server, 32-bit and 64-bit

■

RHEL 5 Advanced Platform, 32-bit and 64-bit

■

SUSE Linux Enterprise Server 9, SP4

■

Solaris 10 8/07 (s10u4) OS for the x64 and x86 (32-bit and 64-bit) platforms

■

Solaris 10 5/08 (s10u5) OS for the SPARC (64-bit) platform

■

VMware ESX Server 3.0.2, Update 1

Note – The Sun StorageTek RAID Manager graphical user interface (GUI) is not
supported with the VMware technology. To configure your storage space with the
VMware technology, use the command-line interface (CLI) and the BIOS
Configuration Utility. The CLI is installed as part of the Sun StorageTek RAID
Manager software installation. For more information about the CLI, see the Uniform
Command-Line Interface User’s Guide at:
http://docs.sun.com/app/docs/prod/stortek.raid.hba#hic

Note – For up-to-date OS version support and drivers, visit
http://support.intel.com/support/go/sunraid.htm.
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CHAPTER

2

Installing and Starting the Software
The Sun StorageTek RAID Manager software must be installed on every system that
will be part of your storage space. This chapter describes how to install and start the
Sun StorageTek RAID Manager software. The chapter contains the following
sections:
■

“Installing the Software” on page 9

■

“Starting the Software” on page 16

■

“Starting the Agent Only” on page 17

■

“Using the Software With a Firewall” on page 19

■

“Understanding Permission Levels” on page 20

■

“Logging Out of and in to the Software” on page 21

Installing the Software
To install the software, obtain the Sun StorageTek RAID Manager CD from the HBA
ship kit and follow the installation instructions for your OS:
■

“Installing on the Windows OS” on page 10

■

“Performing a Silent Windows Installation (Advanced)” on page 11

■

“Installing on the Linux OS” on page 13

■

“Installing on the Solaris OS” on page 14

Note – To obtain the latest version of the Sun StorageTek RAID Manager software,
go to http://support.intel.com/support/go/sunraid.htm.
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Note – Advanced users—To install the Sun StorageTek RAID Manager software
with the VMware technology, see “Installing On VMware Technology” on page 15.
Although the Sun StorageTek RAID Manger GUI is not supported, performing this
task will install the command-line interface (CLI), which allows RAID management.

Installing on the Windows OS
This section describes how to install the Sun StorageTek RAID Manager software on
systems running the Windows OS. See “System Requirements” on page 8 for a list of
the minimum supported OS.

Note – You need administrator or root privileges to install the Sun StorageTek RAID
Manager software. For details on verifying privileges, refer to your OS
documentation.
If a previous version of the Sun StorageTek RAID Manager software is installed on
the system, you must remove it before beginning this installation. To uninstall the
Sun StorageTek RAID Manager software, use the Add/Remove Programs option in
the Windows Control Panel.

Note – Advanced users—To perform a silent installation, follow the instructions on
“Performing a Silent Windows Installation (Advanced)” on page 11.

▼ To Install the Software on the Windows OS
1. Insert the Sun StorageTek RAID Manager Installation CD.
The Installation wizard opens automatically. (If it does not open, browse to the
CD in Windows Explorer, then click Autorun.)
2. Select Internal RAID Controller Setup or Custom Setup (advanced users only),
and click Next.
3. Click Next to begin the installation, click I accept..., then click Next.
4. Follow the onscreen instructions to complete the installation.
5. Repeat these Step 1 to Step 4 in order to install the Sun StorageTek RAID
Manager software on every Windows system that will be part of your storage
space.
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6. Continue with “To Start the Software on the Windows OS” on page 16.

Performing a Silent Windows Installation
(Advanced)
A silent installation uses command-line parameters to complete an installation
without messages or user interaction.

▼ To Perform a Silent Windows Installation of the
Software
1. Insert the Sun StorageTek RAID Manager Installation CD.
2. Open a command prompt window and change to the CD directory.
3. Install the Sun StorageTek RAID Manager software by typing the following at
the command line:
setup.exe /s /v" /qn properties"
where properties is one or more of the options listed in TABLE 2-1. Separate the
properties with spaces; separate feature names for the ADDLOCAL property with
commas (see examples on “Example Command-Line Installations” on page 13).

Chapter 2
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TABLE 2-1

Sun StorageTek RAID Manager Property Options

Property

Values

INSTALLDIR
(Not required)

Specifies the installation path. If you are specifying the installation path, it
must be set for a command-line install, and must be enclosed in escaped
quotation marks. For example:
INSTALLDIR=\"C:\Program Files\Sun\Sun StorageTek RAID
Manager\"
Note: If you do not explicitly set the installation path, the default path is
C:\Program Files\Sun\Sun StorageTek RAID Manager

ADDLOCAL
(Required)

Note: Use commas to separate multiple values.
• ALL—Installs all of the following features. If you specify ALL, do not
also specify any of the following values.
• Manager—Installs the Sun StorageTek RAID Manager software. If this
feature is installed, your system will reboot if certain RAID cards that
use the filter driver are installed. If necessary, you can use the REBOOT
property to suppress this (see “REBOOT” on page 12).
• SNMPSupport—Installs SNMP support for the Sun StorageTek RAID
Manager software. If you specify the SNMPSupport value, the Manager
value is also specified automatically. (See “Configuring SNMP Support”
on page 153 for more information about SNMP support.)
• ASMReadme—Installs the Readme file its Start menu shortcut.
• CLITools—Installs Command Line Interface tools.

REBOOT
(Not
Required)

• Force—Forces a reboot at the end of the installation.
• Suppress—Suppresses a reboot unless files were in use and could not
be overwritten during installation.
• ReallySuppress—Suppresses all reboots at the end of the installation.
Note: A reboot is only forced by the Sun installer if you have installed
Manager or DSM, or if any files cannot be overwritten.

Note – Synchronous Installation—To install the Sun StorageTek RAID Manager
software so that the setup.exe file does not close until the installation is complete,
add the /w parameter to setup.exe and run the application with the start /WAIT
command as shown in this example:
start /WAIT setup.exe /w /s /v" /qn properties"
You might want to do this for a batch file installation so that the setup will not
return until the installation is finished.
4. After a minute or two, the silent installation will complete and the Sun
StorageTek RAID Manager software icon will be accessible.
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Example Command-Line Installations
■

To install the basic options, which include the Manager, Readme, and SNMP
support:
setup.exe /s /v" /qn ADDLOCAL=Manager,ASMReadme,SNMPSupport"

■

To install just the Manager and suppress a reboot at the end of installation:
setup.exe /s /v" /qn ADDLOCAL=Manager REBOOT=ReallySupress"

■

To install all features silently, on a machine named COMP1234, and force a reboot:
setup.exe /s /v" /qn ADDLOCAL=Manager, ASMReadme,
SNMPSupport, CLITools REBOOT=Force"

■

To install only the CLI Tools and suppress a reboot:
setup.exe /s /v" /qn ADDLOCAL=CLITools REBOOT=ReallySuppress"

■

To install the Manager to a different installation path:
setup.exe /s /v" /qn ADDLOCAL=Manager INSTALLDIR=\"C:\Sun
StorageTek RAID Manager\""

■

To install the Manager and have setup wait until the installation finishes before it
closes:
start /WAIT setup.exe /w /s /v" /qn ADDLOCAL=Manager REBOOT=
ReallySupress"

Installing on the Linux OS
This section describes how to install the Sun StorageTek RAID Manager software on
systems running the Linux OS. See “System Requirements” on page 8 for a list of the
minimum supported OS.
The Sun StorageTek RAID Manager software includes the Java Runtime
Environment (JRE).

Note – If a previous version of the Sun StorageTek RAID Manager software is
installed on your system, you must remove it before beginning this installation. Any
customization files you created with the previous version are saved and used in the
upgrade. To remove the Sun StorageTek RAID Manager software, type the rpm -erase StorMan command.
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▼ To Install the Software on the Linux OS
1. Insert the Sun StorageTek RAID Manager Installation CD.
2. Mount the Sun StorageTek RAID Manager Installation CD:
For Red Hat: mount /dev/cdrom /mnt/cdrom
For SUSE: mount /dev/cdrom /media/cdrom
3. Change to the cdrom directory:
For Red Hat: cd /mnt/cdrom/linux/manager
For SUSE: cd /media/cdrom/linux/manager
4. Extract the RPM package and install it:
rpm --install ./StorMan*.rpm
5. Unmount the Sun StorageTek RAID Manager Installation CD:
For Red Hat: umount /mnt/cdrom
For SUSE: umount /media/cdrom
6. Repeat Step 1 through Step 5 to install the Sun StorageTek RAID Manager
software on every Linux system that will be part of your storage space.
7. Continue with “To Start the Software on the Linux OS” on page 17.

Installing on the Solaris OS
Note – If a previous version of the Sun StorageTek RAID Manager software is
installed on your system, you must remove it before beginning this installation. Any
customization files you created with the previous version are saved and used in the
upgrade. To remove the Sun StorageTek RAID Manager software, type the pkgrm
RaidMan command.

▼ To Install the Software on the Solaris OS
1. Insert the Sun StorageTek RAID Manager Installation CD.
The CD mounts automatically. (If it does not, manually mount the CD using a
command similar to the one shown in this step. Refer to your OS documentation
for detailed instructions.)
mount -F hsfs -o ro /dev/dsk/c1t0d0s2 /mnt
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2. Install the Sun StorageTek RAID Manager software:
pkgadd -d/mount-point/solaris/manager/StorMan.pkg
3. Follow the onscreen instructions to complete the installation.
4. Eject or unmount the Sun StorageTek RAID Manager Installation CD.
Refer to your OS documentation for detailed instructions.

Installing On VMware Technology
Note – The Sun StorageTek RAID Manager graphical user interface (GUI) is not
supported with the VMware technology. To configure your storage space with the
VMware technology, use the command-line interface (CLI) and the BIOS
Configuration Utility. The CLI is installed as part of the Sun StorageTek RAID
Manager software installation. For more information about the CLI, see the Uniform
Command-Line Interface User’s Guide at:
http://docs.sun.com/app/docs/prod/stortek.raid.hba#hic

▼ To Install On VMware Technology
1. Mount the Sun StorageTek RAID Manager Installation CD:
mount -r /dev/cdrom /mnt/cdrom
2. Change to the cdrom directory:
cd /mnt/cdrom/linux/manager
3. Extract the Linux Sun StorageTek RAID Manager RPM package and install it:
rpm --install ./StorMan*.rpm

Note – Ignore the note that says “Application can be started by typing
/usr/StorMan/StorMan.sh". The console has no graphical capability.
4. Use the command-line interface utility, arcconf, included with the Sun
StorageTek RAID Manager software to configure and manage disk drives.
For more information, see the Uniform Command-Line Interface User’s Guide
available at:
http://docs.sun.com/app/docs/prod/stortek.raid.hba#hic
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5. To use the Sun StorageTek RAID Manager software to connect remotely from
another system, open a range of ports in the built-in firewall by using this
command:
esxcfg-firewall -o 34571:34581,tcp,in,”StorMan”
For more information, see “Logging Into Remote Systems” on page 51.

Starting the Software
Note – You need root privileges to run the Sun StorageTek RAID Manager
software.
To start the Sun StorageTek RAID Manager software, follow the instructions for your
OS. To start the Sun StorageTek RAID Manager Agent only, see “Starting the Agent
Only” on page 17. This section contains the following subsections:
■

“To Start the Software on the Windows OS” on page 16

■

“To Start the Software on the Linux OS” on page 17

■

“To Start the Software on the Solaris OS” on page 17

▼ To Start the Software on the Windows OS
On systems running Windows, you can run the Sun StorageTek RAID Manager
software as a stand-alone application, or in a browser window.

Note – Normally, you only need to run the Sun StorageTek RAID Manager software
in a browser window if you are working on a system that is not part of your storage
space (does not have an HBA installed). If the system you are working on is part of
your storage space, run the Sun StorageTek RAID Manager software as a standalone
application.
1. Choose Start > Programs > Sun StorageTek RAID Manager.
The Log In dialog box appears.
2. Enter the user name and password that you use to log on to the system, then
click Connect.
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Note – Each user name has a permission level associated with it. See
“Understanding Permission Levels” on page 20 for more information.

▼ To Start the Software on the Linux OS
1. Type the following command to change to the Sun StorageTek RAID Manager
installation directory:
cd /usr/StorMan
2. Type the following command and press Enter:
sh StorMan.sh
3. When the Log In dialog box appears, enter the user name and password that
you use to log on to the system, and click Connect.

Note – Each user name has a permission level associated with it. See
“Understanding Permission Levels” on page 20 for more information.

▼ To Start the Software on the Solaris OS
1. Change to the directory where the Sun StorageTek RAID Manager software is
installed:
cd /opt/StorMan
2. Launch the Sun StorageTek RAID Manager script:
sh StorMan.sh

Starting the Agent Only
Note – For more information, see “About the Agent” on page 3.
To start the Sun StorageTek RAID Manager Agent only, follow the instructions for
your OS:
■

“Starting the Agent on the Windows OS” on page 18
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■

“Starting the Agent on the Linux OS” on page 18

■

“Starting the Agent on the Solaris OS” on page 19

Starting the Agent on the Windows OS
On systems running Windows, the Sun StorageTek RAID Manager Agent starts
automatically when the system is powered on.

▼ To Verify That the Agent is Running On the System
1. Open the Windows Control Panel.
2. Double-click Administrative Tools, then double-click Services.
3. In the list of services, check that the Sun StorageTek RAID Manager Agent is
installed and running.
If it is not, you can choose to restart it.
4. Manage and monitor the system by logging into it as a remote system (see
“Logging Into Remote Systems” on page 51).
The default settings for the Sun StorageTek RAID Manager Agent are suitable for
most storage spaces. To customize the settings for your specific requirements, see
“Customizing the Agent” on page 58.

Starting the Agent on the Linux OS
On systems running Linux, the Sun StorageTek RAID Manager Agent starts
automatically when the system is powered on.

▼ To Verify That the Agent is Running On the System
1. Open a shell window.
2. Type this command:
ps -ef | grep StorAgnt.sh
If the Agent is running, it is listed as sh StorAgnt.sh.
3. Manage and monitor the system by logging into it as a remote system (see
“Logging Into Remote Systems” on page 51).
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The default settings for the Sun StorageTek RAID Manager Agent are suitable for
most storage spaces. To customize the settings for your specific requirements, see
“Customizing the Agent” on page 58.

Starting the Agent on the Solaris OS
On systems running the Solaris OS, you must start the agent.

▼ To Start the Agent On the System
1. Open a terminal window and type this command:
svcadm enable ADPTstor_agent
2. Manage and monitor the system by logging into it as a remote system (see
“Logging Into Remote Systems” on page 51).
The default settings for the Sun StorageTek RAID Manager Agent are suitable for
most storage spaces. To customize the settings for your specific requirements, see
“Customizing the Agent” on page 58.

Using the Software With a Firewall
If your network includes a firewall, you must unblock the ports listed in this section.
Unblock this port to ensure that the Sun StorageTek RAID Manager software
operates properly:
■

8003 (TCP)

Unblock these ports to allow the Sun StorageTek RAID Manager software remote
access to systems on your network:
■

34570 to 34580 (TCP)

■

34570 (UDP)

■

34577 to 34580 (UDP)

Chapter 2

Installing and Starting the Software

19

Understanding Permission Levels
When you log into the Sun StorageTek RAID Manager software, your permission
level is identical to your OS permission level. For example, if you have administrator
permissions on your OS, you also have administrator permissions in the Sun
StorageTek RAID Manager software.
This section describes the three different permission levels.

About the Administrator Permission Level
Logging in as an Administrator allows you full access to manage and modify the
HBAs, disk drives, and logical drives that are part of your storage space.

▼ To Log In as an Administrator
■

Windows—Enter a valid user name and password for the administrator or
administrative user on the system. (The administrative user is any member of the
local administrators group, which can, in a domain configuration, include domain
administrators.)

■

Linux—Type root for the user name and enter the root password.

■

Solaris—Type root for the user name and enter the root password.

About the User Permission Level
Logging in as a User partially restricts your access to the storage space, as described
in this table.
TABLE 2-2
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User Restrictions

Tasks That Users Can Perform

Tasks That Users Cannot Perform

Rescan HBAs

Create logical drives

Save activity logs

Modify logical drives

Verify disk drives (with and without fix)

Delete logical drives

Verify logical drives (with and without fix)

Delete hot-spares

Identify disk drives and enclosures

Perform data migrations
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TABLE 2-2

User Restrictions

Tasks That Users Can Perform

Tasks That Users Cannot Perform

Rebuild disk drives
Create hot-spares
Access the same information as Guests (see the
following section)

▼ To Log In as a User
●

Use your normal network user name and password at the Login window.

About the Guest Permission Level
Logging in as a Guest restricts your access to the storage space to view-only.
You can see all local and remote systems and view their properties windows, view
event logs, save configuration files and support archives, and browse the online
Help.
You cannot make any changes to the storage space.

▼ To Log In as a Guest
●

Click Cancel on the Login window.

Logging Out of and in to the Software
This section contains the following subsections:
■

“To Log Out of the Software” on page 21

■

“To Log in to the Software” on page 22

▼ To Log Out of the Software
1. In the Enterprise View, click on the local system.
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2. In the menu bar, choose Actions, then click Log out.
You are logged out of the Sun StorageTek RAID Manager software.

▼ To Log in to the Software
1. In the Enterprise View, click on the local system.
2. In the menu bar, select Actions, then click Log In.
3. Enter your user name and password, then click Connect.
See “Understanding Permission Levels” on page 20 for more information.
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CHAPTER

3

Exploring the Software
Before you build a storage space, read this chapter to familiarize yourself with the
main features of the Sun StorageTek RAID Manager software and learn to navigate
to the information you need.
This chapter contains the following sections:
■

“Navigating the Main Window” on page 23

■

“Using the Enterprise View” on page 24

■

“Using the Physical Devices View” on page 26

■

“Using the Logical Devices View” on page 27

■

“Revealing More Disk Drive Information” on page 29

■

“Checking System Status” on page 31

■

“Working in The Software” on page 32

■

“Getting Help” on page 33

Navigating the Main Window
The main window of the Sun StorageTek RAID Manager software has three main
panels, or views, in addition to the other features shown in this figure.
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FIGURE 3-1

Sun StorageTek RAID Manager Main Window

Resize the panels and scroll horizontally or vertically to view more or less
information.
For more information about specific areas of the main window, see these sections:
■

“Using the Enterprise View” on page 24.

■

“Using the Physical Devices View” on page 26.

■

“Using the Logical Devices View” on page 27.

Using the Enterprise View
The Enterprise View is an expandable tree with two main branches—the Internal
RAID branch, and the External RAID branch. The External RAID branch is not
covered in this document.
Under Internal RAID, the Enterprise View lists the local system (the system you are
working on) and any other systems that you are managing using the Sun StorageTek
RAID Manager software.
Expand a system in the Enterprise View to the see its HBAs. (See “Logging Into
Remote Systems” on page 51 for more information about local and remote systems.)
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Note – See “Creating Display Groups” on page 54 to learn how to group related
systems together in the Enterprise View.
When you select a component in the Enterprise View, the disk drives and logical
drives (“devices”) associated with it appear in the Physical and Logical Devices
Views, as shown in the following figure.
FIGURE 3-2

Enterprise View

You can perform most tasks by selecting an HBA in the Enterprise View and
working with its associated devices in the Physical and Logical Devices Views.

Using the Physical Devices View
When you select an HBA in the Enterprise View, information about the physical disk
drives and enclosures connected to that HBA are displayed in the Physical Devices
View.
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FIGURE 3-3

Example of the Physical Devices View

TABLE 3-1

Physical Devices View Icons

Icon

Description

Disk drives designated as hot-spares have plus signs (+) beside them.
A blue plus sign means that the spare is protecting at least one logical
drive.
See “Working With Hot-Spares” on page 83 for more information.
A hot-spare with a yellow plus sign may not be large enough to protect
the logical drive it’s assigned to, or may not be assigned to a logical
drive.
See “Working With Hot-Spares” on page 83 for more information.
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Icon

Description

Hold your cursor over any disk drive to see its status,
port/connector/ID number, and maximum speed. You can also click the
arrow to see this same information for all the disk drives at the same
time. To reveal further information, use the View buttons to change how
the disk drives are displayed, as described in “Revealing More Disk
Drive Information” on page 29.
A disk drive shaded in light blue is not part of any logical drive. A disk
drive shaded half light/half dark blue has some space allocated to a
logical drive, and some space available.
To view the logical drives associated with a particular disk drive, see
“Using the Logical Devices View” on page 27.
If your storage space includes an enclosure, its enclosure management
device is represented by the following icon.

Using the Logical Devices View
When you select an HBA in the Enterprise View, information about the logical drives
and arrays associated with that HBA appear in the Logical Devices View. (A logical
drive is a group of physical disk drives that your OS recognizes as a single drive. For
more information, see “Understanding Logical Drives” on page 63.)
FIGURE 3-4

Logical Devices View
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TABLE 3-2

Icon

Logical Devices View Icons
Description

The RAID level of a logical drive is indicated by the number inside the
logical drive’s icon. For instance, the logical drive shown at right has
RAID 1. Logical drives protected by hot-spares have plus signs (+)
beside them.
Hold your cursor over any logical drive to see its name, status, and size.
You can also click the arrow to view this same information for all the
logical drives at once.

Click on a logical drive to highlight the disk drives that comprise it in the Physical
Devices View. In the following figure, six disk drives (plus one hot-spare) comprise
the selected RAID 5 logical drive.
FIGURE 3-5

Relationship Between Physical and Logical Devices

You can also click on any disk drive to see which (if any) logical drive it belongs to.
A disk drive shaded in light blue is not part of any logical drive.

Revealing More Disk Drive Information
You can reveal more information about disk drives by using the View buttons to
change how they are displayed.
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By default, disk drives are displayed in the unexpanded Text Description View, as
shown in the following figure.
FIGURE 3-6

Unexpanded Text Description View

Or, if you are managing disk drives in an enclosure, the disk drives are displayed in
the Enclosure View.
EXAMPLE 3-1

Enclosure View

Note – Not all enclosures are supported by the Sun StorageTek RAID Manager
software. Unsupported enclosures do not appear in Enclosure View.
Click the expand arrow to see basic disk drive information.
FIGURE 3-7

Text Description View

Chapter 3

Exploring the Software

29

Click the Full Size Capacity View button to see the size capacities of the disk drives.
Disk drives or segments of disk drives that are included in logical drives are shaded
brown.
FIGURE 3-8

Full Size Capacity View

Click the Relative Size Capacity View button to see the size capacities of the disk
drives relative to each other. A full length bar is displayed for the largest disk drive.
Proportionally shorter bars are displayed for other disk drives.
FIGURE 3-9

Relative Size Capacity View

Checking System Status
The Sun StorageTek RAID Manager software includes an Event Viewer for at-aglance system and event status information. The Event Viewer provides status
information and messages about activity (or events) occurring in your storage space.
Double-click any event to see more information in an easy-to-read format.

30

Sun Intel Adaptec RAID User’s Guide • June 2009

FIGURE 3-10

Event Viewer Screen

Warning-level and Error-level icons, shown in FIGURE 3-11, appear next to
components (such as systems and logical drives) affected by a failure or error,
creating a trail, or rapid fault isolation, that helps you identify the source of a
problem when it occurs. See “Identifying a Failed or Failing Component” on
page 158 for more information.
FIGURE 3-11

Enclosure Warning and Disk Drive Error Icons

If your storage space includes a HBA with a temperature sensor, or an enclosure
with an enclosure management device, such as a SCSI Accessed Fault-Tolerant
Enclosure (SAF-TE) processor, temperature, fan, and power module status is
displayed by status icons in the Physical Device view, as shown in the next figure.
These status icons change color to indicate status (see “Managing Enclosure Status”
on page 116).
FIGURE 3-12

Physical Devices View Icons

For more information, see “Monitoring Storage Space” on page 93.

Note – By default, all Warning- and Error-level events activate an audible alarm. See
“Silencing and Testing the Audible Alarm” on page 118 for more information.
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Working in The Software
The Sun StorageTek RAID Manager software provides multiple ways to work with
its menus and windows.
Most menu options are available by doing the following:
■

Selecting items from the menu bar.

■

Clicking buttons on the tool bar.

■

Right-clicking on components in the main window. (Only tasks and windows
associated with a specific component are available on right-click menus.)

For simplicity, the tasks in this document are explained mainly using menu bar
options.

About the Actions Menu
Most of the main tasks in the Sun StorageTek RAID Manager software are part of the
Actions menu on the menu bar. Options on the Actions menu vary, depending on
which type of component is selected in the main window. For instance, managed
systems, disk drives, and hot-spares each have specialized Actions menus.
For an overview of all Actions menu options, see “About Viewing Actions Menu
Options” on page 180.

Getting Help
The Sun StorageTek RAID Manager software online Help includes conceptual
information, glossary definitions, and descriptions of on screen menus and items, in
addition to step-by-step instructions for completing tasks.
To open the online Help, click the Help button. Alternatively, press the
F1 key, or in the menu bar select Help, then click Search or Contents.
Press the Help button in a dialog box or wizard for help with that specific dialog
box, window, or procedure.
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Additionally, you can find the most commonly asked-about information in
“Frequently Asked Questions” on page 175 of this document. For help identifying
features of the Sun StorageTek RAID Manager software, see “Buttons and Icons Ata-Glance” on page 185.
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CHAPTER

4

Building a Storage Space
Once you have logged into the Sun StorageTek RAID Manager software, you can
begin to build storage space by creating logical drives. (For more information, see
“Understanding Logical Drives” on page 63.) This chapter describes how to start
building your storage space.

Note – You must be logged in as an Administrator to complete the tasks described
in this chapter.
The chapter contains the following sections:
■

“Selecting a Configuration Method” on page 35

■

“Express Configuration: Building the Easy Way” on page 36

■

“Custom Configuration (Advanced)” on page 39

■

“Building a RAID Volume” on page 46

■

“Sun StorageTek SAS RAID HBA Support” on page 49

■

“Managing Your Storage Space” on page 49

Selecting a Configuration Method
The Sun StorageTek RAID Manager software has a wizard to help you build (or
configure) logical drives, and offers two configuration methods to choose from,
depending on your needs:
■

Express configuration (basic)—Automatically creates logical drives by grouping
together same-sized physical drives, and assigns RAID levels based on the
number of physical disk drives in the logical drive.
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Use Express Configuration when you want to use all available disk drives in the
most efficient manner. For instructions, see “Express Configuration: Building the
Easy Way” on page 36.
■

Custom configuration (advanced)—Helps you group disk drives, set RAID
levels, determine logical drive size, and configure advanced settings manually.
Use the custom method when you want to create specific logical drives with any
or all available disk drives. For instructions, see “Custom Configuration
(Advanced)” on page 39.

Note – Do not combine SAS and SATA disk drives within the same logical drive.
The Sun StorageTek RAID Manager software generates a warning if you try to create
a logical drive using a combination of SAS and SATA disk drives.

Express Configuration: Building the
Easy Way
When you use express configuration, the Sun StorageTek RAID Manager software
automatically creates logical drives by grouping together same-sized physical disk
drives, and assigns RAID levels based on the number of physical disk drives in a
logical drive:
■

A logical drive with three or more physical disk drives is assigned RAID 5.

■

A logical drive with two physical disk drives is assigned RAID 1.

■

A logical drive with only a single physical disk drive becomes a simple volume,
which does not offer redundancy.

Note – To create a logical drive with any other RAID level, you must use the custom
method, as described in “Custom Configuration (Advanced)” on page 39. See
“Selecting the Best RAID Level” on page 263 for more information about RAID
levels.
By default, logical drive size is set by the Sun StorageTek RAID Manager software
and automatically maximizes the capacity of the disk drives. However, you can
choose to specify a size for a logical drive, if required.

36

Sun Intel Adaptec RAID User’s Guide • June 2009

▼ To Build a Storage Space With the Express
Method
1. In the Enterprise View, select the HBA you want.
2. On the toolbar, click Create.

3. When the wizard opens, select Express configuration..., then click Next.
4. Review the information that appears.

Note – Do not combine SAS and SATA disk drives within the same logical drive.
The Sun StorageTek RAID Manager software generates a warning if you try to create
a logical drive using a combination of SAS and SATA disk drives.

To exclude specific disk drives, specify a size for the logical drives, or to make
other changes to the configuration, click Modify logical devices. See Step 6 for
more information.

Chapter 4

Building a Storage Space

37

Note – Some OS have size limitations for logical drives. Before you save the
configuration, verify that the size of the logical drive is appropriate for your OS.
5. Click Apply, then click Yes.
The Sun StorageTek RAID Manager software builds the logical drive(s), indicated
by a magnifying glass moving across the new logical drive icon in the Logical
Devices View. The configuration is saved on the Sun StorageTek SAS RAID HBA
and on the physical drives.

Note – To stop the creation of a new logical drive, right-click on the magnifying
glass icon, then choose Stop current task. You can also change the priority of the
build task to High, Medium, or Low by choosing Change background task priority
from the same right-click menu.

6. Repeat Step 1 to Step 5 for each HBA on your system.
7. If you want to assign hot-spares to the logical drives, see “Working With HotSpares” on page 83.
8. Continue with “Partitioning and Formatting Logical Drives” on page 39.
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Partitioning and Formatting Logical Drives
The logical drives you create are displayed as physical disk drives on your OS. You
must partition and format these logical drives before you can use them to store data.

Note – Logical drives that have not been partitioned and formatted cannot be used
to store data.
Refer to your OS documentation for more information.

Including More Systems In the Storage Space
Note – The Sun StorageTek RAID Manager software must be installed on every
system that will be part of your storage space.
If you have installed Sun StorageTek SAS RAID HBAs on more than one system, to
continue building your storage space do the following:
■

From each individual system, log into the Sun StorageTek RAID Manager
software and repeat Step 1 to Step 8 to continue building the storage space, or

■

From the local system (the system you are working on), log in to all other systems
in your storage space as remote systems (see “Logging Into Remote Systems” on
page 51), then repeat Step 1 to Step 8 to continue building your storage space.

The maximum number of supported RAID HBAs varies depending on your OS. See
“Sun StorageTek SAS RAID HBA Support” on page 49 for more information.
To continue, see “Managing Your Storage Space” on page 49.

Custom Configuration (Advanced)
Custom configuration helps you build your storage space manually by stepping you
through the process of creating logical drives, setting RAID levels, and configuring
other settings.
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▼ To Build the Storage Space With Custom
Configuration
1. In the Enterprise View, click the HBA you want.
Note how many available disk drives are connected to the HBA; this information
will be helpful as you create logical drives.
2. On the toolbar, click Create.

3. When the wizard opens, select Custom configuration..., then click Next.
4. Select a RAID level.
The most common RAID levels are listed first; advanced RAID levels are available
by clicking Advanced settings.
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Note – To build a RAID Volume, see “Building a RAID Volume” on page 46. See
“Selecting the Best RAID Level” on page 263 for more information about RAID
levels.
5. Click Next.
6. In the Physical Devices panel, select the disk drives you want to use in the
logical drive.

Note – Do not combine SAS and SATA disk drives within the same logical drive.
The Sun StorageTek RAID Manager software generates a warning if you try to create
a logical drive using a combination of SAS and SATA disk drives.
The Sun StorageTek RAID Manager software prompts you to select the correct
number of disk drives. For example, the following figure illustrates disk drives
installed in a system.
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The following figure illustrates disk drives installed in two enclosures.

By default, the Sun StorageTek RAID Manager software automatically sets the size
of the logical drive and maximizes the capacity of the disk drives you select. (To set
a custom size for the logical drive, see Step 8.)
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7. (Optional) If you want to assign hot-spares to the logical drives, see “Working
With Hot-Spares” on page 83.
A plus sign (+) appears to indicate that the selected drive will be designated as a
hot-spare, as shown below. To remove a hot-spare designation from a disk drive,
control-click it again.

See “Working With Hot-Spares” on page 83 for more information.
8. (Optional) Adjust the Advanced Settings:
■

To set a smaller logical drive size—Click Advanced Settings, then enter a size
for the logical drive in the Size GB box. Available space will remain on the
selected disk drives. See “Understanding Logical Drives” on page 63 for more
information.

■

To modify other settings—Click Advanced Settings and customize the settings
as required. See “Fine-Tuning Logical Drives” on page 69 for more information.

9. If you have no other available disk drives, skip to Step 11.
If you have available disk drives and want to create additional logical drives,
click Add logical device to open a new tab in the wizard.

Chapter 4

Building a Storage Space

43

10. Repeat Step 4 to Step 9 for each logical drive that you want to create on the
HBA.
11. Click Next, then review the logical drive settings.
This example shows two logical drives with RAID 5 are ready to be created.

To make changes, click Back.

Note – Some OS have size limitations for logical drives. Before continuing, verify
that the size of the logical drive is appropriate for your OS. For more information,
refer to your OS documentation.
12. Click Apply, then click Yes.
The Sun StorageTek RAID Manager software builds the logical drive(s), indicated
by a magnifying glass moving across the new logical drive icon in the Logical
Devices View. The configuration is saved on the Sun HBA and on the physical
drives.

13. Repeat Step 1 to Step 12 for each HBA on the system.
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14. Partition and format the logical drives.
See “Partitioning and Formatting Logical Drives” on page 39 for more
information.
If your storage space comprises one or more HBAs on a single system, building is
complete. Continue with “Managing Your Storage Space” on page 49.
If you have installed HBAs on more than one system and wish to add them to your
storage space, continue with “Including More Systems In the Storage Space” on
page 45.

Including More Systems In the Storage Space
Note – The Sun StorageTek RAID Manager software must be installed on every
system that will be part of your storage space.
If you have installed HBAs on more than one system, to continue building your
storage space:
■

From each individual system, log into the Sun StorageTek RAID Manager
software and repeat Step 1 to Step 14 to continue building your storage space.
Or:

■

From the local system, log in to all the other systems as remote systems (see
“Logging Into Remote Systems” on page 51), then repeat Step 1 to Step 14 to
continue building your storage space.

The maximum number of supported Sun StorageTek SAS RAID HBAs varies
depending on your OS. See “Sun StorageTek SAS RAID HBA Support” on page 49
for more information.
When your storage space is complete, continue with “Managing Your Storage Space”
on page 49.

Building a RAID Volume
A RAID Volume comprises two or more logical drives connected end-to-end. The
logical drives in a RAID Volume must meet the following requirements:
■

They must be built using disk drives connected to the same HBA.

■

They have the same RAID level assigned.
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■

They must not be striped together.

■

They may have equal or different capacities.

▼ To Build a RAID Volume
1. Create two or more logical drives that meet the requirements listed at the
beginning of this section, and wait for them to build and initialize.
For instructions, see “Express Configuration: Building the Easy Way” on page 36
or “Custom Configuration (Advanced)” on page 39.
The following figure shows two example RAID 5 logical drives.

2. On the toolbar, click Create.
3. When the configuration wizard opens, select Custom configuration..., then click
Next.
4. Click Advanced settings, select RAID Volume, then click Next.
5. In the Logical Devices panel, select the logical drives you want to use in the
RAID Volume.
The Sun StorageTek RAID Manager software prompts you to select the correct
number of logical drives.
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6. Modify the Advanced Settings, if required.
See “Fine-Tuning Logical Drives” on page 69 for more information.
7. Click Next to review the RAID volume settings.
To make changes, click Back.
The following figure shows an example RAID volume ready to be created.

8. Click Apply, then click Yes.
The Sun StorageTek RAID Manager software builds the RAID Volume. The
configuration is saved on the Sun StorageTek SAS RAID HBA and on the physical
drives. The Sun StorageTek RAID Manager software replaces the individual
logical drives with a single RAID Volume in the Logical Devices View.
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9. Partition and format your RAID Volume.
See “Partitioning and Formatting Logical Drives” on page 39 for more
information.

Sun StorageTek SAS RAID HBA Support
The maximum number of Sun StorageTek SAS RAID HBAs supported by the Sun
StorageTek RAID Manager software varies, depending on your OS:
■

Windows—Up to 16 Sun StorageTek SAS RAID HBAs

■

Linux—Up to 12 Sun StorageTek SAS RAID HBAs

Managing Your Storage Space
Once your storage space is built, you can add systems, HBAs, and disk drives to
meet your changing needs, then create logical drives by repeating the steps in this
chapter.
To customize the Sun StorageTek RAID Manager software and make managing your
storage space easier and more effective, continue with “Customizing the Software”
on page 51.
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To learn how to monitor, manage, and modify your storage space, see these chapters
in the rest of this document:
■

“Managing Logical Drives and Hot-Spares” on page 63

■

“Protecting Data” on page 89

■

“Monitoring Storage Space” on page 93

■

“Managing Tasks” on page 121

■

“Working with Display Groups” on page 131

■

“Managing HBAs, Disk Drives, and Enclosures” on page 137

■

“Troubleshooting” on page 157

To find the most commonly asked-about information, see “Frequently Asked
Questions” on page 175.
For help identifying features of the Sun StorageTek RAID Manager software, see
“Buttons and Icons At-a-Glance” on page 185.
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CHAPTER

5

Customizing the Software
This chapter describes how you can customize the Sun StorageTek RAID Manager
software to make managing your storage space easier and more effective. All tasks
described in this chapter are optional. The chapter contains the following sections:
■

“Logging Into Remote Systems” on page 51

■

“Creating Display Groups” on page 54

■

“Setting Preferences and Changing Views” on page 56

■

“Customizing the Agent” on page 58

Logging Into Remote Systems
If multiple systems on the network are in your storage space, you can use the Sun
StorageTek RAID Manager software to monitor and manage all of them from one
system.
The system that you are working on is called the local system. All other systems in
the storage space are remote systems. ‘Local’ and ‘remote’ are relative terms, as
shown in the following figure—when you are working on system A (local system),
system B is a remote system; when you are working on system B (local system),
system A is a remote system.
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To manage remote systems from the local system, you log into the remote systems.
(The Sun StorageTek RAID Manager software encrypts the user name and password
of a remote system during log-in.) The Sun StorageTek RAID Manager software or
the Sun StorageTek RAID Manager Agent (see “Starting the Agent Only” on
page 17) must be running on these remote systems before you can log into them.
When you log into a remote system, you add that system to the Enterprise View of
the Sun StorageTek RAID Manager software, as shown in this example.

Once you have logged into a remote system, it is automatically included in the
Enterprise View each time you start the Sun StorageTek RAID Manager software
from the local system. You can work with the remote system’s HBAs, disk drives,
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and logical drives as if they were part of your local system. You must log in with the
proper permission level to complete the tasks you wish to perform. (See
“Understanding Permission Levels” on page 20 for more information.)

▼ To Log Into a Remote System
1. From the menu bar, click Remote, then select Add.
The Add Managed System window appears.
2. Ensure that Managed System (Internal RAID) is selected in the Type dropdown menu, then enter the Host name or TCP/IP address of the remote system.
3. Enter the startup port number of the remote system.
The default port number is 34571.
4. If prompted, enter your user name and password.
(User names and passwords are case-sensitive.) To save this user name and
password, select the Save user name/password box.
5. Click Connect.
The Sun StorageTek RAID Manager software connects to the remote system and
adds it to the list of managed systems in the Enterprise View.
6. To manage the remote system, select it in the Enterprise View and enter your
user name and password if prompted.
To create logical drives on remote systems, see “Building a Storage Space” on
page 35.

▼ To Remove a Remote System
If you no longer want to monitor a remote system, you can remove it from the
Enterprise View.
Removing a remote system does not cause it to fail.
1. In the menu bar of the main window, choose Remote > Remove managed
system > remote-system-name.
The Remove Managed System window appears.
2. If you want to continue receiving events from the remote system after it has
been removed from the local system, select Continue to receive events from the
remote system from the drop-down menu.
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3. Click OK.
The remote system is removed from the Enterprise View of the Sun StorageTek
RAID Manager software.

Creating Display Groups
You can organize related local and remote systems into display groups to make
managing your storage space easier and more effective.
Systems in a display group are displayed together in the Enterprise View under the
group name.

▼ To Create a Display Group
1. In the Enterprise View, right-click on a system that you want to add to a display
group
A navigational menu appears.
2. Choose Change display group > New group.

3. Enter a name for the new display group, then click OK.
The display group is created and the system you selected in Step 1 is added to it.
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4. To add another system to the newly created display group, right-click on the
system in the Enterprise View, choose Change display group > group-name.

The system is added to the new display group.

Display groups are sorted alphabetically and are displayed in the Enterprise View
below any systems that are not part of a display group.
A system can belong to only one display group at a time; you cannot include the
same system in multiple display groups.
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For more information, see “Working with Display Groups” on page 131.

Setting Preferences and Changing Views
You can customize the Sun StorageTek RAID Manager software by doing the
following:
■

Sorting the systems in the Enterprise View (see the following section).

■

Selecting the standard unit of measure shown for disk drives (see “To Change the
Standard Unit of Measure” on page 57).

■

Excluding the tool bar or status bar from the main window, or turning off the Tool
Tips (see “To Change the Main Window Appearance” on page 58).

▼ To Sort Systems in the Enterprise View
You can set the Sun StorageTek RAID Manager software to sort systems in the
Enterprise View alphabetically or chronologically. By default, systems are listed in
alphabetical order. The local system always appears first when you sort objects
alphabetically.
1. In the menu bar of the main window, choose File > Preferences.
2. Click the Display options tab.
3. In the System tree sorting drop-down menu, select the option you want.

4. Click OK.
56

Sun Intel Adaptec RAID User’s Guide • June 2009

▼ To Change the Standard Unit of Measure
You can set the Sun StorageTek RAID Manager software to show disk drive capacity
in measures of megabytes (MB), gigabytes (GB), or terabytes (TB).
You can choose the Auto-select setting to allow the Sun StorageTek RAID Manager
software to show the most appropriate unit of measure based on disk drive size.
This option allows different disk drives to be shown in different units of measure.
By default, disk drives are shown in GB.
1. In the menu bar of the main window, choose File > Preferences.
2. Click the Display options tab.
3. In the Capacity display units drop-down menu, select the option you want.

4. Click OK.

▼ To Change the Main Window Appearance
You can choose to remove the tool bar and status bar from the main Sun StorageTek
RAID Manager software window to save space onscreen. You can also choose to turn
off the Tool Tips that automatically appear when you place your cursor over
onscreen items.
●

In the menu bar, select View.
The options in the View menu are toggle switches, which means that they can be
selected and deselected by clicking on them.
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Customizing the Agent
The default settings of the Sun StorageTek RAID Manager Agent are suitable for
most storage spaces. (See “About the Agent” on page 3 for more information.)
However, you can customize the Agent on any system by doing the following:
■

Setting the Agent to broadcast events on that system to all logged-in users. See
“Broadcasting Event Alerts From a System” on page 59.

■

Changing the OS event log setting for that system. See “To Change or Disable OS
Event Logging On a System” on page 59.

■

Changing the frequency and duration of the alarm, or choose to disable the alarm
for that system. See “To Change Alarm Settings On a System” on page 60.

■

Changing to Agent base port number on that system. See “To Change the Agent
Base Port Number On a System” on page 61.

Any changes you make to the Agent settings affect the selected system only and are
not applied to all systems in your storage space.

Broadcasting Event Alerts From a System
You can set the Sun StorageTek RAID Manager Agent to send event alerts about a
specific system to all users who are logged into your storage space network. You
might want to do this if your storage space is not managed by a dedicated person, or
if that particular system is off-site or is not connected to a monitor.
Event alerts signal to everyone working on the storage space that technical
assistance is required for that system.
For more information, see “Broadcasting Event Alerts to Users” on page 115.

▼ To Change or Disable OS Event Logging On a
System
By default, all warning-level and error-level events on a system are recorded in the
OS event log. You can customize the level of events that are recorded, or you can
disable OS event logging.
1. In the Enterprise View, select the system.
2. Click the Configure button, then choose General Settings.
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The Agent General Settings window appears.
3. From the Save events to OS log drop-down menu, choose the type of event
logging that you want, then click Save changes.

4. Restart the Sun StorageTek RAID Manager software to apply the new setting.

▼ To Change Alarm Settings On a System
Warning-level and error-level events on a system (see “About the Status Icons” on
page 96) trigger an audible alarm, a series of beeps which sound every five minutes
until the event is resolved.
You can change the frequency and duration of the alarm, or choose to disable the
alarm on any system. For information about using the audible alarm, see “Silencing
and Testing the Audible Alarm” on page 118.
1. In the Enterprise View, select the system.
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2. Click the Configure button, then click General Settings.
The Sun StorageTek RAID Manager Agent General Settings window appears for
the system you selected.

3. Edit the alarm settings as required.
(Select or deselect Sound alarm; change the Alarm interval (Seconds) time.)

Caution – If you disable the alarm, no audible signal will sound on that system
when a Warning- or Error-level event occurs.
4. Click Save changes.
5. Restart the Sun StorageTek RAID Manager software to apply the new settings.

▼ To Change the Agent Base Port Number On a
System
The Sun StorageTek RAID Manager software uses six consecutive ports to access
remote systems: 34571, 34572, 34573, 34574, 34575, and 34576. The default port
number for the Agent is 34571. If your system has a conflict with these ports, change
the base port to a different port number.
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▼ To Change the Agent Base Port Number
1. In the Enterprise View, select the system.
2. Click the Configure button, then click General Settings.
The Sun StorageTek RAID Manager Agent General Settings window appears for
the system you selected.
3. Enter a new Agent system base port number.
4. Click Save changes.
5. Restart the Sun StorageTek RAID Manager software and the Sun StorageTek
RAID Manager Agent to apply the new setting.
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CHAPTER

6

Managing Logical Drives and HotSpares
This chapter explains how to manage logical drives and hot-spares associated with
RAID host bus adapters (HBAs). For detailed information about creating a logical
drive, see “Building a Storage Space” on page 35.
The chapter contains the following sections:
■

“Understanding Logical Drives” on page 63

■

“Creating Logical Drives” on page 64

■

“Fine-Tuning Logical Drives” on page 69

■

“Verifying Logical Drives” on page 73

■

“Increasing the Capacity of a Logical Drive” on page 76

■

“Changing the RAID Level of a Logical Drive” on page 79

■

“Deleting a Logical Drive” on page 82

■

“Working With Hot-Spares” on page 83

Understanding Logical Drives
A logical drive is a group of physical disk drives that appears to your OS as a single
drive that can be used for storing data.
A logical drive can comprise one or more disk drives and can use part or all of each
disk drive’s capacity.
It is possible to include the same disk drive in two different logical drives by using
just a portion of the space on the disk drive in each, as shown in the following
figure.
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Disk drive space that has been assigned to a logical drive is called a segment. A
segment can include all or just a portion of a disk drive’s space. A disk drive with
one segment is part of one logical drive, a disk drive with two segments is part of
two logical drives, and so on. A segment can be part of only one logical drive. When
a logical drive is deleted, the segments that comprised it revert to available space (or
free segments).
A logical drive can include redundancy, depending on the RAID level assigned to it.
(See “Selecting the Best RAID Level” on page 263 for more information.)
Once a logical drive has been created, you can change its RAID level or increase its
capacity to meet changing requirements. You can also protect your logical drives by
assigning one or more hot-spares to them. (See “Working With Hot-Spares” on
page 83 for more information.)

Creating Logical Drives
For basic instructions for creating logical drives, see “Building a Storage Space” on
page 35.
This section describes these additional scenarios for creating logical drives:
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■

Setting the size of a new logical drive (see the following section)

■

Including different-sized disk drives in a logical drive (see “Including DifferentSize Disk Drives in a Logical Drive” on page 66)

■

Creating a logical drive using available segments of disk drives (see “To Create a
Logical Drive Using Free Segments on Disk Drives” on page 67)

Note – After making a change to a drive, you must manually rescan the BIOS or
reset power before changes to a drive can be seen in the GUI.

▼ To Set the Size of a Logical Drive
The Sun StorageTek RAID Manager software automatically sets the size of a new
logical drive to maximize the capacity of the disk drives that it comprises. However,
you can choose to set the size for a new logical drive. You may want to do this to
maximize the available disk drive space, or allocate available space to more than one
logical drive.
1. Complete Step 1 through Step 6 in “Custom Configuration (Advanced)” on
page 39.
2. Click Advanced Settings.
The maximum size of the logical drive appears in the Size (GB) box.
3. Enter the new size for the logical drive.
The size you enter must be less than or equal to the maximum size.
4. Click Next.
5. Review the logical drive settings, click Apply, then click Yes.
The Sun StorageTek RAID Manager software builds the logical drive. The
configuration is saved in the Sun HBA and in the physical drives.
If the disk drives you used to create this logical drive have available space left over,
you can use them to create a new logical drive (see “To Create a Logical Drive Using
Free Segments on Disk Drives” on page 67), or to expand an existing logical drive
(see “Increasing the Capacity of a Logical Drive” on page 76).
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Including Different-Size Disk Drives in a Logical
Drive
You can combine disk drives of different sizes in the same logical drive. If the logical
drive includes redundancy, however, the size of each segment can be no larger than
the size of the smallest disk drive. (See “Selecting the Best RAID Level” on page 263
for more information about redundancy.)

Note – Do not combine SAS and SATA disk drives within the same logical drive.
The Sun StorageTek RAID Manager software generates a warning if you try to create
a logical drive using a combination of SAS and SATA disk drives.
To create a logical drive with disk drives of different sizes, follow the instructions in
“Building a Storage Space” on page 35. When the logical drive is created, it is
displayed in a similar fashion to the following example. In this example, a RAID 5
logical drive includes two 16.95 GB disk drives and two 9.77 GB disk drives.

The Full Size Capacity View of the same RAID 5 logical drive shows that the two
larger disk drives still have available space (free segments are indicated in lightblue) that is not part of a logical drive.

66

Sun Intel Adaptec RAID User’s Guide • June 2009

You can include the available space on a disk drive in a new logical drive (see “To
Create a Logical Drive Using Free Segments on Disk Drives” on page 67), or add it to
an existing logical drive (see “Increasing the Capacity of a Logical Drive” on
page 76).

▼ To Create a Logical Drive Using Free Segments
on Disk Drives
Free segments on a disk drive can be used to create a new logical drive. (A segment
can only be used in one logical drive at a time.)
1. Complete Step 1 through Step 5 in “Custom Configuration (Advanced)” on
page 39.
2. In the Physical Devices panel, select the disk drives and/or free disk drive
segments you want to use in the logical drive.

Note – Do not combine SAS and SATA disk drives within the same logical drive.
The Sun StorageTek RAID Manager software generates a warning if you try to create
a logical drive using a combination of SAS and SATA disk drives.
In this example, two free disk drive segments (indicated in blue) are used to create a
RAID 1 logical drive.
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3. Click Next.
4. Review the logical drive settings.
5. Click Apply, then click Yes.
The Sun StorageTek RAID Manager software builds the logical drive. The
configuration is saved in the Sun StorageTek SAS RAID HBA and in the physical
drives.

Fine-Tuning Logical Drives
You can fine-tune a new or existing logical drive to meet your needs by changing its
name or adjusting the Advanced settings described in this section. (Not all options
are available for all HBAs or all RAID levels.)

68

Sun Intel Adaptec RAID User’s Guide • June 2009

Note – After making a change to a drive, you must manually rescan the BIOS or
reset power before changes to a drive can be seen in the GUI.

▼ To Change The Name of a Logical Drive
1. In the Enterprise View, click the HBA associated with the logical drive.
2. In the Logical Devices View, click the logical drive.
3. In the menu bar, choose Actions > Change logical device name.

4. Type the new name, and click OK.
The logical drive is updated with its new name.
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▼ To Change the Advanced Settings of a Logical
Drive
Note – The default settings in the Sun StorageTek RAID Manager software are
optimal for most users and storage spaces. Do not change the settings described in
this section if you are not an advanced user.
1. Open the list of Advanced settings.
2. If you are creating a new logical drive, follow the instructions in Step 6 in “To
Build the Storage Space With Custom Configuration” on page 40.
3. If you are modifying an existing logical drive do the following:
a. In the Enterprise View, click the HBA associated with the logical drive.
b. In the Logical Devices View, click the logical drive.
c. In the menu bar, choose Actions > Expand or change logical device.
d. Click Next, then click Advanced settings.
4. Modify the available settings as required for your logical drive (not all options
are available for all HBAs or all RAID levels):
■

Logical drive size (see “To Set the Size of a Logical Drive” on page 65)

■

Stripe size (see “Changing the Stripe Size” on page 70)

■

Write cache (see “Changing the Write Cache Setting” on page 71)

■

Read cache (see “Changing the Read Cache Setting” on page 71)

■

Initialize priority (see “Changing the Initialize Priority” on page 72)

■

Initialize method (see “Changing the Initialize Method” on page 72)

5. Click Next.
6. To apply the changes immediately, click Apply.
To schedule the changes for later, click Schedule, then set the date and time. (For
more information, see “Scheduling a Task” on page 121.)

Changing the Stripe Size
The stripe size is the amount of data (in KB) written to one partition before the HBA
moves to the next partition in a logical drive.
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Stripe size options vary, depending on your HBA. Normally, the default stripe size
provides the best performance.
For RAID 6 and RAID 60 logical drives, the more disk drives there are in the logical
drive, the fewer the stripe size options.

Changing the Write Cache Setting
The write cache setting determines when data is stored on a disk drive and when the
HBA communicates with the OS.
■

Disabled (write-through)—The HBA sends (or writes) the data to a disk drive,
then sends confirmation to the OS that the data was received. Use this setting
when performance is less important than data protection.

■

Enabled (write-back)—The HBA sends confirmation to the OS that the data was
received, then writes the data to a disk drive. Use this setting when performance
is more important than data protection and you are not using a battery-backup
cache. Enabled is the default setting.

Note – (RAID 10, 50, and 60 only) All logical drives within a RAID 10/50/60 logical
drive must have the same write cache setting—either all write-through or all writeback.

▼ To Change the Write Cache Setting
1. Click the logical drive you want.
2. In the menu bar, choose Actions > Configure write cache > Enabled or
Disabled, as required.
The write cache setting is changed.

Changing the Read Cache Setting
When read caching is enabled, the HBA monitors the read access to a logical drive
and, if it sees a pattern, pre-loads the cache with data that seems most likely to be
read next, increasing performance.
■

Enabled—The HBA transfers data from the logical drive to its local cache in
portions equal to the stripe size. Use this setting for the best performance when
workloads are steady and sequential. Enabled is the default setting.
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■

Disabled—The HBA transfers data from the logical drive to its local cache in
portions equal to the system I/O request size. Use this setting for the best
performance when workloads are random or the system I/O requests are smaller
than the stripe size. (For more information about system I/O requests, refer to
your OS documentation.)

▼ To Change the Read Cache Setting
1. Click the logical drive you want.
2. In the menu bar, choose Actions > Configure read cache > Enabled or Disabled,
as required.
The read cache setting is changed.

Changing the Initialize Priority
The Initialize Priority setting determines the priority for the initialization of the
logical drive. The default setting is High, which means that the logical drive is
initialized as quickly as possible.

Changing the Initialize Method
The Initialize Method setting determines how a logical drive is initialized (prepared
for reading and writing), and how long initialization will take. The settings are
presented in order of slowest to fastest method.
■

Build—(slowest) For RAID 1 logical drives, data is copied from the primary drive
to the mirror drive; for RAID 5 logical drives, parity is computed and written.
Build is the default setting for most logical drives (see the Quick method below).

The Sun StorageTek RAID Manager software performs build initialization in the
background; you can use the logical drive immediately.
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■

Clear—Every block in the logical drive is overwritten, removing all existing data.
You cannot use the logical drive until the initialization is complete.

■

Quick—(fastest) The logical drive is made available immediately. Quick is the
default setting for RAID 1, RAID 1EE, and RAID 10 logical drives.
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Verifying Logical Drives
To ensure that there are no data problems on your logical drives, it is important to
verify them. When you verify a logical drive, the Sun StorageTek RAID Manager
software checks it for inconsistent or bad data and then fixes any problems. (You can
also choose to verify a logical drive without fixing it.)

Note – Logical drives with no redundancy (for instance, RAID 0 logical drives) do
not need to be verified.
In the Sun StorageTek RAID Manager software, logical drive verification can occur
like so:
■

Automatic verification—If your HBA supports build initialization, the Sun
StorageTek RAID Manager software automatically verifies all new redundant
logical drives. No manual verification is required.

▼ To Confirm That the HBA Supports Build
Initialization
Right-click the HBA in the Enterprise View and click Properties.
■

Manual verification—If your HBA does not support build initialization, a
Warning-level event notice appears in the Event Viewer prompting you to verify
a logical drive before you begin to use it. To verify a logical drive manually, see
“To Verify and Fix a Logical Drive” on page 74.

■

Background verification—If your HBA supports background consistency check,
the Sun StorageTek RAID Manager software continually and automatically checks
your logical drives once the drives are in use.

▼ To Confirm That the HBA Supports Background
Consistency Checking
●

Right-click the HBA in the Enterprise View, then click Properties.
To enable or disable background consistency check, see “To Enable or Disable
Background Consistency Checking” on page 76.
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Note – If your HBA does not support background consistency checking, verify its
logical drives weekly. Follow the instructions in “To Verify and Fix a Logical Drive”
on page 74.

▼ To Verify and Fix a Logical Drive
Note – To verify a logical drive without fixing it, see “To Verify a Logical Drive
Without Fixing It” on page 75.
While the Sun StorageTek RAID Manager software verifies and fixes a logical drive,
you cannot complete any other tasks on the HBA. Because the verification can take a
long time to complete, you may want to schedule it as a task to be completed
overnight or on a weekend.
1. In the Enterprise View, click the HBA associated with the logical drive.
2. In the Logical Devices View, click the logical drive.
3. In the menu bar, choose Actions, > Verify with fix.

4. To begin the verification immediately, click Yes.
To schedule the verification, click Schedule, then set the date and time. You can
also choose to set the verification as a recurring task. (For more information, see
“Scheduling a Task” on page 121.)
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Note – Do not power off the system while the verification is in progress. If you do,
the verification will stop.
While the verification is in progress, the logical drive is shown as an
animated icon to indicate that the task is in progress.
When the verification is complete, an event notice is generated in the local
system’s event log (and broadcast to other systems, if you have event notification set
up—see “Using Notifications to Monitor Status” on page 97).
You can now continue working on the HBA.

▼ To Verify a Logical Drive Without Fixing It
Note – To verify and fix a logical drive, see “To Verify and Fix a Logical Drive” on
page 74.
While the Sun StorageTek RAID Manager software verifies a logical drive, you
cannot complete any other tasks on the HBA associated with that logical drive.
Because verification takes a long time to complete, you may want to schedule it as a
task to be completed overnight or on a weekend.
1. In the Enterprise View, click the HBA associated with the logical drive.
2. In the Logical Devices View, click the logical drive.
3. In the menu bar, choose Actions > Verify.
4. To begin the verification immediately, click Yes.
To schedule the verification for later, click Schedule, set the date and time, then
click Apply. You can also set the verification to recur. (For more information, see
“Scheduling a Task” on page 121.)

Note – Do not power off the system while the verification is in progress. If you do,
the verification will stop. While the verification is in progress, the logical drive is
shown as an animated icon (as shown at right) to indicate that the task is in
progress.
While the verification is in progress, the logical drive is shown as an animated
icon.
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When the verification is complete, an event notice is generated in the local system’s
event log (and broadcast to other systems, if you have event notification set up—see
“Using Notifications to Monitor Status” on page 97).
You can now continue working on the HBA.

▼ To Enable or Disable Background Consistency
Checking
If your HBA supports background consistency checking, the Sun StorageTek RAID
Manager software continually and automatically checks your logical drives once
they are in use. (To confirm that your HBA supports background consistency
checking, right-click the HBA in the Enterprise View, then click Properties.)
1. In the Enterprise View, click the HBA.
2. In the menu bar, choose Actions > Enable (Disable) background consistency
check.
The HBA is updated with the new setting.

Increasing the Capacity of a Logical
Drive
You can add more disk drive space to a logical drive to increase its capacity (or
expand it).

Note – The maximum size of a logical drive varies by HBA. Refer to your HBA’s
documentation for more information.
The expanded logical drive must have a capacity that’s greater than or equal to the
original logical drive.

Note – After making a change to a drive, you must manually rescan the BIOS or
reset power before changes to a drive can be seen in the GUI.
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▼ To Increase the Capacity of a Logical Drive
1. In the Enterprise View, click the HBA associated with the logical drive.
2. In the Logical Devices View, click the logical drive.
3. In the menu bar, choose Actions > Expand or change logical device.
A wizard opens to help you modify the logical drive.
4. Click Next.
5. Click on the disk drive(s) or disk drive segments you want to add to the logical
drive.

Note – Do not combine SAS and SATA disk drives within the same logical drive.
The Sun StorageTek RAID Manager software generates a warning if you try to create
a logical drive using a combination of SAS and SATA disk drives.

If you want to remove a specific disk drive or segment and replace it with another
one (for instance, replace a smaller disk drive with a larger one), click on the disk
drive you want to remove.
An X indicates that the selected disk drive will be removed from the logical drive,
and you are prompted to select another disk drive (of greater or equal size) to
replace it.
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6. Modify the Advanced Settings, if required.
See “Fine-Tuning Logical Drives” on page 69.
7. Click Next.
8. Review the new logical drive settings.
To make changes, click Back.

Note – Some OS have size limitations for logical drives. Before you save the
configuration, verify that the size of the logical drive is appropriate for your OS.
9. To update the logical drive immediately, click Apply, then click Yes.
To schedule the changes for later, click Schedule, set the date and time, then click
Apply. (For more information, see “Scheduling a Task” on page 121.)
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Extending a Partition on a Logical Drive
(Windows 2003, Windows XP, and Windows 2000 only) If you have expanded a logical
drive, you can extend the partition on that logical drive to use the newly added
space. Refer to your OS instructions for more information.

Changing the RAID Level of a Logical
Drive
As your requirements change, you can change the RAID level of your logical drives
to suit your needs. You may want to do this to add redundancy to protect your data,
or improve data availability for speedier access to your data. See “Selecting the Best
RAID Level” on page 263 for more information.
Changing the RAID level normally requires one or more disk drives to be added to
or removed from the logical drive. The Sun StorageTek RAID Manager software
does not allow you to continue unless you have the right number of disk drives
available.

Note – After making a change to a drive, you must manually rescan the BIOS or
reset power before changes to a drive can be seen in the GUI.

▼ To Change the RAID Level of a Logical Drive
1. In the Enterprise View, click the HBA associated with the logical drive.
2. In the Logical Devices View, click the logical drive.
3. In the menu bar, choose Actions > Expand or change logical device.
A wizard opens to help you change the RAID level.
4. Select a new RAID level, then click Next.
Only valid options are offered.
In the following example, a RAID 1 logical drive is being changed to a RAID 5
logical drive.
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5. In the Logical Devices panel, select the disk drives you want to use in the
modified logical drive.

Note – Do not combine SAS and SATA disk drives within the same logical drive.
The Sun StorageTek RAID Manager software generates a warning if you try to create
a logical drive using a combination of SAS and SATA disk drives.
The Sun StorageTek RAID Manager software prompts you to select the correct
number of disk drives. In the following example, you must select three disk
drives.
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If you want to remove a specific disk drive and replace it with another one (for
instance, replace a smaller disk drive with a larger one), click on the disk drive
you want to remove. An X indicates that the selected disk drive will be removed
from the logical drive.
6. Modify the Advanced Settings, if required.
See “Fine-Tuning Logical Drives” on page 69.
7. Click Next.
8. Review the new logical drive settings.
To make changes, click Back.

Note – Some OS have size limitations for logical drives. Before you save the
configuration, verify that the size of the logical drive is appropriate for your OS.
9. To update your logical drive immediately, click Apply, then click Yes.
To schedule the changes for later, click Schedule, set the date and time, then click
Apply. (For more information, see “Scheduling a Task” on page 121.)
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Deleting a Logical Drive
Caution – When you delete a logical drive, you lose all data stored on that logical
drive.

Note – After making a change to a drive, you must manually rescan the BIOS or
reset power before changes to a drive can be seen in the GUI.

▼ To Delete a Logical Drive
1. Ensure that you no longer need the data stored on the logical drive.
2. In the Enterprise View, click on the HBA associated with the logical drive.
3. In the Logical Devices View, click the logical drive.
4. In the menu bar, choose Actions > Delete logical device.

5. When prompted, click Yes to delete the device, or No to cancel the deletion.
If you click Yes, the logical drive is deleted. The disk drives or drive segments
included in the logical drive become available, and can be used to create a new
logical drive (see “To Create a Logical Drive Using Free Segments on Disk Drives”
on page 67), or to expand an existing logical drive (see “Increasing the Capacity of
a Logical Drive” on page 76).
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Working With Hot-Spares
A hot-spare is a disk drive that automatically replaces any failed drive in a logical
drive, and can subsequently be used to rebuild that logical drive. (For more
information on recovering from a disk drive failure, see “Recovering From a Disk
Drive Failure” on page 159.)

Note – After making a change to a drive, you must manually rescan the BIOS or
reset power before changes to a drive can be seen in the GUI.

Hot-Spare Limitations
■

You cannot create a hot-spare for RAID 0 logical drives, simple volumes, or
spanned volumes.

■

You cannot create a hot-spare from a disk drive that is already part of a logical
drive.

■

You must select a disk drive that is at least as big as the largest disk drive it might
replace.

■

You cannot designate a SAS hot-spare for a logical drive comprising SATA disk
drives, or a SATA hot-spare for a logical drive comprising SAS disk drives.

Global Hot-Spare Versus Dedicated Hot-Spare
A global hot-spare is not assigned to a specific logical drive and will protect any
logical drive on the HBA (except RAID 0 logical drives). You can designate a global
hot-spare before or after you build logical drives on a HBA; you can also designate a
global hot-spare while you are creating a logical drive. To designate a global hotspare, see “To Designate a Global Hot-Spare” on page 84.
A dedicated hot-spare is assigned to one or more specific logical drives and will only
protect those logical drives. (A dedicated hot-spare that has been assigned to protect
more than one logical drive is called a pool spare.) You must create the logical drive
before you can assign a dedicated hot-spare. If you create the logical drive using the
BIOS utility, you must wait until the build is complete before you can assign a
dedicated hot-spare. To assign a dedicated hot-spare or pool hot-spare, see “To
Assign a Dedicated or Pool Hot-Spare” on page 85.

Chapter 6

Managing Logical Drives and Hot-Spares

83

▼ To Designate a Global Hot-Spare
This section describes how to designate a global hot-spare before or after you build
a logical drive.

Note – To designate a global hot-spare while you are creating a logical drive, see
Step 6 in “To Build the Storage Space With Custom Configuration” on page 40.
1. In the Enterprise View, click the HBA on which you want a global hot-spare.
2. In the Physical Devices View, click the disk drive you want to designate as a
hot-spare.
See “Hot-Spare Limitations” on page 83 for help selecting a disk drive.
3. Click the Create global hot-spare drive button.

A plus sign is displayed beside the selected disk drive, indicating that it’s
designated as a hot-spare. (A yellow plus sign indicates an error. See “About the
Hot-Spare Icons” on page 86 for help solving the problem.)
FIGURE 6-1

Identifying a Global Hot-Spare - The Icon With The Plus Sign Next To It

Any other logical drives created on the HBA will automatically be protected by that
global hot-spare.
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▼ To Assign a Dedicated or Pool Hot-Spare
A hot-spare that has been assigned to one or more specific logical drives is called a
dedicated hot-spare. A hot-spare that has been assigned to protect more than one
logical drive is called a pool hot-spare.)

Note – You must create the logical drive before you can assign a dedicated hotspare. If you create the logical drive using the BIOS utility, you must wait until the
build is complete before you can assign a dedicated hot-spare.
1. In the Enterprise View, click the HBA on which you want a dedicated hotspare.
2. In the Physical Devices View, click the disk drive you want to designate as a
hot-spare.
See “Hot-Spare Limitations” on page 83 for help selecting a disk drive.
3. In the menu bar, choose Actions > Create dedicated hot-spare drive for > nameof-the-logical-drive.
FIGURE 6-2

Creating a Dedicated Hot-Spare Drive

A plus sign is displayed next to the selected disk drive, indicating that it is
designated as a dedicated hot-spare. (A yellow plus sign indicates an error. See
“About the Hot-Spare Icons” on page 86 for more information.)
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FIGURE 6-3

Identifying a Designated Hot-Spare

4. To use the same dedicated hot-spare to protect another logical drive (create a
pool hot-spare), repeat Step 2 and Step 3.

About the Hot-Spare Icons
TABLE 6-1
Icon

Hot-Spare Icons

Explanation

Action

Healthy global or dedicated hot-spare.

No action required.

Error on hot-spare:
• Hot-spare is not assigned to any
logical drives.

• Create at least one logical drive on the
same HBA.

• Hot-spare is too small to protect the
logical drive(s).

• Designate larger disk drive as hot-spare.

• Global hot-spare was designated
before any logical drives were built.

• Create at least one logical drive on the
same HBA.

Hot-spare has been built into a logical
drive after disk drive failure.

Designate replacement or other available
disk drive as new hot-spare; remove ‘hotspare’ designation from disk drive (see “To
Remove or Delete a Dedicated Hot-Spare”
on page 86).

▼ To Remove or Delete a Dedicated Hot-Spare
You can delete a dedicated hot-spare or remove it from a logical drive. You may
want to do this to:
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■

Make disk drive space available for another logical drive.

■

Convert a dedicated hot-spare into a global hot-spare.
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■

Remove the ‘hot spare’ designation from a disk drive that is no longer being used
as a hot-spare. (When a hot-spare is built into a logical drive after a disk drive
failure, it retains its ‘hot spare’ designation even though it can no longer protect
the logical drives it’s assigned to. See “Recovering From a Disk Drive Failure” on
page 159 for more information.)

1. In the Enterprise View, click the HBA associated with the hot-spare.
2. In the Physical Devices View, click the hot-spare.
3. In the menu bar, choose either of these options:

FIGURE 6-4

■

Actions > Delete dedicated hot-spare drive > logical-drive-name

■

Actions > Remove dedicated hot-spare drive from > logical-drive-name

Removing a Dedicated Hot-Spare Drive From a Logical Drive

The hot-spare is deleted or removed, and the disk drive becomes available for
other uses in your storage space.

▼ To Delete a Global Hot-Spare
You can delete a global hot-spare. You may want to do this to:
■

Make disk drive space available for another logical drive.

■

Convert a global hot-spare into a dedicated hot-spare.
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■

Remove the ‘hot spare’ designation from a disk drive that is no longer being used
as a hot-spare. (When a hot-spare is built into a logical drive after a disk drive
failure, it retains its ‘hot spare’ designation even though it can no longer protect
the logical drives it’s assigned to. See “Recovering From a Disk Drive Failure” on
page 159 for more information.)

1. In the Enterprise View, click the HBA associated with the hot-spare.
2. In the Physical Devices View, click the hot-spare.
3. In the menu bar, choose Actions > Delete hot-spare drive.
FIGURE 6-5

Deleting a Hot-Spare Drive

The hot-spare is deleted and the disk drive becomes available for other uses in
your storage space.

▼ To Enable Copyback
When a logical drive is rebuilt using a hot-spare (see “Failed Disk Drive Protected by
a Hot-Spare” on page 159), data from the failed drive is transferred to the hot-spare.
When copyback is enabled, data is moved back to its original location once the HBA
detects that the failed drive has been replaced. Once the data is copied back, the hotspare becomes available again. Copyback is disabled by default.
1. Right-click the HBA.
2. Choose Enable or Disable copy back mode.
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CHAPTER

7

Protecting Data
In addition to the standard (RAID 0, RAID 1, RAID 5, RAID 10, RAID 50) and
enhanced (RAID 1E, RAID 5EE, RAID 6, RAID 60) RAID levels, HBAs with the Sun
Advanced Data Protection Suite include two additional methods of protecting the
data on your storage space.
This chapter describes how to use snapshot to protect your stored data.

Creating a Snapshot
A snapshot is a frozen image of a logical drive at a particular point in time. You can
copy the data on one logical drive to another logical drive by creating a snapshot.
You may want to do this if you want to back up your data to tape, clone a drive, or
copy the data to multiple servers.
There are two snapshot options:
■

Snapshot Backup—Copies all data on a logical drive so that it can be moved from
one server to another. See “To Create a Snapshot with Backup” on page 90.

■

Snapshot Nobackup—Creates a temporary copy of a logical drive for tape
backup and reference (uses less system resources than Snapshot Backup). See “To
Create a Snapshot Without Backup” on page 91.

To delete an existing snapshot, see “To Delete a Snapshot” on page 91.

Snapshot Limitations
■

Windows and Linux compatible only.

■

You can create a snapshot of only one HBA at a time; you cannot create a
snapshot that includes multiple HBAs.
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■

The source logical drive (the logical drive that you are copying) and the target
logical drive (the logical drive that you are copying to) must be on the same HBA.

■

The source and target logical drives may have the same or different RAID levels.

■

You can create up to four snapshots on each HBA.

■

The size of the target logical drive must be greater than or equal to the size of the
source logical drive.

■

You cannot take a snapshot of a booted OS volume.

■

You cannot modify any information on a snapshot.

▼ To Create a Snapshot with Backup
Caution – To avoid a corrupted snapshot, ensure that no files are open or in use on
the source logical drive before you begin this task.
1. In the Logical Devices View, click the logical drive you want to copy.
2. In the menu bar, choose Actions > Create snapshot > with backup to > name-ofthe-target-logical-drive.

Note – Only logical drives that can support the snapshot are listed.

FIGURE 7-1

Creating a Snapshot With Backup to a Device

3. Click Yes to create the snapshot.
The snapshot is created on the target logical drive, which now appears in the Sun
StorageTek RAID Manager software with a camera icon beside it.
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FIGURE 7-2

Logical Drive Displayed With a Camera Icon Beside It

In FIGURE 7-2, the source logical drive has the number five on it and the target logical
drive with the snapshot has the number 50 on it.

▼ To Create a Snapshot Without Backup
1. In the Logical Devices View, right-click the logical drive you want to copy.
2. In the menu bar, choose Actions > Create snapshot > without backup to >
target-logical-drive-name.
3. Click Yes to create the snapshot.
The snapshot is created on the target logical drive, which now appears in the Sun
StorageTek RAID Manager software with a camera icon beside it, as shown above.
4. Use an OS-level or third-party data backup tool to move the snapshot onto a
tape drive or other server.

▼ To Delete a Snapshot
When a snapshot is no longer needed, you can delete it from the Sun StorageTek
RAID Manager software.
1. In the Logical Devices View, right-click the snapshot you want to delete.
A navigational menu appears.
2. Choose Remove snapshot.
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FIGURE 7-3

Removing a Snapshot

3. Click Yes to delete the snapshot.
The snapshot is deleted
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CHAPTER

8

Monitoring Storage Space
This chapter describes how the Sun StorageTek RAID Manager software helps you
monitor your storage space. The chapter contains the following sections:
■

“Monitoring Options” on page 93

■

“Checking Activity in Your Storage Space” on page 94

■

“About the Status Icons” on page 96

■

“Using Notifications to Monitor Status” on page 97

■

“Broadcasting Event Alerts to Users” on page 115

■

“Managing Enclosure Status” on page 116

■

“Silencing and Testing the Audible Alarm” on page 118

Monitoring Options
The Sun StorageTek RAID Manager software provides many ways to monitor the
status of your storage space:
■

Event Viewer—The main window of the Sun StorageTek RAID Manager software
includes an Event Viewer that provides at-a-glance status information about
activity occurring in your storage space. (See “Checking Activity in Your Storage
Space” on page 94.)

■

Status Icons—Three basic icons (information, warning, and error) appear in the
Event Viewer and in the main Sun StorageTek RAID Manager software window
to help you quickly identify problems. (See “About the Status Icons” on page 96.)

■

Notification Manager and E-mail Notification Manager—Notification utilities
help you monitor these activities on local and remote systems (see “Setting Up
Event Notifications” on page 97 and “Setting Up E-mail Notifications” on
page 106):
■

Progress of scheduled tasks, such as logical drive verifications.
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■

Changes in the status of the physical components of your storage space, such
as disk drives.

■

Changes to the local system, such as the expansion of a logical drive expansion
or the creation of a hot-spare.

■

Audible Alarm—A series of beeps sounds whenever a serious event occurs on
your storage space. (See “Silencing and Testing the Audible Alarm” on page 118.)

■

Properties Button—You can check the status of any component in your storage
space by using the Properties button. (See “Viewing Component Properties” on
page 137.)

Checking Activity in Your Storage Space
From the local system, you can see status information and messages about the
activity (or events) occurring in your storage space.

▼ To View the Full List of Events
●

To open a full-screen version of the event log, go to the Event Viewer by
clicking the Events button.

You can sort the events by clicking the column heads.

▼ To View Event Details
1. From the Event Viewer, review the log of events.
Status is indicated by an icon in the left-hand column. The icons are described in
“About the Status Icons” on page 96.
2. Double-click an event to see more details about the event.
The Configuration event detail window appears.
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3. From the Configuration event detail window, click Next to see the next event in
the list.
You can monitor activity on, and the status of, remote systems from the local system
by using the Sun StorageTek RAID Manager software’s two notification utilities to
broadcast messages—the Notification Manager (see “Setting Up Event Notifications”
on page 97) and the E-mail Notification Manager (see “Setting Up E-mail
Notifications” on page 106).

▼ To View the Full List of Events
1. To open a full-screen version of the event log, click the Events button.

▼ To Clear All the Event Logs Belonging to All
HBAs in a System
1. In the Enterprise View, click the system you want.
2. In the menu bar, choose Actions > Clear logs on all controllers.
3. Click Yes to clear the log.
The log for the selected system is cleared, except for one event reporting that the
log was cleared.
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About the Status Icons
The Sun StorageTek RAID Manager software indicates event status with icons. The
following table lists the three categories, or types, of events based on severity.
TABLE 8-1
Icon

Event Status Icons

Status

Examples

Information

The local system successfully connected to a remote system.
A logical drive was created.
A hot-spare was created.
A logical drive was deleted.

Warning

A logical drive is in a degraded state.
A disk drive is being rebuilt.
An HBA is not responding to an enclosure.
An enclosure fan or power supply has failed.

Error

An HBA has failed.
A logical drive has failed.
A hot-spare has failed.
A disk drive within a logical drive has failed.
An enclosure is overheating.
Multiple fans or power supplies within an enclosure have failed.
An enclosure is not responding.

Warning- and Error-level icons appear next to components (such as systems and
logical drives) affected by a failure or error, creating a trail, or rapid fault isolation,
that helps you identify the source of a problem when it occurs. See “Identifying a
Failed or Failing Component” on page 158 for more information.

Note – All Warning- and Error-level events also cause the audible alarm to sound.
See “Silencing and Testing the Audible Alarm” on page 118 for more information.
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Using Notifications to Monitor Status
You can set up the Sun StorageTek RAID Manager software to broadcast messages
(or notifications) to selected remote systems and users when an event, such as the
creation of a logical drive or the failure of a disk drive, occurs on the local system.
(For more information about event types, see “Checking Activity in Your Storage
Space” on page 94.)
You can set up one or both of these types of notifications for any system in your
storage space:
■

Event notifications—Messages about a system are sent to the Event Viewer of
other systems in your storage space. See the following section.

■

E-mail notifications—Messages about a system are sent by E-mail to specified
users. See “Setting Up E-mail Notifications” on page 106.

Setting Up Event Notifications
Event notifications are messages about events on one system that are sent to the
Event Viewer of another system in your storage space. These messages, called
logged notifications, can help you monitor activity on your entire storage space from
a single local station, and are especially useful in storage spaces that include
multiple systems running the Sun StorageTek RAID Manager Agent only.
Logged notifications include status information and identify which system (or
source) an event occurred on. For instance, in this example, the Event Viewer
indicates that two logical drives were added to a system named ‘gas1668b’.
FIGURE 8-1

Identifying Event Types

Logged notifications are not sent to all systems in your storage space. In the
Notification Manager, you can specify which systems will send and receive logged
notifications; then, you can add or delete systems as your storage space grows and
changes.
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Opening the Notification Manager and Adding
Systems
This section describes how to set up event notifications for one system in your
storage space. You must complete the tasks in this section for each individual system
that you’ll be monitoring with logged notifications.

▼ To Set Up Event Notifications for a System
1. Note this information for each system that will receive event notifications
about the selected system:
■

Host name or TCP/IP address

■

TCP/IP port number (or the default, 34571)

2. In the Sun StorageTek RAID Manager software menu bar, choose Configure >
system-you-want > Notifications.
FIGURE 8-2

Opening the Notification Manager

The Notification Manager appears on the Notifications tab of a new window. The
local system is automatically included on the Notification List—by default, all local
events are listed in the local Event Viewer.
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FIGURE 8-3

Notifications Manager

3. To the Notification List, add the names of the other systems in your storage
space that will receive event notifications generated by the system you selected
in Step 2:
a. In the tool bar, click Add system.
b. In the Add System window, enter the host name or TCP/IP address of the
first system.
If you are not using the default port number, 34571, enter the TCP/IP port.
Then, click Add.
c. If you want more than one system to receive the event notifications, repeat
Step b as required.
d. When done, click Cancel to close the Add System window.
The systems you added are displayed in the Notification List. Although you cannot
sort the list, you can reorganize the columns by clicking and dragging the column
heads.
FIGURE 8-4

Reorganizing the Columns of the Notification List

You can specify which levels of events are sent to individual systems by following
the instructions in “Modifying the Address, Host Name, or Notification Level of a
System” on page 101.
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4. Close the Notifications window when you are done.

Note – You can access other utilities in this window, such as the Task Manager (see
“Managing Tasks” on page 121), by clicking their tabs.
5. Repeat Step 1 to Step 4 for each system you want to monitor with event
notifications.

Sending a Test Event
To ensure that a system is receiving logged notifications, you can send a test event.

▼ To Send a Test Event
1. Open the Notification Manager.
See “Opening the Notification Manager and Adding Systems” on page 98.

Note – You can also access the Notification Manager by selecting the system you
want in the Enterprise View, then (on the menu bar) clicking Actions > Agent actions
> Configure > Notifications tab.
2. In the Notification List, click on the system you want to send a test event to.

Note – You can only send a test event to one system at a time.
3. On the menu bar, choose Actions > Send test event.
The test event is sent. A message appears indicating either that the test event was
sent successfully or that the test failed. (Click OK to clear the message.)
If the test is successful, the receiving system beeps once, and its Event Viewer shows
that a test event was received.
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FIGURE 8-5

Viewing the Result of a Test Notification

▼ To Troubleshoot a Failed Test
1. Ensure that the receiving system is powered on and running the Sun
StorageTek RAID Manager software.
2. Open the receiving system’s System Properties window (see Step 3) and
double-check the TCP/IP address and port number.
3. Try sending the test event again.

Managing the Event Notification List
This section describes how to manage systems in the Notification List:
■

To add a system to the Notification List, see “Setting Up Event Notifications” on
page 97.

■

To modify a system’s connection information, see “Modifying the Address, Host
Name, or Notification Level of a System” on page 101.

■

To remove a system from the Notification List, see “Removing a System From the
Notification List” on page 102.

Modifying the Address, Host Name, or Notification
Level of a System
If you want to specify the notification level for a system, or if the TCP/IP
information or host name of a system changes, update its properties in the
Notification Manager.
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Note – Does this system receive event notifications from more than one other
system? Ensure you enter the updated information in the Notification Manager of all
affected systems.

▼ To Modify System Information
1. Open the Notification Manager.
See “Opening the Notification Manager and Adding Systems” on page 98.
2. In the Notification List, click the system you want to modify.
3. In the System Properties window, enter the new information or select a new
notification level in the Event Type drop-down menu, then click OK.
The Notification List shows the modified information.
FIGURE 8-6

Notification System Properties

Removing a System From the Notification List
You can remove any system (including the local system) from the Notification List.
Once a system has been removed, logged notifications from the local system are no
longer sent to it.

102

Sun Intel Adaptec RAID User’s Guide • June 2009

▼ To Remove a System From the Notification List
1. Open the Notification Manager.
See “Opening the Notification Manager and Adding Systems” on page 98.
2. In the Notification List, click on the system you want to remove.
3. In the tool bar, click Delete system.
4. Click Yes to confirm the deletion.
The system is removed from the Notification List.

Monitoring and Managing the Notification Log
The Notification Log displays status information and messages about the
Notification Manager itself, such as whether notifications were sent successfully or
not.
This section describes how to manage the Notification Log and use it to monitor the
logged notifications being sent:
■

Using the Notification Log (see the following section).

■

Clearing the Notification Log (see “To Clear the Notification Log” on page 104).

Using the Notification Log
By default, notification events are listed in the order they occurred, with the most
recent event first. To make it easier to find a specific event, click on the column heads
to sort the events. You can also reorganize the columns by clicking and dragging the
column heads.
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The Notification Log uses icons to show the status of events. These icons also appear
in the Event Viewer of the remote systems.
TABLE 8-2
Icon

Notification Log Icons

Status

Explanation and Solution

Information

The Notification Manager successfully connected and sent the event.
No action required.

Error

The Notification Manager did not successfully connect to a system or
send an event. Ensure that the correct host name and TCP/IP address
of the receiving system is correct.

Double-click on an event to see basic information about it. Click Next to see the next
event in the list.
FIGURE 8-7

Notification Event Detail Window

▼ To Clear the Notification Log
To make it easier to monitor recent events, you can clear the Notification Log.
1. Open the Notification Manager.
See “Opening the Notification Manager and Adding Systems” on page 98.
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2. In the menu bar, choose File > Clear the event log > Notifications.
FIGURE 8-8

Clearing the Event Log of Notifications

3. Click Yes to clear the log.
The log is cleared, except for one event reporting that the log was cleared.

Disabling and Re-Enabling Event Notifications
Event notifications are enabled by default. You can choose disable them, if required.

Note – If you disable event notifications, events will be generated but not
broadcast—not even to the local system.

▼ To Disable Event Notifications
1. Open the Notification Manager.
See “Opening the Notification Manager and Adding Systems” on page 98.
2. In the menu bar, choose Actions > Disable notifications.
Event notifications are disabled. The Notifications tab shows the red ‘disabled’
icon.
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FIGURE 8-9

Disabling Notifications

▼ To Re-Enable Event Notifications
●

Follow Step 1 and Step 2 in “Disabling and Re-Enabling Event Notifications” on
page 105, selecting Enable Notifications during Step 2.

3.

Setting Up E-mail Notifications
E-mail notifications are E-mail messages about events on a system in your storage
space that are sent to specified users. E-mail notifications can help you monitor
activity on your entire storage space from any location, and are especially useful in
storage spaces that include multiple systems running the Sun StorageTek RAID
Manager Agent only.
Only the users you specify receive E-mail notifications. (See “To Modify Information
About a Recipient” on page 111.) You can specify which types of events generate Email messages to which recipients to ensure that errors receive immediate attention
from the right people.
In the E-mail Notification Manager, you can add and delete E-mail recipients, and
modify the types of E-mail notices they receive, as your requirements change.

▼ To Set Up E-mail Notifications
This section describes how to set up E-mail notifications for one system in your
storage space. You must complete the tasks in this section for each individual system
that you’ll be monitoring with E-mail notifications.
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1. Note this information:
■

The address of your Simple Mail Transfer Protocol (SMTP) server (host name and
domain, or TCP/IP address)

■

The name and E-mail address of each person who will receive E-mail notifications

2. In the menu bar, choose Configure > system-name > E-mail Notifications.
FIGURE 8-10

Opening the E-mail Notification Manager

The E-mail Notification Manager appears on the E-mail Notifications tab of a new
window.
FIGURE 8-11

Displaying the E-mail Notifications Tab

3. If this is the first time you are opening the E-mail Notification Manager,
continue with “To Enter the SMTP Server Settings” on page 108.
To set up E-mail notifications, continue with “To Add an E-mail Recipient” on
page 108.
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▼ To Enter the SMTP Server Settings
The first time you are opening the E-mail Notification Manager, the SMTP Server
Settings window is opened automatically.
1. Enter the address of your SMTP server.
2. Enter the “From” address to be displayed in E-mail notifications.
FIGURE 8-12

SMTP Server Settings Window

If E-mail recipients will be replying to E-mail notifications, be sure that the
“From” address belongs to a system that is actively monitored.
3. Click OK to save the settings.
4. To set up E-mail notifications, continue with “To Add an E-mail Recipient” on
page 108.

▼ To Add an E-mail Recipient
1. Open the E-mail Notification Manager.
See “Setting Up E-mail Notifications” on page 106.
2. In the menu bar, click Add E-mail recipient.
The Add E-mail Recipient window appears.
3. In the Add E-mail Recipient window, enter the name and E-mail address of the
recipient.
4. In the Event Type drop-down menu, select an event level.
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FIGURE 8-13

Add E-mail Recipient Window

For more information on event levels, see “About the Status Icons” on page 96.
5. Click Add.
6. Repeat Step 3 to Step 5 to add more E-mail recipients.
7. Click Cancel to close the Add E-mail Recipient window.
The E-mail recipients you added are now displayed in the E-mail List.
FIGURE 8-14

E-mail Recipients in the E-mail List

Although you cannot sort the list, you can reorganize the columns by clicking and
dragging the column heads.
8. Close the E-mail Notifications window when you are done.

Note – You can access other utilities in this window, such as the Task Manager (see
“Managing Tasks” on page 121), by clicking their tabs.
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9. Repeat Step 1 to Step 8 for each system you want to monitor with E-mail
notifications.

▼ To Send a Test Message
To ensure that an E-mail recipient is receiving event notifications, you can send them
a test message.
1. Open the E-mail Notification Manager.
See “Setting Up E-mail Notifications” on page 106.

Note – You can also access the Notification Manager from the menu bar by choosing
Actions > Agent actions > Configure > E-mail Notifications tab.
2. Click the E-mail address to which you want to send the test message.

Note – You can only send a test message to one E-mail address at a time.
3. On the menu bar, choose Actions > Send test message.
FIGURE 8-15

Sending a Test E-mail Message

The test message is sent.
If the test is successful, the E-mail recipient receives the test message. If the test
fails:
a. Ensure that the recipient’s E-mail address is correct. (See “To Modify
Information About a Recipient” on page 111 to modify the address.)
b. Ensure that your SMTP server address is correct. (See “To Change the E-mail
Notification Manager Settings” on page 113 to modify the address.)
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c. Try sending the test message again.

Managing the E-mail List
This section describes how to:
■

Add an E-mail recipient, see “To Add an E-mail Recipient” on page 108.

■

Modify an E-mail recipient’s information, see “To Modify Information About a
Recipient” on page 111.

■

Remove an E-mail recipient, see “To Remove a Recipient From the E-mail List” on
page 111.

▼ To Modify Information About a Recipient
If the E-mail address of a recipient changes, or if you need to change the types of
event notifications the recipient receives, you can update the information about the
recipient in the E-mail List.
1. Open the E-mail Notification Manager.
See “Setting Up E-mail Notifications” on page 106.
2. Click on the name of the recipient.
3. Modify the information about the recipient as required, then click OK.

▼ To Remove a Recipient From the E-mail List
You can remove any recipient from the E-mail List. Once a recipient has been
removed, event notifications from the local system are no longer sent to that E-mail
address.
1. Open the E-mail Notification Manager.
See “Setting Up E-mail Notifications” on page 106.
2. Click the recipient you want to remove.
3. In the menu bar, choose Delete E-mail recipient.
4. Click Yes to confirm the deletion.
The recipient is removed from the E-mail List.
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Monitoring and Managing the E-mail Log
The E-mail Log displays status information and messages about the E-mail
Notification Manager itself, such as whether E-mail notifications were sent
successfully or not.
By default, E-mail events are listed in the order they occurred, with the most recent
event first. To make it easier to find a specific event, click on the column heads to
sort events. You can also reorganize the column by clicking and dragging the column
heads.
This section explains how to use and clear the E-mail Log.

▼ To Use the E-mail Log
1. Double-click on an event to see basic information about the event, including
the event type.
See “About the Status Icons” on page 96 for a list of event types.
FIGURE 8-16

E-mail Event Detail Window

2. Click Next to see the next event in the list.

▼ To Clear the E-mail Log
1. Open the E-mail Notification Manager.
See “Setting Up E-mail Notifications” on page 106.
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2. In the menu bar, choose Clear the event log > E-mail Notifications.
FIGURE 8-17

Clearing the Event Log of E-mail Notifications

3. Click Yes to clear the log.
The log is cleared, except for one event reporting that the log was cleared.

▼ To Change the E-mail Notification Manager
Settings
You can modify these E-mail Notification Manager settings as your needs change:
■

Address of your SMTP server

■

‘From’ address that will appear in E-mail notifications

1. Open the E-mail Notification Manager.
See “Setting Up E-mail Notifications” on page 106.
2. In the menu bar, choose Actions, > SMTP server settings.
The SMTP server settings window appears.
FIGURE 8-18

Changing the SMTP Server Settings for the E-mail Notification Manager

3. Enter the address of the SMTP server.
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4. Enter the From address that will be displayed in E-mail notifications.
If E-mail recipients will be replying to E-mail notifications, be sure that the From
address belongs to a system that is actively monitored.
5. Click OK to save the settings.

▼ To Disable E-mail Notifications
E-mail notifications are enabled by default, but can be disabled if required.

Note – If you disable E-mail notifications, events are generated but E-mail notices
are not broadcast.
1. Open the E-mail Notification Manager.
See “Setting Up E-mail Notifications” on page 106.
2. In the menu bar, choose Actions > Disable E-mail Notifications.
FIGURE 8-19

Disabling E-mail Notifications

E-mail notifications are disabled. The E-mail Notifications tab shows the red
disabled icon.

▼ To Re-Enable E-mail Notifications
●
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Broadcasting Event Alerts to Users
You can set the Sun StorageTek RAID Manager Agent to send event alerts about a
specific system to all users who are logged into your storage space. You might want
to do this if your storage space is not managed by a dedicated person, or if that
particular system is off-site or not connected to a monitor. Event alerts signal
everyone working on the storage space that a system requires technical assistance.
When you set the Sun StorageTek RAID Manager to broadcast event alerts, all
logged-in users receive messages about all types of events. In Windows, these alerts
appear as pop-up messages; in all other OS, these alerts appear as console messages.
When enabled, event alerts occur independent of event notifications (see “Setting Up
Event Notifications” on page 97) and E-mail notifications (see “Setting Up E-mail
Notifications” on page 106).

▼ To Enable Event Alerts
1. On the menu bar, choose Configure > system-name > General Settings.
FIGURE 8-20

Enabling Event Alarms

The General settings window appears for that system.
2. Select Broadcast events to logged-in users, then click Save changes.
3. Restart the Sun StorageTek RAID Manager software to apply the change.
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Managing Enclosure Status
If your storage space includes an enclosure with an enclosure management device,
such as a SCSI Accessed Fault-Tolerant Enclosure (SAF-TE) processor, the Sun
StorageTek RAID Manager software displays temperature, fan, and power module
status in the Physical Device view, as shown in the following figure.
FIGURE 8-21

Enclosure Status Icons

The enclosure status icons change color to indicate status.
TABLE 8-3

Enclosure Status Icons
Icon

Enclosure Fans

HBA Battery
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Status

Examples

Normal

Fans are working properly.

Warning

A fan has failed.

Error

Multiple fans have failed.

Normal

Battery temperature and charge is normal.

Sun Intel Adaptec RAID User’s Guide • June 2009

TABLE 8-3

Enclosure Status Icons
Icon

Enclosure
Temperature

Enclosure Power

Status

Examples

Normal

Enclosure temperature is normal.

Warning

Enclosure temperature is higher than normal.

Error

Enclosure is overheating.

Normal

Power supplies are working normally.

Warning

One power supply has failed.

Error

Multiple power supplies have failed.

Note – If your enclosure does not have an enclosure management device, the status
icons appear but do not indicate status.
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Silencing and Testing the Audible Alarm
The Sun StorageTek RAID Manager software supports an audible alarm which is
triggered on the local system when a Warning- or Error-level event (see “To View
Event Details” on page 94) occurs on any system in the Enterprise View. The alarm is
a series of beeps, which sound every five minutes until the event is resolved.
The alarm is disabled by default, but can be enabled on any system. You can also
change the frequency and duration of the alarm (see “To Change Alarm Settings On
a System” on page 60 for more information).
This section describes how to:
■

Enable a system’s alarm (see “To Enable an Alarm for a System” on page 118).

■

Ensure the alarm is working on your local system (see “To Test the Alarm” on
page 119).

■

Silence a sounding alarm (see “To Silence the Alarm” on page 120).

▼ To Enable an Alarm for a System
1. In the Enterprise View, select the system you want.
2. In the menu bar, choose Actions > Agent actions > Alarm Actions > Enable.
FIGURE 8-22

Enabling Alarms

The alarm is enabled for that system.
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▼ To Disable an Alarm
●

Repeat Step 1 and Step 2, above, but choosing Disable instead.

Caution – When the alarm is disabled, no audible signal sounds when a Warningor Error-level event occurs on the system.

▼ To Test the Alarm
1. Ensure that the speakers on your local system are not muted.
2. In the Enterprise View, click on your local system.
3. In the menu bar, choose Actions > Agent actions. > Alarm actions > Test alarm
FIGURE 8-23

Testing the Alarm

The alarm sounds.
4. To stop the test, click OK.

▼ To Silence the Alarm
When a Warning- or Error-level event occurs, you can silence the alarm on your local
system while you fix the problem.
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●

Click the Silence button in the main the Sun StorageTek RAID Manager
window.

Or:
●

120

In the menu bar, choose Actions > Agent actions > Alarm actions > Silence
alarm.
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CHAPTER

9

Managing Tasks
The Sun StorageTek RAID Manager software allows you to schedule some types of
jobs (or tasks) to complete at convenient times. Additionally, you can schedule some
tasks to recur at preset times.
A Task Manager utility helps you manage the tasks you schedule.
This chapter describes how to schedule, monitor, and manage tasks. The chapter
contains the following sections:
■

“Scheduling a Task” on page 121

■

“Opening the Task Manager” on page 123

■

“Monitoring Tasks” on page 125

■

“Modifying a Task” on page 126

■

“Deleting a Task” on page 129

■

“Disabling the Task Manager” on page 129

Scheduling a Task
If a task is lengthy and limits access to components on your storage space, you may
want to set a date and time for the task to complete, instead of running the task
while there is activity on your storage space.
If a task must be performed regularly, you can schedule it to recur at preset times.
You can schedule these Sun StorageTek RAID Manager software tasks:
■

Expanding a logical drive

■

Changing a logical drive’s RAID level

■

Modifying the stripe size of a logical drive
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■

Verifying a logical drive

■

Verifying and fixing a logical drive

▼ To Schedule a Task
1. Complete each step of the task until you are prompted to click Apply.
Do not click Apply. You will see a Schedule button on the Configuration
Summary screen.
FIGURE 9-1

Accessing the Schedule Button

2. Click Schedule.
The schedule window appears.

122

Sun Intel Adaptec RAID User’s Guide • June 2009

FIGURE 9-2

Schedule Window

3. Set the date and time for the task.

Note – Keep geography in mind—If you are scheduling tasks on remote systems
located in other geographical areas, remember that the time you set for a scheduled
task is that system’s time, which may be different from local time. You will be
prompted to select a new time if the one you’ve set occurs in the past on the remote
system.
4. Set the recurrence frequency, if the option is available for this task and you
want it to occur regularly.
5. Click Apply.
The task is saved in the Task Manager, and the scheduled task is added to the
Task List.

Opening the Task Manager
You can use the Task Manager to monitor and modify the tasks you have scheduled.
To schedule a task, see “Scheduling a Task” on page 121.

Chapter 9

Managing Tasks

123

Tasks are associated with systems. When you open the Task Manager, you see the
scheduled tasks associated with that local or remote system only.

▼ To Open the Task Manager
1. From the menu bar, choose Configure > system-name> Tasks.
FIGURE 9-3

Opening the Task Manager

The Task Manager appears on the Tasks tab of a new window. The Tasks tab has
two main panels: the Task List (upper panel) and the Task Event Log (lower
panel).
FIGURE 9-4

Task Manager Window

Note – From the Tasks tab, you can access other utilities in this window, such as the
E-mail Notification Manager (see “Setting Up E-mail Notifications” on page 106), by
clicking their tabs.
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Monitoring Tasks
Use the two main panels of the Task Manager—the Task List and the Task Event
Log—to monitor tasks.

Monitoring Upcoming Tasks in the Task List
The Task List displays all scheduled tasks in order of creation, and includes basic
information about each task. Although you cannot sort the tasks in any other order,
you can reorganize the columns in the Task List by clicking and dragging the
column heads.
The Status column of the Task List shows the current condition of each task:
■

Scheduled—The task is scheduled to be completed at a future date and time.

■

Executed—The task has been completed successfully.

■

Executed*—A recurring task has been completed once and will be repeated at the
scheduled time.

■

Error—The task has not been completed successfully. (For more information
about an error, double-click the task in the Task List to open the Task Properties
window.)

In the menu bar, click View task for additional detail about any task in the Task List.

▼ To Check Past Tasks and Events in the Event
Log
The Event Log displays detailed information about the Task Manager itself, such as
when scheduled events were modified, deleted, or completed successfully.
By default, task events are listed in the order they occurred, with the most recent
event first.
1. Click on the column heads to sort task events.
You can also reorganize the columns by clicking and dragging the column heads.
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2. Review the icons to determine the status of past tasks.
The following table describes the Event Log uses icons.
TABLE 9-1
Icon

Event Log Icons

Status

Explanation and Solution

Information

The task or event completed successfully. No action required.

Warning

The task missed its start time. Reschedule the task to clear the error,
as described in “Modifying a Task” on page 126.

Error

The task failed. Delete the task to clear the error. Schedule the task
again, as described in “Scheduling a Task” on page 121.)

3. Double-click on an event to see basic information about the event.
4. Click Next to see the next event in the list.

Modifying a Task
If your requirements change, you can reschedule a task to a different date or time.
You can also modify the task description that appears in the Task List. Creating a
custom task description makes it easier to find the task in the Task List.

▼ To Modify a Scheduled Task
1. From the menu bar, choose Configure > system-name > Tasks (as shown in
FIGURE 9-3).
The Task Manager appears.
2. In the Task Manager, select the task you want to change, then click Modify
task.
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FIGURE 9-5

Modifying a Scheduled Task

3. In the Modify Task window, make the required changes, then click OK.

Chapter 9

Managing Tasks

127

FIGURE 9-6

Modify Task Window

The task and Task List are updated with the new information.

Rescheduling a Task Following a Missed Start
Time
Tasks scheduled in the Sun StorageTek RAID Manager software include an
automatic 30-minute grace period following their start time, to accommodate
temporary interruptions. For instance, if there’s a brief power outage a task will run
once normal conditions resume, if the interruption lasts no longer than 30 minutes
past the scheduled start time.
If a task misses its start time, it must be rescheduled. For instructions, see
“Modifying a Task” on page 126.
If a recurring task misses its start time, it is automatically rescheduled to run at the
next scheduled interval.
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Deleting a Task
If a scheduled task is no longer required, you can delete it from the Task Manager.

▼ To Delete a Task
1. From the menu bar, choose Configure > system-associated-with-the-task-you-wantto-delete > Tasks (as shown in FIGURE 9-3).
The Task Manager appears.
2. In the Task Manager, select the task you want to delete, and click Delete task.
FIGURE 9-7

Deleting a Task

3. Click Yes to confirm the deletion.
The task is deleted.

Disabling the Task Manager
The Task Manager is enabled by default. If you do not wish to schedule tasks on a
selected system, you can disable it.

Note – If you disable the Task Manager, no scheduled tasks will run on that system.
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▼ To Disable the Task Manager
1. From the menu bar, choose Configure > system-name > Tasks (as shown in
FIGURE 9-3).
The Task Manager appears.
2. In the Task Manager menu bar, choose Actions > Disable Task Scheduler.
FIGURE 9-8

Disabling the Task Manager

The Task Manager is disabled. The Tasks tab shows the red disabled icon.

Note – When the Task Manager is disabled, a brief three-tone alert sounds each time
you open and log into the Sun StorageTek RAID Manager software. Scheduled tasks
in the Task List will not run while the Task Manager is disabled.

▼ To Re-Enable the Task Manager
Follow the steps in “Disabling the Task Manager” on page 129, selecting Enable Task
Scheduler during Step 2.
Scheduled tasks that have missed their start times must be rescheduled if you want
them to run. See “Modifying a Task” on page 126 for instructions.
Scheduled tasks that did not miss their start time while the Task Manager was
disabled will run as scheduled.

130

Sun Intel Adaptec RAID User’s Guide • June 2009

CHAPTER

10

Working with Display Groups
This chapter describes how to work with and manage display groups in the Sun
StorageTek RAID Manager software.
To create display groups, see “Creating Display Groups” on page 54.
The chapter contains the following sections:
■

“Adding a System to a Display Group” on page 131

■

“Viewing Display Group Status” on page 132

■

“Moving a System From One Display Group to Another” on page 133

■

“Renaming a Display Group” on page 134

■

“Removing a System From a Display Group” on page 134

■

“Deleting a Display Group” on page 135

Adding a System to a Display Group
As your storage space grows and changes, you can add new systems to your display
groups.

▼ To Add a System to a Display Group
1. Right-click on the system in the Enterprise View.
A navigational menu appears.
2. From the navigational menu, choose Change display group > display-group-name.
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FIGURE 10-1

Changing a Display Group

The system is added to the display group.
FIGURE 10-2

System Added to a Display Group

Note – A system can belong to only one display group at a time; you cannot include
the same system in multiple display groups.

Viewing Display Group Status
To quickly view the status of systems within a display group, you can open the
display group Properties window.
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▼ To View the Display Group Properties
●

In the Enterprise View, right-click on the display group, and choose Properties.
The Properties window appears for that display group, summarizing the status of
the systems that belong to that group.

Moving a System From One Display
Group to Another
▼ To Move a System From One Display Group to
Another
1. In the Enterprise View, right-click the system you want to move.
2. Choose Change display group > new-display-group-name.
FIGURE 10-3

Moving a System to a New Display Group

The system moves to its new display group.

Chapter 10

Working with Display Groups

133

Renaming a Display Group
You can make managing your storage space easier and more efficient by giving your
display groups meaningful names.

▼ To Rename a Display Group
1. In the Enterprise View, right-click on the display group.
A navigational menu appears.
2. From the navigational menu, choose Rename display group.
FIGURE 10-4

Renaming a Display Group

3. Enter a new name for the display group, then click OK.
The Enterprise View shows the new name of the display group.

Removing a System From a Display
Group
▼ To Remove a System From a Display Group
1. In the Enterprise View, right-click the system you want to remove.
A navigational menu appears.

134

Sun Intel Adaptec RAID User’s Guide • June 2009

2. From the navigational menu, choose Change display group > None.
The system is removed from the display group.

Note – Systems that are not part of display groups are listed at the top of the
Enterprise View, above any display groups.

Deleting a Display Group
If required, you can delete a display group. When you delete the display group, the
systems that belonged to it are listed at the top of the Enterprise View, above any
remaining display groups.

▼ To Delete a Display Group
1. In the Enterprise View, right-click on the display group.
A navigational menu appears.
2. From the navigational menu, choose Delete display group (as shown in
FIGURE 10-4).
The display group is deleted and the systems that belonged to it are no longer
grouped together in the Enterprise View.
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CHAPTER

11

Managing HBAs, Disk Drives, and
Enclosures
This chapter describes how to manage the HBAs, disk drives, and enclosures in your
storage space. The chapter contains the following sections:
■

“Viewing Component Properties” on page 137

■

“Blinking a Component” on page 138

■

“Managing Disk Drives” on page 139

■

“Managing HBAs” on page 142

■

“Managing Enclosures” on page 146

■

“Updating HBA BIOS and Firmware” on page 148

Viewing Component Properties
Click on any component in the main window of the Sun StorageTek RAID Manager
software, then click the Properties button (shown at right) to view version numbers,
status, model numbers, and other information about that component.
.
The properties listed vary, depending on which type of component you select.

137

Blinking a Component
You can blink the LEDs on enclosures, or disk drives inside enclosures, to identify
where they are physically located in your storage space. This table describes how to
blink specific enclosures and disk drives.
TABLE 11-1

Icons That Cause LEDs to Blink

To Blink This LED

Right-Click On This Icon

The disk drive

All disk drives connected to that
HBA

Disk Drive icon

HBA icon (in the Enterprise View or in the
Physical Devices View)

The enclosure

Enclosure Management Device icon

All disk drives included in a
logical drive

Logical Drive icon

All disk drives included in all the
logical drives on a selected HBA

All disk drives connected to
selected HBA ports

Text—In the Logical
Devices View of a HBA
with multiple logical
drives
Text—In the Physical Devices View of a
HBA with multiple ports

All disk drives connected to a
selected HBA channel

Text—In the Physical Devices View
of a HBA with multiple channels

All disk drives connected to a
selected HBA connector

Text—In the Physical Devices View
of a HBA with multiple connectors

▼ To Blink a Component
1. In the Sun StorageTek RAID Manager software, right-click the component,
then click Blink....
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Note – If the component you select (for instance, a HBA) does not support the blink
function, the Blink... option does not appear in the menu.
The LEDs on the disk drives or enclosures begin to flash.
2. Click OK to stop blinking the component.

Managing Disk Drives
This section describes how to use the Sun StorageTek RAID Manager software to
manage the disk drives that are part of your storage space.

Note – After making a change to a drive, you must manually rescan the BIOS or
reset power before changes to a drive can be seen in the GUI.

Replacing Disk Drives in a Logical Drive
You can replace one or more disk drives in a logical drive. You may want to do this
to upgrade to larger disk drives, or to make disk drive size uniform across the
logical drive.

Caution – If another disk drive in the logical drive fails during rebuild (see
“Rebuilding Logical Drives” on page 164), you may lose data.

▼ To Replace a Disk Drive in a Logical Drive
1. In the Physical Devices View, click the disk drive you want to replace.
2. Set the drive state to failed.
See “Setting a Disk Drive to ‘Failed’” on page 140.
3. Remove and replace the disk drive with one of equal or larger size.
4. Wait for the logical drive to rebuild.
See “Rebuilding Logical Drives” on page 164.
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5. Repeat Step 1 to Step 4 for all the disk drives you want to replace.
For help solving disk drive problems, see “Recovering From a Disk Drive Failure”
on page 159.

Setting a Disk Drive to ‘Failed’
Before you can remove a disk drive, you must set it to a failed state to protect your
data.

Caution – You may lose data or damage your disk drive if you remove a disk drive
without first setting it to a failed state.
You can set a disk drive to a failed state if:
■

The disk drive is not part of a logical drive, or

■

The disk drive is part of a redundant, healthy logical drive

You cannot set a disk drive to a failed state if doing so will take a logical drive
offline.

▼ To Set a Disk Drive to a Failed State
1. In the Physical Devices View, click the disk drive.
2. From the menu bar, choose Actions > Set drive state to failed.
3. Click Yes to set the drive status to failed.
4. Remove and replace the disk drive.
5. If the logical drive that the disk drive belongs to is failed, see “Recovering
From a Disk Drive Failure” on page 159.

Initializing Disk Drives
You can use the Sun StorageTek RAID Manager software to initialize any disk drives
that are in a Ready state, if required. You may want to do this to erase all existing
data and metadata (including all logical drive information).
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Caution – Do not initialize a disk drive that is part of a logical drive. Initializing a
disk drive that’s part of a logical drive may make the logical drive unusable.
Back up all data from your disk drive before you initialize it.

▼ To Initialize a Single Disk Drive
1. In the Physical Devices view, click the disk drive you want to initialize.
2. In the menu bar, choose Actions > Initialize.
FIGURE 11-1

Initializing a Disk Drive

3. Click Yes to initialize the disk drive.
The initialization begins.

▼ To Initialize All Ready Disk Drives on a HBA
1. In the Enterprise View, click the HBA whose disk drives you want to initialize.
2. In the menu bar, choose Actions > Initialize all ready drives.
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FIGURE 11-2

Initializing All Ready Disk Drives

3. Click Yes to initialize the disk drives.
The initialization begins.

Managing HBAs
This section describes how to use the Sun StorageTek RAID Manager software to
manage the HBAs that are part of your storage space. It contains the following
subsections:
■

“To Register a New HBA” on page 142.

■

“To Test an HBA Alarm” on page 143.

■

“To Silence an HBA Alarm” on page 143.

■

“To Disable an HBA Alarm” on page 144.

■

“To Rescan an HBA” on page 144.

■

“To Save The HBA Configuration” on page 145.

▼ To Register a New HBA
When you log into the Sun StorageTek RAID Manager software, it searches for new
HBAs in your storage space. If it detects a new HBA, you are prompted to register it.
●
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Click Register Now on the New hardware detected window.
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Follow the onscreen instructions to complete the registration.

▼ To Test an HBA Alarm
Note – Not all HBAs have alarms. Refer to your HBA documentation for more
information.
1. Ensure that the speakers on your local system are not muted.
2. In the Enterprise View, select the HBA you want.
3. In the menu bar, choose Actions > Alarm actions > Test alarm.
FIGURE 11-3

Testing the Alarm

The alarm sounds.
4. To stop the test, click OK.

▼ To Silence an HBA Alarm
You can silence the alarm on a HBA while you fix the problem.
●

Click the Silence button in the main Sun StorageTek RAID Manager software
window.
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▼ To Disable an HBA Alarm
You can disable the alarm for a selected HBA.

Caution – If you disable the alarm, no audible signal will sound when an error
occurs on the HBA.
1. In the Enterprise View, select the HBA you want.
2. In the menu bar, choose Actions > Alarm Actions > Disable.
The alarm is disabled for that system.

▼ To Rescan an HBA
After you connect a disk drive to or remove a ‘Ready’ (non-failed) disk drive from
an HBA, the Sun StorageTek RAID Manager software may not recognize the change
until it rescans the HBA.
1. In the Enterprise View, click the HBA.
2. From the menu bar, choose Actions > Rescan.
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FIGURE 11-4

Rescanning the HBA

The Sun StorageTek RAID Manager software scans all the channels or ports on
the HBA you selected.
When the scan is complete, a report appears.
3. Click Done after you have reviewed the scan report.

▼ To Save The HBA Configuration
If you require a record of your HBA configurations, you can use the Sun StorageTek
RAID Manager software to create a text file with this information about all HBAs on
a selected system:
■

HBAs

■

Disk drives

■

Disk drives used in logical drives

■

Logical drives

1. In the Enterprise View, click the local or remote system.
2. From the menu bar, choose Actions > Save printable configuration.
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FIGURE 11-5

Saving the HBA Configuration

m
The Save window appears.
3. In the Save window, browse to the directory you want, then enter a file name
for the report.
The default directory is the directory in which the Sun StorageTek RAID Manager
software is installed. The default file name is RaidCfg.log.
A text-file report is saved.

Managing Enclosures
This section describes how to manage the enclosures in your storage space. The
section contains the following subsections:
■

“To Test an Enclosure Alarm” on page 146.

■

“To Silence an Enclosure Alarm” on page 147.

■

“To Disable an Enclosure Alarm” on page 147.

▼ To Test an Enclosure Alarm
1. Ensure that the speakers on your local system are not muted.
2. In the Enterprise View, select the HBA that is connected to the enclosure you
want.
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3. In the Physical Devices View, right-click the enclosure icon of the enclosure
that you want.
A navigational menu appears.
4. Choose Alarm actions > Test alarm.
FIGURE 11-6

Testing the Enclosure Alarm

The alarm sounds.
5. To stop the test, click OK.

▼ To Silence an Enclosure Alarm
You can silence the alarm on an enclosure while you fix the problem.
Click the Silence button in the main Sun StorageTek RAID Manager software window.

▼ To Disable an Enclosure Alarm
You can disable the alarm for a selected enclosure, if required.

Caution – If you disable the alarm, no audible signal will sound when an error
occurs on the enclosure.
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1. In the Enterprise View, select the HBA that is connected to the enclosure you
want.
2. In the Physical Devices View, right-click the enclosure icon of the enclosure
that you want.
A navigational menu appears.
3. Choose Alarm actions > Disable.
FIGURE 11-7

Disabling the Enclosure Alarm

The alarm is disabled for that system.

Updating HBA BIOS and Firmware
Note – Do not perform this task if you are not and advanced user.
The Sun StorageTek RAID Manager software provides a wizard to help you update
the BIOS and firmware for the HBAs in your storage space. The ROM Update
wizard updates the BIOS and firmware for all HBAs of the same type on local and
remote systems. You can update one type of HBA at a time.

Before You Begin
Before you begin, download the latest firmware images from
http://support.intel.com/support/go/sunraid.htm. Image files typically
come in sets of two or more and have a .ufi file extension.
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▼ To Update the HBA BIOS and Firmware
1. In the Enterprise View, right-click Direct attached storage.
A navigational menu appears.
2. Choose Update controller images.
FIGURE 11-8

Updating the HBA BIOS and Firmware

The ROM Update wizard opens.
3. Click Next.
4. Click Add to browse to the firmware image files you downloaded, select the
files, then click Open.
FIGURE 11-9

Opening the Firmware Image Files
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5. In the wizard, select the image files you want, then click Next.
FIGURE 11-10

Selecting the Image Files in the Wizard

6. Select the HBAs you want to update, then click Next.
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FIGURE 11-11

Choosing the HBAs You Want to Update

7. Review the update summary, then click Apply.
8. When prompted, click Yes to begin the update.

Caution – Do not power down the HBA(s) during the update.
9. When the update is complete, click OK.
10. Restart the server(s) to activate the new firmware images.
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CHAPTER

12

Configuring SNMP Support
This chapter describes how to configure SNMP support for the Sun StorageTek
RAID Manager software. The Sun StorageTek RAID Manager software supports
SNMP “gets” and “traps” through the use of an SNMP agent. The chapter contains
the following sections:
■

“Configuring SNMP Support on Windows” on page 153

■

“Configuring SNMP Support on Linux” on page 155

Configuring SNMP Support on
Windows
Note – Be sure your Windows installation includes SNMP support. By default,
Windows 2000 and Windows XP do not install SNMP.

▼ To Install and Configure SNMP Support
1. Run the Sun StorageTek RAID Manager software installation program, as
described in “Installing the Software” on page 9.
SNMP support is installed automatically, unless you choose to not install it.
2. Follow the onscreen instructions to complete the installation, then restart your
system.
3. Open the Windows Computer Management tool, and select Services from the
tree.
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FIGURE 12-1

Selecting Services From the Windows Computer Management Tool

4. Double-click SNMP Service.
The SNMP Service Properties window appears.
5. Click the Traps tab, then enter the IP address of each system on which you
want to enable traps.
6. Click OK.
7. Start the SNMP service.
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Configuring SNMP Support on Linux
For the Linux OS, the Sun StorageTek RAID Manager software SNMP agent is a subagent that interfaces with the UCD-SNMP agentx architecture. UCD-SNMP is a
third-party package for Linux; for information, documentation, and downloads, see
www.net-snmp.org.

▼ To Configure SNMP Support
1. Install the Sun StorageTek RAID Manager software as described in “Installing
the Software” on page 9.
2. Add Sun OID information and agentx extension information to the snmp.conf.
3. Delete /var/agentx/master (socket file for agentx).
4. Start the snmpd daemon and agentx.
5. Start aus-snmp daemon.
Refer to your Linux documentation for information on configuring UCD-SNMP,
agentx, and setting up traps.
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CHAPTER

13

Troubleshooting
This chapter provides troubleshooting information about the software and the
storage space. The chapter contains the following sections:
■

“Troubleshooting Potential Software Issues” on page 157

■

“Identifying a Failed or Failing Component” on page 158

■

“Recovering From a Disk Drive Failure” on page 159

■

“Understanding Hot-Plug Limitations and Conditions” on page 163

■

“Rebuilding Logical Drives” on page 164

■

“Solving Notification Problems” on page 165

■

“Creating a Support Archive File” on page 165

■

“Understanding Error and Warning Messages” on page 166

Troubleshooting Potential Software
Issues
If you experience problems installing or using the Sun StorageTek RAID Manager
software, follow these suggestions:
■

Ensure that you are logged into the Sun StorageTek RAID Manager software at
the permission level you need to perform the tasks you want. (See
“Understanding Permission Levels” on page 20 for more information.)

■

Ensure that all managed systems are powered on and that you are logged in to
any remote systems you want to manage. (See “Understanding Permission
Levels” on page 20 for more information.)

■

Check all cable connections.

■

Try uninstalling and reinstalling the Sun StorageTek RAID Manager software.
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Identifying a Failed or Failing
Component
When a Warning- or Error-level event occurs, use the rapid fault isolation feature of
the Sun StorageTek RAID Manager software to quickly identify the source of the
problem.
For instance, in this example, a disk drive has failed. To find the failed disk drive,
follow the yellow Error icons.
FIGURE 13-1

158

Using Icons to Identify Failures

Sun Intel Adaptec RAID User’s Guide • June 2009

The GUI Displays Logical Drives as Failed When
a Blade or JBOD is Powered Off
If a disk subsystem, such as a blade or JBOD, is powered off separately from a host,
the operating system (OS) continues to detect the logical drives of that powered-off
disk subsystem. This is because the logical drives already existed prior to powering
off the blade or JBOD. In this situation, the OS expects the logical drives could return
to their operating status at any time. Therefore, the Sun StorageTek RAID Manager
GUI displays the logical drives as failed, assuming no physical drives are present.
This is expected behavior in the event that a disk subsystem is powered off
separately from a host. To return the logical drives to their operating status, reapply
power to the disk subsystem.

Recovering From a Disk Drive Failure
When a disk drive fails for any reason, it is represented in the Sun StorageTek RAID
Manager software with a red X.

This section explains how to recover when a disk drive fails:
■

If the logical drive was protected by a hot-spare (see “Failed Disk Drive Protected
by a Hot-Spare” on page 159).

■

If the logical drive was not protected by a hot-spare (see “Failed Disk Drive Not
Protected By a Hot-Spare” on page 161).

■

If there is a disk drive failure in more than one logical drive simultaneously (see
“Failure in Multiple Logical Drives Simultaneously” on page 161).

■

If it is a RAID 0 logical drive (see “Disk Drive Failure in a RAID 0 Logical Drive”
on page 162).

■

If multiple disk drives fail within the same logical drive (see “Multiple Failures in
the Same Logical Drive” on page 162).

Failed Disk Drive Protected by a Hot-Spare
When a logical drive is protected by a hot-spare, if a disk drive in that logical drive
fails the hot-spare is automatically incorporated into the logical drive and takes over
for the failed drive.
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For instance, when a disk drive fails in the RAID 5 logical drive, the logical drive is
automatically rebuilt (its data is reconstructed) using the hot-spare in place of the
failed drive. You cannot access the logical drive until the rebuilding is complete.

Note – In this example, the color of the hot-spare changed from light-blue to darkblue, showing that it is now part of a logical drive.

▼ To Recover From the Failure
1. Remove and replace the failed disk drive (following the manufacturer
instructions).
2. If copyback is not enabled, do the following:
a. Remove the ‘hot spare’ designation from the original hot-spare (the disk
drive that was built into the logical drive).
See “To Remove or Delete a Dedicated Hot-Spare” on page 86 for instructions.
b. Designate a new hot-spare to protect the logical drives on that HBA.
3. If copyback is enabled, no action is required.
Data is automatically moved back to its original location once the HBA detects
that the failed drive has been replaced.
See “To Enable Copyback” on page 88 for more information.
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Failed Disk Drive Not Protected By a Hot-Spare
When a logical drive is not protected by a hot-spare, if a disk drive in that logical
drive fails, remove and replace the failed disk drive. The HBA detects the new disk
drive and begins to rebuild the logical drive.
For instance, when one of the disk drives fails in the RAID 1 logical drive shown in
the next example, the logical drive is not automatically rebuilt. The failed disk drive
must be removed and replaced before the logical drive can be rebuilt.

▼ To Recover From the Failure
1. If the HBA fails to rebuild the logical drive, check that the cables, disk drives,
and HBAs are properly installed and connected.
2. If necessary, follow the instructions in “Rebuilding Logical Drives” on page 164.

Failure in Multiple Logical Drives Simultaneously
If a disk drive fails in more than one logical drive at the same time (one failure per
logical drive), and the logical drives have hot-spares protecting them, the HBA
rebuilds the logical drives with these limitations:
■

A hot-spare must be of equal or greater size than the failed disk drive it’s
replacing.

■

Failed disk drives are replaced with hot-spares in the order in which they failed.
(The logical drive that includes the disk drive that failed first is rebuilt first,
assuming an appropriate hot-spare is available—see the previous bullet.)

▼ To Troubleshoot the Failures
●

If there are more disk drive failures than hot-spares, see “Failed Disk Drive Not
Protected By a Hot-Spare” on page 161.

●

If copyback is enabled, data is moved back to its original location once the
HBA detects that the failed drive has been replaced.
See “To Enable Copyback” on page 88 for more information.
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Disk Drive Failure in a RAID 0 Logical Drive
Because RAID 0 volumes do not include redundancy, if a disk drive fails in a RAID
0 logical drive, the data cannot be recovered.
Correct the cause of the failure or replace the failed disk drives. Then, restore your
data (if available).

Multiple Failures in the Same Logical Drive
Except in RAID 6 and RAID 60 logical drives (see “RAID 6 Logical Drives” on
page 272), if more than one disk drive fails at the same time in the same logical
drive, the data cannot be recovered.
Correct the cause of the failure or replace the failed disk drives. Then, restore your
data (if available).

Note – In some instances, RAID 10 and RAID 50 logical drives may survive multiple
disk drive failures, depending on which disk drives fail. See “Selecting the Best
RAID Level” on page 263 for more information.

Removing the Icon of a Failed Disk Drive
Note – You can only complete this task on disk drives that are not included in any
logical drive.
When a disk drive fails, it may still be displayed in the Sun StorageTek RAID
Manager software although it is no longer available. To see an accurate
representation of your storage space and make it easier to monitor your disk drives,
you can remove a failed disk drive from the Physical Devices View.
In the Physical Devices View, right-click the failed disk drive, then click Remove
failed drive.
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Understanding Hot-Plug Limitations
and Conditions
Hot-plugging of hard disk enclosures is not supported from the Sun StorageTek
RAID Manager graphical user interface (GUI). However, hot-plugging of SAS/SATA
hard disk drives (HDDs) is supported through the GUI, but only within hard disk
enclosures under the following conditions:
■

“Hot-Unplug Removal Conditions” on page 163

■

“Hot-Plug Addition Conditions” on page 163

■

“Hot-Unplug and Plug Replacement/Reinsertion Conditions” on page 163

Hot-Unplug Removal Conditions
Hot-unplug, removal, of HDDs is supported under the following conditions:
■

After the HDDs are removed, you must wait until the configuration change is
detected and displayed within the GUI before performing any additional action to
the new physical device configuration of the HBA.

■

You can continue to configure the storage space.

Hot-Plug Addition Conditions
Hot-plug, add, of HDDs is supported under the following conditions:
■

After all HDDs are added to the enclosure, you must wait until the configuration
change is detected and displayed within the GUI before performing any
additional action to the new physical device configuration of the HBA.

■

You can continue to configure the storage space.

Hot-Unplug and Plug Replacement/Reinsertion
Conditions
Hot unplug and plug, replace/reinsert, of HDDs is supported under the following
conditions:

Chapter 13

Troubleshooting

163

■

If a hard disk drive is to be removed and replaced either into the same slot or a
different unused slot using the same disk drive or a new disk drive, you must
wait until the configuration change is detected and displayed within the GUI
before performing any additional action to the new physical device configuration
of the HBA:
a. Remove the selected hard disk drive.
b. Confirm that the GUI detects and displays the new configuration.
c. Replace/reinsert the hard disk (new or same) into an enclosure slot (same or
another unused slot).
d. Confirm that the GUI detects and displays the new configuration.

■

You can continue to configure the storage space.

Rebuilding Logical Drives
A hot-swap rebuild occurs when an HBA detects that a failed disk drive in a logical
drive has been removed and then reinserted.

▼ To Start a Hot-Swap Rebuild
1. Following the manufacturer instructions, gently pull the failed disk drive from
the server without fully removing it.
2. Wait for the disk drive to spin down fully before continuing.
3. If there is nothing wrong with the disk drive, reinstall it, following the
manufacturer instructions.
If necessary, replace the failed disk drive with a new disk drive of equal or larger
size.
4. The HBA detects the reinserted (or new) disk drive and begins to rebuild the
logical drive.
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Solving Notification Problems
To test notifications on your storage space, you can send test events or E-mails to
ensure that they are being received properly.

▼ To Troubleshoot a Failed Test Event
1. Ensure that the remote system is powered on and running the Sun StorageTek
RAID Manager software.
2. Open the remote system’s System Properties window (see Step 3 in “To Modify
System Information” on page 102) and double-check the TCP/IP address and
port number.
3. Try sending the test event again.
If the test E-mail fails:
a. Ensure that the E-mail address of the recipient is correct.
See “To Modify Information About a Recipient” on page 111 to modify the
address.
b. Ensure that the SMTP server address is correct.
See “To Change the E-mail Notification Manager Settings” on page 113 to
modify the address.
c. Try sending the test message again.

Creating a Support Archive File
Your Sun StorageTek RAID Manager software service representative might ask you
to create a configuration and status information archive file to help diagnose a
problem with your system.

▼ To Create the Archive File
1. In the Enterprise View, click the local or remote system on which the problem
is occurring.
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2. In the menu bar, select Actions, then click Save support archive.
3. Enter a name for the archive file or accept the default name, then click Save.

Understanding Error and Warning
Messages
This section provides detailed information about error and warning events that
occur in the Sun StorageTek RAID Manager software.

Warning Messages
TABLE 13-1

Warning Messages

Warning

Warning Message Text

ArrayCritical

Ready disk drives are still available

HotSpareTooSmall

The hot-spare is too small to protect the specified array

HotSpareWontWork

At least one logical drive is not protected by the specified hot-spare

InitLD

Hot-spare is too small for use by at least one array

NoService

The specified logical drive was not initialized

SyncLD

Could not contact the Sun StorageTek RAID Manager Agent. The
Sun StorageTek RAID Manager software may not function correctly.
Please start the Agent.

Error Messages
TABLE 13-2
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Error Messages

Error

Error Message Text

AbortTask

Could not stop the specified currently running task

AccessControl

Could not write the logical drive access control list

AddToDiskSet

Could not add drives to the specified diskset

AgentRemoved

Could not remove the specified Agent

Sun Intel Adaptec RAID User’s Guide • June 2009

TABLE 13-2

Error Messages (Continued)

Error (Continued)

Error Message Text (Continued)

ArrayInUse

Could not delete the specified array. One or more initiators
are logged into a logical drive(s) contained within this
array

ArraysInUse

Could not delete all of the specified arrays. One or more
initiators are logged into a logical drive(s) contained within
this array

BreakRemoteMirror

Could not break the specified remote mirror facet

CalibrateBatteryController

Could not recalibrate the specified battery

ChangeArraylName

Could not change the name of the specified array

ChangeBIOSMode

Could not change the BIOS-compatibility mapping

ChangeDiskSetName

Could not change the name of diskset

ChangeLogicalLun

Could not change the LUN of the specified logical drive

ChangeLogicalName

Could not change the name of the specified logical drive

ChangeNtpServer

Could not update the specified NTP server

ChangeTimeDate

Could not change the date and time

ChgAlarm

Could not change the alarm setting

ChgDataScrubRate

Could not change the background consistency check rate

ChgRebuildRate

Could not change the rebuild rate

ChgSCSIXferSpeed

Could not change the SCSI transfer speed

ChgStripeSize

Could not change the specified stripe size

ChgTaskPriority

Could not change task priority

ClearAdapterLogsFail

Could not clear the event logs for the specified system

ClearEnclosureLogsFail

Could not clear the event logs for specified enclosure

ClearHardDrive

Clear failed to start for the specified disk drive

CommFailure

You must re-establish communication with specified
system

CommFailure1

Restart the Sun StorageTek RAID Manager Agent to
establish communication with the local system

ControllerRescan

Could not rescan for the specified controller

ControllerRestart

Could not restart the specified controller

ControllerShutDown

Could not shut down the specified controller

CreateDiskSet

Could not create the diskset

CreateLDError

There was an error creating specified logical drive
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TABLE 13-2
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Error Messages (Continued)

Error (Continued)

Error Message Text (Continued)

CreateSimpleVolume

Could not create a simple volume

DataScrub

Could not change the background consistency check mode

DDDAdInternal

Failed drive—Controller internal failure

DDDDeviceNotFound

Failed drive—Device not found

DDDDeviceNotReady

Failed drive—Specified device will not come ready

DDDDriveAddedToSystem

Failed drive—Specified disk drive added to server

DDDDriveNotBelong1

Failed drive—Specified disk drive does not belong

DDDDriveNotBelong2

Failed drive—Specified disk drive does not belong

DDDDriveNotFound

Failed drive—Specified disk drive not found

DDDDriveNotPartOfCluster

Failed drive—Specified disk drive is not part of the cluster

DDDHardwareError

Failed drive—Internal hardware error

DDDInternalHW

Failed drive—Internal hardware error

DDDIOSubSystem1

Failed drive—I/O subsystem error

DDDIOSubSystem2

Failed drive—I/O subsystem error

DDDIOSubSystem3

Failed drive—I/O subsystem error

DDDSCSI1

Failed drive—SCSI error

DDDSCSI2

Failed drive—SCSI error

DDDSCSI3

Failed drive—SCSI error

DDDSCSIBusParity

Failed drive—SCSI bus parity error

DDDSCSIBusTest

Failed drive—SCSI bus test error

DDDSCSIChanNotOperational

Failed drive—SCSI channel is not operational

DDDSCSIErrUnknown

Failed drive—Unknown SCSI error

DDDUnknownDriveFound

Failed drive—Unknown disk drive on controller

DDDUnknownDriveInCluster

Failed drive—Unknown disk drive in cluster

DDDUnknownSASError

Failed drive—Unknown SAS error

DDDUserAcceptedInitChange

Failed drive—User accepted

DDDUserMarked

Failed drive—User marked 'failed'

DDDUserMarkedFailed

Failed drive—User marked 'failed'

DeleteArray

Could not delete the specified array

DeleteArrays

Could not delete all of the specified arrays
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TABLE 13-2

Error Messages (Continued)

Error (Continued)

Error Message Text (Continued)

DeleteDiskSet

Could not delete the diskset

DeleteHArray

Could not delete the specified spanned array

DeleteLogDrive

Could not delete the specified logical drive

DisCopyBackMode

Could not disable copy back mode

DisReadCache

Could not disable read cache

DisUnattendedMode

Could not disable unattended mode

DisWriteCache

Could not disable write cache

EnclosureRestart

Could not restart the specified enclosure

EnclosureShutDown

Could not shut down the specified enclosure

EnCopyBackMode

Could not enable copy back mode

EnReadCache

Could not enable read cache

EnUnattendedMode

Could not enable unattended mode

EnWriteCache

Could not enable write cache

EventNotSent

Could not send the event to the system

ExportedArray

Could not export the specified array

FactoryDefault

Could not restore the configuration to the factory-default
settings

FailbackDiskSet

Could not move diskset

FailedAtPort

The Sun StorageTek RAID Manager software failed to start
at specified port number

FailedSelfTest

Specified self-test problem code was returned from
specified controller, channel, SCSI ID, S/N

FailedSelfTestStart

One or more of the selected disk drives failed to execute the
self-test. View the RaidErrA.log file on the Sun StorageTek
RAID Manager Agent for details

FailedToConnect

Failed to connect to specified host name at specified port
number

FailedToReadNOT

Failed to read the notification list file

FailedToReadSEC

Failed to read the user accounts file

FailIncompatible

Failed to connect to the specified host name due to
incompatible software versions

FailOver

Could not fail from the active device to the passive device

FailoverDiskSet

Could not move diskset
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TABLE 13-2
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Error Messages (Continued)

Error (Continued)

Error Message Text (Continued)

HostList

Could not write the host initiator list

HotSwap

Could not enable the automatic rebuild on replacement
operation

ImageSelect

Could not change the firmware to the specified boot image

ImportConfig

Could not copy the configuration from the specified drives

ImportedArray

Could not import the specified array

IncreaseLogDrive

Could not increase the size of the specified logical drive

InitHardDrive

Could not initialize the specified disk drive

InitLogDrive

Could not initialize the specified logical drive

KillOtherController

Could not kill other controller

LDM

Could not start the specified logical drive reconfiguration

LogIn

The user could not be logged in

LogOut

The user could not be logged out

MaybeReadCache

Could not set read cache mode to 'enabled when protected
by battery'

MaybeWriteCache

Could not set write cache mode to 'enabled when protected
by battery'

MergeOwnNS

Could not copy the configuration from the non-shared
logical drives

Rebuild

Could not set the drive to the specified rebuild state

RemoveAHS

Could not delete the dedicated hot-spare drive

RemoveFromDiskSet

Could not remove drives from the specified diskset

RemoveSHS

Could not delete the specified standby hot-spare drive

ReplaceDHS

Could not replace the specified failed drive

RollbackSnapshot

Could not rollback the specified snapshot

ScanDrives

Could not perform the bus rescan

SetArrayOnline

Could not send the Array Optimal command to the
specified controller

SetChannelInitiatorId

Could not set the specified SCSI initiator ID

SetContDiskCachePolicy

Could not change the specified global drive cache policy

SetHostId

Could not set the specified controller name

SetITNexusLossTime

Could not change I_T nexus loss time
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TABLE 13-2

Error Messages (Continued)

Error (Continued)

Error Message Text (Continued)

SetMergeGroup

Could not set the specified merge-group number

SetPartnerId

Could not set the specified partner controller name

SetSpareSet

Could not change the specified spare set attribute

SetToAHotSpare

Could not create a dedicated hot-spare drive

SetToDefunct

Could not set the specified drive to failed

SetToEmpty

Could not remove the specified failed drive

SetToHotSpare

Could not create a hot-spare drive

SetToOnline

Could not set the specified failed drive to optimal

SetToSHotSpare

Could not create a standby hot-spare drive

SetWce

Could not change the write-cache mode

SyncArray

Could not start the array verify

SyncLogDrive

Could not start the logical drive verify

TargetInfo

Could not write the logical drive target information

Unblock

Could not unblock the specified logical drive

UnkillOtherController

Could not unkill other controller

UserAccounts

Could not write the target user account list

VerifyArray

Could not start the array verify

VerifyFixHardDrive

Verify with fix failed to start

VerifyHardDrive

Verify failed to start

VolumeInUse

Could not delete the specified logical drive. One or more
initiators are logged into the logical drive.
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CHAPTER

14

Frequently Asked Questions
This chapter provides quick references to frequently requested information about
basic tasks, functions, and concepts in the Sun StorageTek RAID Manager software.

Note – For troubleshooting tips, see “Troubleshooting” on page 157.
The appendix contains the following sections:
■

“How to Perform Common Tasks” on page 175

■

“About Terminology Clarifications” on page 178

■

“About Viewing Actions Menu Options” on page 180

■

“About Tasks That You Can Schedule” on page 184

How to Perform Common Tasks
This section describes how to perform common tasks with the software.

▼ To Set Up Your Storage Space
●

Follow the steps in “Getting Started Tasks” on page 1.

▼ To Create or Add a New Logical Drive
1. In the Enterprise View, right-click the HBA you want.
A navigational menu appears.
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2. Do one of the following:
■

From the navigational menu, choose Create logical device.

■

Click either of the buttons in the following table.

Create Buttons

For more information, see “Building a Storage Space” on page 35.

▼ To Open the Configuration Wizard
1. In the Enterprise View, right-click the HBA you want.
A navigational menu appears.
2. Do one of the following:
■

From the navigational menu, choose logical device.

■

Click either of the Create buttons.

See “Building a Storage Space” on page 35.

▼ To Turn Off an Alarm
●

Do one of the following:
■

Click the Silence button in the Enterprise View.

■

From the menu bar, choose Actions > Agent actions > Alarm actions > Silence
alarm.

See “Silencing and Testing the Audible Alarm” on page 118.
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▼ To Add a New User to the Software
Any user with a valid network user name and password can log into the Sun
StorageTek RAID Manager software.
See “Starting the Software” on page 16.

▼ To Add a Remote System
●

Click the Add button.

See “Logging Into Remote Systems” on page 51.

▼ To Prevent a User From Changing Your Storage
Space
●

See “Understanding Permission Levels” on page 20 for information on
restricting access.

▼ To Check Disk Drive or Logical Drive Status
●

Hold your cursor over the disk drive or logical drive to reveal status
information.

See also “Revealing More Disk Drive Information” on page 29.

▼ To Log Out of the Software
1. In the Enterprise View, click on the local system.
2. In the menu bar, select Actions, then click Log out.
See “Logging Out of and in to the Software” on page 21.
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▼ To Schedule a Task
1. Complete each step of the task until you are prompted to click Apply. (Do not
click Apply.)
2. Click Schedule.

Note – The Schedule button will not be displayed for tasks that cannot be
scheduled.
See “Scheduling a Task” on page 121.

▼ To Find the Task Manager
●

From the menu bar, choose Configure > system-name > Tasks.

See “Scheduling a Task” on page 121.

▼ To Find the Notification Manager
●

From the menu bar, choose Configure > system-name > Notifications.
See “Setting Up Event Notifications” on page 97.

▼ To Find the E-mail Notification Manager
●

From the menu bar, choose Configure > system-name > E-mail Notifications.

See “Setting Up E-mail Notifications” on page 106.

About Terminology Clarifications
This section describes the differences between terms used in the software.
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Software Versus Agent
The Sun StorageTek RAID Manager software is the full software application,
including the graphical user interface (windows, menus). It helps you build and
maintain the logical drives, HBAs, and disk drives that make up your storage space.
The agent is similar to a service that keeps your storage space running. Its job is to
monitor system health and manage event notifications, tasks schedules, and other
on-going processes on each system in your storage space. The Agent can run
independently of the full application.
See “About the Sun StorageTek RAID Manager GUI Software” on page 2 for more
information.

Internal Versus External RAID Branches of the
Enterprise View
The Internal RAID branch of the Enterprise View helps you manage the local and
remote systems in your storage space that have internal (or direct-attached)
storage—a RAID HBA and disk drives residing inside or directly attached to the
system. Internal RAID storage can only be accessed by the system to which it is
attached. This document addresses the internal RAID branch only.
FIGURE 14-1

Internal RAID Branch

The External RAID branch helps you set up and manage external storage—one or
more RAID HBAs and multiple disk drives that reside in a server, and which is
shared among multiple systems on a LAN.
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FIGURE 14-2

External RAID Branch

Event Notifications Versus E-mail Notifications
Versus Event Alerts
Event notifications (also called logged notifications) are messages about events on
one system that are sent to the Event Viewer of another system in your storage
space. (See “Setting Up Event Notifications” on page 97.)
E-mail notifications are E-mail messages about events on a system in your storage
space that are sent to specified users. (See “Setting Up E-mail Notifications” on
page 106.)
Event alerts are pop-up messages or console messages about all types of events on a
specific system, which are broadcast to all the users who are logged into your
storage space. (See “Broadcasting Event Alerts to Users” on page 115.)

About Viewing Actions Menu Options
This section describes the different options on the Actions menu, a commonly used
menu in the software. The options on the Actions menu change, depending on
whether you select a system, HBA, disk drive, or enclosure before accessing the
menu.

Note – You can access many Action menu options by right-clicking a component.
For example, right-click on a system to access most of the options shown in “To View
Local and Remote System Actions” on page 181. See “About the Actions Menu” on
page 33 for more information.
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▼ To View Local and Remote System Actions
1. In the Enterprise View, click on a local or remote system.
2. From the menu bar, choose Actions.
The action options that can be applied to the selected system are displayed.
Mouse-over the Actions menu to view all the Action options. The Agent actions
option displays additional menu options.

▼ To View HBA Actions
1. In the Enterprise View, click on an HBA.
2. From the menu bar, choose Actions.
The action options that can be applied to the selected HBA are displayed. Mouseover the Actions menu to view all the Action options.

▼ To View Disk Drive Actions
1. In the Physical Devices View, click on a disk drive.
2. From the menu bar, choose Actions.
The action options that can be applied to the selected disk drive are displayed.
Mouse-over the Actions menu to view all the Action options.
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▼ To View Enclosure Actions
1. In the Physical Devices View, click on an enclosure management device.
2. From the menu bar, choose Actions.
The action options that can be applied to the selected disk drive are displayed.
Mouse-over the Actions menu to view all the Action options.

▼ To View Logical Drives Actions
In the Logical Devices View, click on a logical drive. In the menu bar, choose Actions
to view these options.

▼ To View Internal RAID Storage Actions
In the Enterprise View, click Internal RAID. In the menu bar, select Actions to view
these options.
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▼ To View Notification Manager Actions
In the tool bar, click Configure, select the system you want, then click Notifications.
In the menu bar, select Actions to view these options.

▼ To View E-mail Notification Manager Actions
In the tool bar, click Configure, select the system you want, then click E-mail
Notifications. In the menu bar, select Actions to view these options.

▼ To View Task Manager Actions
In the menu bar, click Configure, select the system you want, then click Tasks. In the
menu bar, select Actions to view these options.
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About Tasks That You Can Schedule
You can schedule any of these tasks to run at a specified time:
■

Changing a logical drive from one RAID level to another (see “Changing the
RAID Level of a Logical Drive” on page 79).

■

Expanding the size of a logical drive (see “Increasing the Capacity of a Logical
Drive” on page 76).

■

Modifying a logical drives settings (see “Fine-Tuning Logical Drives” on page 69).

■

Verifying a logical drive (see “To Verify a Logical Drive Without Fixing It” on
page 75) or verifying and fixing a logical drive (see “To Verify and Fix a Logical
Drive” on page 74).

See “Scheduling a Task” on page 121 for more information.
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CHAPTER

15

Buttons and Icons At-a-Glance
This chapter provides quick references to the icons and buttons that display in the
Sun StorageTek RAID Manager software. The appendix contains the following
sections:
■

“Enterprise View Icons” on page 186

■

“Icons in the Physical Devices View” on page 186

■

“Icons in the Logical Devices View” on page 188

■

“Buttons in the Main Window” on page 189

■

“Buttons in the Notification Manager” on page 191

■

“Buttons in the E-mail Notification Manager” on page 191

■

“Buttons in the Task Manager” on page 192
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Enterprise View Icons
TABLE 15-1
Icon

Enterprise View Icons

Description

System with RAID HBA and directly attached disk drives or enclosures
Enclosure
HBA

Icons in the Physical Devices View
TABLE 15-2
Icon

Physical Devices View Icons

Description

Ready disk drive
Disk drive with free space
Disk drive with no free space
Failed disk drive
HBA battery

Healthy global or dedicated hot-spare
Hot-spare with error (see “About the Hot-Spare Icons” on page 86 for more
information)
Hot-spare being built into logical drive after disk drive failure
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TABLE 15-2

Physical Devices View Icons (Continued)

Hot-spare built into logical drive after disk drive failure
HBA
Enclosure Management Device
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Enclosure Status Icons
TABLE 15-3
Icon

Enclosure Status Icons

Description

Icon

Description

Enclosure fan(s) — normal

Enclosure fan(s) — error

Enclosure temperature — normal

Enclosure temperature — error

Enclosure Power — normal

Enclosure Power — error

Enclosure fan(s) — warning
Enclosure temperature — warning
Enclosure Power — warning

Icons in the Logical Devices View
TABLE 15-4
Icon

Logical Devices View Icons

Description

Logical drive
Logical drive with healthy hot-spare
Logical drive being initialized
Logical drive being modified
Logical drive being rebuilt after disk drive failure
Array with available space
Array with no available space
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Buttons in the Main Window
TABLE 15-5

Button

Main Window Buttons
For More Information, See This
Section

Click to Do the Following

Add a remote system

“Logging Into Remote
Systems” on page 51

Create a logical drive; open the
Configuration wizard

“Building a Storage Space” on
page 35

Silence the audible alarm

“Silencing and Testing the
Audible Alarm” on page 118

Check status and other properties of a
HBA, disk drive, or other component

“Viewing Component
Properties” on page 137

View the full Event log

“To View the Full List of
Events” on page 94

• Configure the agent settings
• Configure notification settings
• Configure E-mail notification
settings
• Check the status of scheduled tasks;
monitor and modify
scheduled tasks

• “Customizing the Agent” on
page 58
• “Setting Up Event
Notifications” on page 97
• “Setting Up E-mail
Notifications” on page 106
• “Managing Tasks” on
page 121

Open the online Help

“Getting Help” on page 33

See a text description of your disk
drives

“Revealing More Disk Drive
Information” on page 29

See the size capacities of your disk
drives

“Revealing More Disk Drive
Information” on page 29

See the size capacities of your disk
drives relative to each other

“Revealing More Disk Drive
Information” on page 29

Create a global hot-spare

“To Designate a Global HotSpare” on page 84

Create a logical drive

“Building a Storage Space” on
page 35

Delete a logical drive

“Deleting a Logical Drive” on
page 82
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TABLE 15-5

Main Window Buttons (Continued)

Button (Continued)
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Click to Do the Following (Continued)

For More Information, See This
Section (Continued)

Expand and collapse additional
information about disk drives and
logical drives

“Revealing More Disk Drive
Information” on page 29

Access logical drive-specific functions,
such as deleting

“Blinking a Component” on
page 138

Access channel-specific functions,
such as rescanning

“Blinking a Component” on
page 138

Access port-specific functions, such as
blinking

“Blinking a Component” on
page 138

Access device-specific functions, such
as initializing

“Blinking a Component” on
page 138
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Buttons in the Notification Manager
TABLE 15-6

Button

Notification Manager Buttons
For More Information, See
This Section

Click to Do the Following

Add a system that will receive
notifications generated by the
Notification Manager

“Setting Up Event
Notifications” on page 97

Update a system’s address, host name,
or notification level

“Modifying the Address,
Host Name, or
Notification Level of a
System” on page 101

Remove a system from the Notification
List

“Removing a System From
the Notification List” on
page 102

Buttons in the E-mail Notification
Manager
TABLE 15-7

Button

E-mail Notification Manager Buttons
For More Information, See
This Section

Click to Do the Following

Add the E-mail address of a user who
will receive notifications generated by
the E-mail Notification Manager

“Setting Up E-mail
Notifications” on page 106

Update a recipient’s E-mail address or
notification level

“To Modify Information
About a Recipient” on
page 111

Remove a recipient from the E-mail
Notification List

“To Remove a Recipient
From the E-mail List” on
page 111
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Buttons in the Task Manager
TABLE 15-8

Button
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Task Manager Buttons
Click to Do the Following

For More Information, See This
Section

View the details of a scheduled task

“Monitoring Tasks” on
page 125

Reschedule a task or change the
description of the task in the Task
List

“Modifying a Task” on
page 126

Delete a task that is no longer
required

“Deleting a Task” on
page 129
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PA RT

II

Uniform Command-Line Interface

This part describes how to use the Sun StorageTek RAID Manager CLI. It includes
the following chapters:
■

“Getting Started With the Command-Line Interface” on page 16-195

■

“Using the Command-Line Interface” on page 17-201

■

“hrconf Commands” on page 18-221

CHAPTER

16

Getting Started With the CommandLine Interface
This chapter explains how to get started with the command-line interface (CLI),
arcconf. The arcconf CLI can be used with RAID host bus adapters (HBAs).
This chapter contains the following sections:
■

“Command-Line Interface Functionality” on page 195

■

“Installing the Command-Line Interface” on page 196

■

“Starting the Command-Line Interface” on page 199

Command-Line Interface Functionality
The arcconf CLI allows you to do the following:
■

Create and delete logical drives.

■

Display and modify a limited set of configuration settings.

■

Copy configurations from one computer to another.

■

Recover from a failed physical device and rebuild an affected logical drive.

■

Flash new firmware and BIOS onto the controller.

■

Enable the controller to check the removal and connection of any disk drives.

■

Automatically update Windows drivers.

■

Provide access to the status and event logs of a controller.

■

Isolate problems and determine their causes.
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Installing the Command-Line Interface
This section contains the following subsections:
■

“About Installing the Command-Line Interface” on page 196

■

“To Install on the Windows OS” on page 197

■

“To Install on the Linux OS” on page 197

■

“To Install on the Solaris OS” on page 198

■

“To Install on VMware Technology” on page 198

About Installing the Command-Line Interface
To install the CLI, obtain the Sun StorageTek RAID Manager CD that is provided in
the product ship kit or obtain the latest version of the software at:
http://support.intel.com/support/go/sunraid.htm
The CLI is automatically installed in the same directory as the Sun StorageTek RAID
Manager software and must remain there.
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You can install the CLI on the following OS:
■

Windows OS

■

Linux OS

■

Solaris OS

■

VMware technology (ESX Server)

For information about the specific OS and technology product versions that are
supported, see the Sun StorageTek SAS RAID HBA installation documentation at:
http://docs.sun.com/app/docs/prod/stortek.raid.hba#hicl

▼ To Install on the Windows OS
1. Start the computer.
2. After the Windows OS starts, insert the Sun StorageTek RAID Manager CD.
3. When the installation program starts, follow the onscreen instructions to install
the CLI.

▼ To Install on the Linux OS
1. Start the computer.
2. After the Linux OS starts, insert and mount the Sun StorageTek RAID Manager
CD.
Red Hat: mount /dev/cdrom /mnt/cdrom
SuSE: mount /dev/cdrom /media/cdrom

3. Change to the cdrom directory.

Red Hat: cd /mnt/cdrom/linux/manager
SuSE: cd /media/cdrom/linux/manager
4. Extract the RPM package and install it.
rpm: install ./StorMan*.rpm

5. Unmount the CD:

Red Hat: umount /mnt/cdrom
SuSE: umount /media/cdrom
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▼ To Install on the Solaris OS
1. Insert the Sun StorageTek RAID Manager CD.
The CD mounts automatically. (If it does not, manually mount the CD using a
command similar to the one shown in this step. Refer to your OS documentation
for detailed instructions.)
mount -F hsfs -o ro/dev/dsk/c1t0d0s2/mnt

2. Install the Sun StorageTek RAID Manager software.
pkgadd -d/mount-point/solaris/manager/StorMan.pkg

3. Follow the onscreen instructions to complete the installation.
4. Eject or unmount the CD. Refer to your OS documentation for detailed
instructions.

▼ To Install on VMware Technology
1. Insert and then mount the Sun StorageTek RAID Manager CD.
mount -r /dev/cdrom /mnt/cdrom

2. Change to the cdrom directory.
cd /mnt/cdrom/linux/manager

3. Extract the Linux Sun StorageTek RAID Manager RPM package and install it.
rpm --install ./StorMan*.rpm

Note – Ignore the note that says “Application can be started by typing
/usr/StorMan/StorMan.sh”. The console has no graphical capability.
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Starting the Command-Line Interface
▼ To Start arcconf
Type the appropriate command for your OS:
Windows: c:\install-directory\arcconf.exe
Linux: /usr/install-directory/arcconf
Solaris: /usr/StorMan/arcconf
VMware: /usr/install-directory/arcconf

Replace install-directory with the directory where the CLI is installed.
To see a list of available commands, type arcconf at the prompt. The CLI command
functions are detailed in the next chapter.
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CHAPTER

17

Using the Command-Line Interface
This chapter explains how to use the text-based command-line interface that
provides the same functions as the Sun StorageTek RAID Manager graphical user
interface (GUI) in environments where a GUI is not available.
This chapter provides a description, syntax, and examples for each CLI command.
Text that you enter literally is shown in bold. Optional parameters are shown
enclosed in [square brackets]. Variables for which you must substitute values are
shown in italics. When you may select between multiple parameters, options are
separated by a bar ( | ).
This chapter contains the following sections:
■

“Understanding the Command-Line Interface” on page 201

■

“arcconf Commands” on page 204

Understanding the Command-Line
Interface
This section contains the following subsections:
■

“About the Command-Line Interface Modes” on page 202

■

“Identifying Return Codes” on page 202

■

“Using Event Log Files” on page 203

■

“Using Error Log Files” on page 203
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About the Command-Line Interface Modes
The command-line interface is used interactively or in batch mode. With interactive
mode, enter commands at the prompt. In batch mode, create scripts and run the
script in the appropriate shell. For example:
TABLE 17-1

Batch Files and Scripts

Environment

Batch File

Run Script

Windows

.bat

CMD.EXE

Linux/UNIX

.sh

sh / bash

In either mode, if the command fails, you immediately see an error message for the
command that failed. Other script messages that you might encounter indicate the
command completed successfully, or the command was aborted.
To access the online help, type arcconf, then press Enter.

Identifying Return Codes
The return values are as follows:
0x00: SUCCESS
0x01: FAILURE
The requested command failed
0x02: ABORT
The command was aborted because parameters failed validation
0x03: INVALID_ARGUMENTS
The arguments are incorrect. (Displays COMMAND help)
0x04: UNSUPPORTED
The command is unsupported
0x06: INVALID_ADAPTER

The adapter specified does not exist (special case for INVALID_ARGUMENTS)
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Using Event Log Files
The command-line interface event log shows the results of a command in the form of
the following:
■

Status – success/failure/aborted/invalid
arguments/unsupported/invalid adapter

■

Return code – 0x00/0x01/0x02/0x03/0x04/0x06

Additionally, when using the romupdate or driverupdate commands, the event
log displays the old and new version of the firmware or driver being updated.
This feature allows you to save logs documenting all commands. The following is an
example of saving a firmware update event log.
arcconf romupdate 1 as4805 noprompt eventlog romupdate_1.log
errorlog update_err.log

Using Error Log Files
The error log keeps an inventory of all relevant information from an event failure.
The error log file also contains return codes (for details see “Identifying Return
Codes” on page 202) that help diagnose why a command failed.
When saving an event log, you can specify the log name and path by using the
eventlog optional parameter, type name-of-CLI eventlog path, then press Enter.
This feature allows you to save logs documenting all event failures. The following is
an example of saving a driver update error log.
arcconf driverupdate_1 c:\sdrivers noprompt eventlog
driverupdate_1.log errorlog update_err.log
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arcconf Commands
This section provides information on the following arcconf commands:
■

“arcconf copyback” on page 204

■

“arcconf create” on page 205

■

“arcconf datascrub” on page 207

■

“arcconf delete” on page 208

■

“arcconf driverupdate” on page 208

■

“arcconf getconfig” on page 209

■

“arcconf getlogs” on page 210

■

“arcconf getstatus” on page 211

■

“arcconf getversion” on page 211

■

“arcconf identify” on page 212

■

“arcconf key” on page 212

■

“arcconf modify” on page 213

■

“arcconf rescan” on page 214

■

“arcconf romupdate” on page 215

■

“arcconf setalarm” on page 215

■

“arcconf setcache” on page 216

■

“arcconf setconfig” on page 217

■

“arcconf setname” on page 218

■

“arcconf setstate” on page 218

■

“arcconf task” on page 219

arcconf copyback
Description
Enables or disables the copyback feature, which attempts to keep drives in the
original slot order after rebuilds.

Syntax
arcconf copyback controller-number on | off
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Options
■

controller-number
The controller number

■

on|off
Enables or disables the copyback feature.

Example
arcconf copyback 1 on

arcconf create
Description
Creates a new logical drive. You must provide the channel and device ID of the
physical devices.
On redundant logical drives, arcconf performs auto synchronization.

Syntax
arcconf create controller-number logicaldrive [stripesize size] [legs
number] [name name] [priority low | medium | high] [Method build
| clear | quick] [ron | roff] [wt | tb | wbb]] [size | max]
[RAID-number] [channel-number channel-ID-number] [noprompt]
arcconf create controller-number logicaldrive rvolume volume [logicaldrive-number] [logical-drive-number] [noprompt]

Options
■

controller-number
The controller number

■

logicaldrive
A logical drive will be created

■

stripesize size
Optional parameter to specifying a stripe size. The size can be 16, 32, 64, 128, 256,
512 and 1024 KB. The default is 256 KB.

■

legs number
Optional parameter to specify the number of legs in the multi-layer array. Value is
an integer for RAID 0x. For RAID 50/60—2 - 16 legs, 3 - 16 drives/leg, 48 drives
max
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■

name name
Optional parameter to specify the alias name of a logical device that appears in
the utilities. Value is a string of up to 16 characters.

■

priority low|medium|high
Initialization priority for logical drive to be created.

■

method build|clear|quick
Initialization method for the logical drive.

■

ron|roff
Turn on or off logical drive read cache

■

wt|wb|wbb
wt / wb: disable or enable logical drive write cache write-through. wbb: enable
logical drive write cache write-back enabled when protected by a battery

■

size|max
The size of the logical drive in megabytes. Use max to set size to available space.

■

RAID-number
RAID level for the new logical drive. 0, 1, 1E, 10, 5, 5EE, 50, 6, 60, and volume are
supported.

■

channel-number ID-number
The space-delimited channel number and device number pairs for each device to
add to the logical drive.

■

rvolume volume
The RAID level for a RAID volume logical drive.

■

logical-drive-number logical-drive-number
Logical drive numbers for two or more logical drives to be concatenated into the
RAID volume. At least two must be used.

■

noprompt
Used mostly for the purpose of scripting setup, this parameter overrides all user
confirmations.

Example
arcconf create 1 logicaldrive STRIPESIZE 64 MAX 0 1 0 1 1 1 2
noprompt
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arcconf datascrub
Description
Sets the background consistency check modes of the controller.

Syntax
arcconf datascrub controller-number on | off | period days [noprompt]

Options
■

controller-number
The controller number

■

on|off|period days
on turns the background consistency check on.
off turns the background consistency check off.
period days the number of days to complete a background consistency check.
period automatically turns on the background consistency check days indicates a
minimum of 10 days (quick) and a maximum of 365 days (slow)

■

noprompt
Used mostly for the purpose of scripting setup, this parameter overrides all user
confirmations.

Example
arcconf datascrub 1 period 10

Chapter 17

Using the Command-Line Interface

207

arcconf delete
Description
Deletes a logical drive. All data stored on the logical drive will be lost. Spanned
drives cannot be deleted with this function.

Syntax
arcconf delete controller-number logicaldrive logical-drive-number-to-delete
| all logical-drive-number logical-drive-number [noprompt]
arcconf delete controller-number logicaldrive all [noprompt]

Options
■

controller-number
The controller number

■

logical-drive-number-to-delete|all
The number of the logical drive to be deleted. all deletes all logical drives.

■

logical-drive-number logical-drive-number
Logical drive numbers for two or more logical drives.

■

noprompt
Used mostly for the purpose of scripting setup, this parameter overrides all user
confirmations.

Examples
arcconf delete 1 logicaldrive 1 2 3
arcconf delete 1 logicaldrive all

arcconf driverupdate
Description
Updates Windows device drivers. When given a directory name, it attempts to
update a driver to the version found in the given directory.

Note – This command is available only on Windows systems.
Syntax
arcconf driverupdate directory-path
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Options
■

directory-path
The directory path containing the driver that you want to update.

Example
arcconf driverupdate C:\windowsall

arcconf getconfig
Description
Lists information about the controllers, logical drives, and physical devices. This
information can include (but is not limited to) the following items:
■

Controller type

■

BIOS, boot block, device driver, and firmware versions

■

Logical drive status, RAID level, and size

■

Physical device type, device ID, presence of PFA

■

Physical device state

■

Enclosure information: fan, power supply, and temperature status

Syntax
arcconf getconfig controller-number [ad | ld | pd | al]

Options
■

controller-number
The controller number

■

ad
Adapter information only

■

ld
Logical drive information only

■

pd
Physical device information only

■

al
All information
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Example
arcconf getconfig 1 ad

arcconf getlogs
Description
Obtains controller log information. Provides access to the status and event logs of a
controller.

Syntax
arcconf getlogs controller-number device | dead | event [clear |
tabular]

Options
■

controller-number
The controller number

■

device
Retrieve a log of any device errors the controller has encountered

■

dead
Retrieve a log that records any occurrences of defunct devices

■

event
Retrieve a log of special events that may have occurred (for example, rebuilds,
LDMs, and so on)

■

clear
Optional, clears the specified controller log

■

tabular
Optional, displays logs in a table format

Examples
arcconf getlogs 1 device
arcconf getlogs 1 device tabular
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arcconf getstatus
Description
The getstatus function displays the status of any background command that is
currently running. Including information about the most recent rebuild,
synchronization, logical-drive migration, and compaction/expansion. The
information includes the type of operation, status, logical drive number, logical
drive size, and percentage of the operation completed.

Note – getstatus reports currently active operations for both arcconf commands
and commands issued from the Sun StorageTek RAID Manager software. It reports
verify, clear, initialize, and secure erase operations on physical devices. It only
reports active operations. It does not display information if the operation is
completed.

Syntax
arcconf getstatus controller-number

Options
■

controller-number
The controller number

Example
arcconf getstatus 1

arcconf getversion
Description
Lists version information for all controllers or a specific controller’s software
components, including information about the BIOS, driver, firmware currently
running, and firmware that will run after a reboot.

Note – The firmware version that will run after a reboot is called the “staged”
firmware.

Syntax
arcconf getversion controller-number
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Options
■

controller-number
The controller number. If no controller number is specified, information for all
controllers is retrieved.

Example
arcconf getversion

arcconf identify
Description
Identifies a physical or logical device by blinking its LEDs

Syntax
arcconf identify controller-number logicaldrive logical-drive-number
arcconf identify controller-number device channel-number ID-number

Options
■

controller-number
The controller number

■

logicaldrive logical-drive-number
The number of the logical drive to be identified

■

device channel-number ID-number
The channel and ID number for the device to be identified

Examples
arcconf identify 1 device 0 0
arcconf identify 1 all

arcconf key
Description
Loads a feature key onto a Sun controller

Syntax
arcconf key controller-number set key-number
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Options
■

controller-number
The controller number

■

set key-number
type the key number provided by Sun

Example
arcconf key 1 set ABCD EFGH IJKL MNOP QRST UVWX

arcconf modify
Description
Morphs a logical device from one raid level to another (RAID Level Migration).
Expands a logical device from original to one with larger capacity (Online Capacity
Expansion). Can be used to make mirrored sets.

Syntax
arcconf modify controller-number from logical-drive-number to [stripe-size |
init-priority | legs | [size | max] RAID-number | channel-number IDnumber[channel-number ID-number]] [noprompt]

Options
■

controller#
The controller number

■

from
The logical drive to be modified

■

logical-drive-number
The logical drive number

■

to
The modifications

■

stripe-size
The stripe size in KB. Options are 16, 32, 64, 128, 256, 512, and 1024. the default is
256 KB.

■

init-priority
The priority level of the modification. Options are low, med, and high.

■

legs
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The number of subarrays for a RAID level-50 or RAID level 60 array. Possible
values are 2-16 legs and 3-16 drives/leg (to 48 drives maximum).
■

size | max
Desired size in MB or max to use all available space on the disk

■

RAID-number
The RAID level for the logical drive 0, 1, 5, 5EE, or 10.

Note – The channel number and ID number parameters is the list of devices that
will contain the target modification object.
■

channel-number
The channel number for the device

■

ID-number
The device_ID (device number) for the device

Note – Channel and device_ID are repeatable parameters.
■

noprompt
Used mostly for the purpose of scripting setup, this parameter overrides all user
confirmations.

Example
arcconf modify 1 from 1 to 262144 1 0 0 0 1

arcconf rescan
Description
Enables the controller to check for the removal of any disk drives in the ready state
and to check for the connection of any new disk drives to the controller. The
command returns when the rescan is complete.

Syntax
arcconf rescan controller-number

Options
■

controller-number
The controller number
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Example
arcconf rescan 1

arcconf romupdate
Description
Allows new firmware and BIOS to be flashed to the controller. A reboot is required
for the new firmware to take effect.

Note – This function is only supported in Windows and Linux. Be sure to copy the
*.UFI update files from the CD and not from the BIOS / firmware update diskettes.

Syntax
arcconf romupdate controller-number basename

Options
■

controller-number
The controller number

■

basename
The name of the ROM image basename or the fully qualified name if you have a
set of controller ROM images.

Note – All UFI files must be in the same directory prior to invoking arcconf. If
you are copying UFI files from floppy images, be sure to check all images.

Examples
arcconf romupdate 1 AC2200
arcconf romupdate 1 AC220001.UFI

arcconf setalarm
Description
Sets the state of the controller audible alarm, if present.
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Syntax
arcconf setalarm controller-number on | off | silence | test

Options
■

controller-number
The controller number

■

on
Enables the alarm

■

off
Disables the alarm

■

silence
Quiets the currently sounding alarm

■

test
Triggers the alarm

Examples
arcconf setalarm 1 test
arcconf setalarm 1 silence

arcconf setcache
Description
Changes a logical drive’s cache mode.

Syntax
arcconf setcache controller-number logicaldrive logical-drive-number [ron
| rof] [wt | tb | wbb] [noprompt]
arcconf setcache controller-number device channel-number ID-number [ron
| roff] [wt | tb | wbb] [noprompt]

Options
■

controller-number
The controller number

■

logicaldrive logical-drive-number
The number of the logical drive whose cache will be altered
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■

ron|roff
Turn on or off logical drive read cache

■

wt|wb|wbb
wt / wb: disable or enable logical drive write cache write-through. wbb: enable
logical drive write cache write-back when protected by a battery

■

device channel-number ID-number
The channel number and device number for the device

■

noprompt
Used mostly for the purpose of scripting setup, this parameter overrides all user
confirmations.

Examples
arcconf setcache logicaldrive 1 ron
arcconf setcache device 0 0 wb

arcconf setconfig
Description
Resets the controller's configuration. Logical drives are deleted, hard disks are reset
to the READY state.

Syntax
arcconf setconfig controller-number default [noprompt]

Options
■

controller-number
The controller number

■

default
Restores the controller’s default configuration

■

noprompt
Used mostly for the purpose of scripting setup, this parameter overrides all user
confirmations.
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Example
arcconf setconfig 1 default

arcconf setname
Description
Renames a logical drive.

Syntax
arcconf setname controller-number logicaldrive logical-drive-number newname

Options
■

controller-number
The controller number

■

logicaldrive logical-drive-number
The number of the logical drive to be renamed

■

new-name
The new name of the logical drive

Example
arcconf setname 1 logicaldrive 1 BACKUP_A

arcconf setstate
Description
Changes the state of a physical device from its current state to the designated state
(hot-spare).

Syntax
arcconf setstate controller-number device channel-number ID-number devicenumber hsp | rdy | ddd logicaldrive logical-drive-number [logical-drivenumber]

Options
■
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The controller number
■

device channel-number ID-number
The channel and ID number for the device

■

device-number
The device number for the device

■

hsp
Create a hot-spare from a ready drive

■

rdy
Remove a hot-spare designation

■

ddd
Force a drive offline

■

logicaldrive logical-drive-number
Logical drive number(s) used to create an assigned hot-spare

Examples
arcconf setstate 1 device 0 0 hsp logicaldrive 1 2 3
arcconf setstate 1 device 0 0 rdy logicaldrive 2

arcconf task
Description
Performs a task on a logical drive.

Syntax
arcconf task start | stop controller-number logicaldrive logical-drivenumber [verify_fix | verify | clear] [noprompt]
arcconf task start | stop controller-number device channel-number IDnumber[verify_fix | verify | clear | initialize | secureerase]
[noprompt]

Options
■

controller-number
The controller number

■

logicaldrive logical-drive-number
The number of the logical drive on which the task is to be performed
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■

device channel-number ID-number
The channel and ID number on which the task is to be performed

■

verify_fix
Verifies the disk media and repairs the disk if bad data is found

■

verify
Verifies the disk media

■

clear
Removes all data from the drive

■

initialize
Returns a drive to the READY state (erases the metadata)

■

secureerase
Removes all data from the drive in a secure fashion to prevent possible recovery
of the erased data

■

noprompt
Used mostly for the purpose of scripting setup, this parameter overrides all user
confirmations.

Example:
arcconf task start 1 logicaldrive 1 verify
arcconf task start 1 device 0 0 initialize
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CHAPTER

18

hrconf Commands

hrconf Commands
The following are the hrconf commands:
■

“hrconf backup” on page 222

■

“hrconf create” on page 222

■

“hrconf delete” on page 224

■

“hrconf driverupdate” on page 225

■

“hrconf getconfig” on page 226

■

“hrconf getstatus” on page 227

■

“hrconf getversion” on page 227

■

“hrconf identify” on page 228

■

“hrconf rescan” on page 229

■

“hrconf restore” on page 230

■

“hrconf romupdate” on page 231

■

“hrconf setboot” on page 232

■

“hrconf setconfig” on page 232

■

“hrconf setstate” on page 233

■

“hrconf task” on page 234

221

hrconf backup
Description
For large-scale deployments, stores the current controller and disk drive
configuration setting to a specific file. Stored files can be used with the restore
command to restore to another controller or disk drive. To restore, the controller or
disk drive must have the same configuration as it did before the backup. For
example: the same type of controller, same number and type of disk drives with
same IDs and channels.

Syntax
hrconf backup controller# filename

Options
■

controller#
The controller number

■

filename
The relative or absolute path with filename

Example
hrconf BACKUP 1 C:\WINDOWS\HR2200

hrconf create
Description
Creates logical drives. You must provide the channel and device ID of the physical
devices. On redundant logical drives, hrconf performs autosynchronization.
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Syntax
hrconf create controller# logicaldrive [[stripesize size] | [name] |
[low | medium | high] | [build | clear | quick]] max RAID#
channel# id# [channel# id#] [noprompt]

Options
■

controller#
The controller number

■

logicaldrive
A logical drive will be created

■

stripesize size
Optional parameter to specifying a stripe size. The size can be 16, 32, or 64 KB.

■

name
Optional parameter to specify the name of a logical device to be created.

■

priority low|medium|high
Initialization priority for logical drive to be created.

■

method build|clear|quick
Initialization method for the logical drive.

■

max
The size of the logical drive

■

RAID#
RAID level for the new logical drive. 0, 1, 10, and volume are supported.

■

channel# id#
The space-delimited channel number and device number pairs for each device to
add to the logical drive.
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■

noprompt
Used mostly for the purpose of scripting setup, this parameter overrides all user
confirmations.

Example
hrconf create 1 logicaldrive STRIPESIZE 64 MAX 0 1 0 1 1 1 2

hrconf delete
Description
Deletes a logical drive. All data stored on the logical drive will be lost. Spanned
drives cannot be deleted with this function.

Syntax
hrconf delete controller# logicaldrive [logicaldrive# [logicaldrive#] |
all] [noprompt]

Options
■

controller#
The controller number

■

logicaldrive logicaldrive# | all
The number of the logical drive(s) to be deleted or all to delete all logical drives

■

noprompt
Used mostly for the purpose of scripting setup, this parameter overrides all user
confirmations.
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Examples
hrconf delete 1 logicaldrive 1 2 3
hrconf delete 1 logicaldrive all

hrconf driverupdate
Description
Updates Windows device drivers. When given a directory name, it will attempt to
update a driver to the version found in the given directory.

Note – This command is available only on Windows systems.

Syntax
hrconf driverupdate dirname

Options
■

dirname
The directory path containing the driver that you want to update.

Example
hrconf driverupdate C:\windowsall
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hrconf getconfig
Description
Lists information about the controllers, logical drives, and physical devices. This
information can include (but is not limited to) the following items:
■

Controller type

■

Logical drive status, RAID level, and size

■

Physical device type, device ID, presence of PFA

■

Physical device state

Syntax
hrconf getconfig controller# [ad | ld | pd | al]

Options
■

controller#
The controller number

■

ad
Adapter information only

■

ld
Logical drive information only

■

pd
Physical device information only

■

al
All information

Example
hrconf getconfig 1 ad
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hrconf getstatus
Description
The getstatus function displays the status of any background command that is
currently running.

Syntax
hrconf getstatus controller#

Parameters
■

controller#
The controller number

Example
hrconf getstatus 1

hrconf getversion
Description
Returns the version information for all controllers or the optionally specified
controller.

Syntax
hrconf getversion [controller#]
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Options
■

controller#
The controller number. If a controller number is not specified, information is
returned for all controllers.

Example
hrconf getversion 1

hrconf identify
Description
Blinks the LEDs on a device(s) connected to a controller.

Syntax
hrconf identify controller# logicaldrive logicaldrive# | all
hrconf identify controller# device device# channel# id#

Options
■

controller#
The controller number

■

logicaldrive logicaldrive# | all
The number of the logical drive to be identified or all to identify all logical drives

■

device device#
The device number for the drive

■

channel# id#
The channel and ID number for the device
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Examples
hrconf identify 1 device 0 0
hrconf identify 1 all

hrconf rescan
Description
Enables the controller to check for the removal of any disk drives in the ready state,
and to check for the connection of any new disk drives to the controller. The
command returns when the rescan is complete.

Syntax
hrconf rescan controller#

Options
■

controller#
The controller number to scan
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Example
hrconf rescan 1

hrconf restore
Description
Restores the controller configuration by importing its configuration settings from a
specified file. Deletes the current configuration. The file must have been saved
through the backup command from a controller of the same type, same number, and
type of physical devices with same channels and device IDs. A reboot is required for
the configuration change to take effect.

Syntax
hrconf restore controller# filename [noprompt]

Options
■

controller#
The controller number

■

filename
The name of the file from which to read the configuration

■

noprompt
Used mostly for the purpose of scripting setup, this parameter overrides all user
confirmations.
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Example
hrconf restore 1 C:\WINDOWS\HR2200 noprompt

hrconf romupdate
Description
Note – This command is only available on systems running Windows or Linux.
Updates the controller or enclosure firmware. The ROM image file must be in the
same directory prior to invoking hrconf.

Syntax
hrconf romupdate controller# [controller] filename

Options
■

controller#
The controller number

■

controller
Update the controller, not the firmware

■

filename
The relative or absolute path with filename
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Example
hrconf romupdate 1 controller AS4830.UFI

hrconf setboot
Description
Marks a logical device bootable.

Syntax
hrconf setboot controller# logicaldrive logicaldrive#

Options
■

controller#
The controller number

■

logicaldrive logicaldrive#
The number of the logical drive to mark bootable

Example
hrconf setboot 1 logicaldrive 1

hrconf setconfig
Description
Resets the controller's configuration. Logical drives are deleted, hard disks are reset
to the READY state.
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Syntax
hrconf setconfig controller# default [noprompt]

Options
■

controller#
The controller number

■

default
Restores the controller’s default configuration

■

noprompt
Used mostly for the purpose of scripting setup, this parameter overrides all user
confirmations.

Example
hrconf setconfig 1 default

hrconf setstate
Description
Redefines the state of a physical device from its current state to the designated state,
or redefines a logical device state to force the logical drive online.

Syntax
hrconf setstate controller# logicaldrive logicaldrive# optimal
[noprompt]
hrconf setstate controller# device channel# id# hsp | rdy | rbl
[noprompt]
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Options
■

controller#
The controller number

■

logicaldrive logicaldrive#
The logical drive whose state will be altered

■

optimal
force a logical drive online

■

channel# id#
The channel and ID number for the device

■

hsp
Create a hot spare from a ready drive

■

rdy
Remove a hot spare designation

■

rbl
Rebuild drive

■

noprompt
Used mostly for the purpose of scripting setup, this parameter overrides all user
confirmations.

Examples
hrconf
hrconf
hrconf
hrconf

setstate
setstate
setstate
setstate

1
1
1
1

0 1 hsp
0 2 rdy
0 2 rbl
logicaldrive 1 optimal

hrconf task
Description
Performs a task on a logical drive.
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Syntax
hrconf task start controller# logicaldrive logicaldrive# verify_fix |
verify | clear [noprompt]

Options
■

controller#
The controller number

■

logicaldrive logicaldrive#
The number of the logical drive on which the task is to be performed

■

verify_fix
Verifies the disk media and repairs the disk if bad data is found

■

verify
Verifies the disk media

■

clear
Removes all data from the drive

■

noprompt
Used mostly for the purpose of scripting setup, this parameter overrides all user
confirmations.

Examples
hrconf task start 1 logicaldrive 1 verify noprompt
hrconf task stop 1 logicaldrive 1
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PA RT

III BIOS RAID Configuration Utility

This part describes how to use the Adaptec RAID Configuration Utility (ARCU) to
create hardware RAID arrays and volumes (single disks) managed by the Adaptec
HBA. The ARCU works for any x64 server running Linux, Windows, or the Solaris
OS. It does not work for SPARC servers. With SPARC servers, you need to boot to a
remote OS, create an array or volume for your OS locally, and then install your OS.
This part includes the following chapters:
■

“Overview” on page 19-239

■

“Using the Adaptec RAID Configuration Utility” on page 20-243

■

“Creating a RAID Array” on page 21-255

CHAPTER

19

Overview
This part describes how to use the Adaptec RAID Configuration Utility (ARCU) to
configure and provision RAID arrays on systems equipped with disk controllers that
use Adaptec-based Sun StorageTek™ RAID capability.
■

Chapter 20 describes the ARCU and provides instructions for using it.

■

Chapter 21 shows how to initialize an array using the ARCU.

The ARCU is a BIOS-level utility that is started by pressing Ctrl-A in response to a
prompt while the system is starting. For details, see “Running the Adaptec RAID
Configuration Utility” on page 244.

Note – After making a change to a volume or drive (including hot-plug actions)
while using the BIOS-based Adaptec RAID Configuration Utility (ARCU), a rescan
of the drives is necessary to see the changes. This can be done using the Rescan
Drives option or by simply navigating back to the ARCU main menu.

When to Use the Adaptec RAID
Configuration Utility
Adaptec-based controllers can be configured using either the ARCU, or using the
Sun StorageTek RAID Manager, a graphical user interface (GUI)-based utility.
However, the Sun StorageTek RAID Manager requires a functioning OS, and some
tasks must be done before the OS is installed. For these tasks, you must use the
ARCU.
The Sun StorageTek RAID Manager is described in the Sun StorageTek RAID Manager
Software User’s Guide and the Uniform Command Line Interface User’s Guide.
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OS Requirements and Limitations
On servers equipped with an Adaptec disk controller, all drives must be part of an
array or a volume before they can be used by the BIOS or the OS. Adaptec
controllers support single-drive volumes that can be used for drives that are not part
of a RAID array. This is especially important to note when you add drives to a
system.

Note – A volume is a single disk drive that is managed by the Adaptec disk
controller but is not part of an array.
Chapter 21 provides procedures for creating volumes and arrays.
If you are going to include your boot drive in a RAID array, you must configure the
array before installing your OS. For this, you must use the ARCU, as described in
Chapter 20.

Understanding Hot-Plug Limitations
and Conditions Within the Adaptec
RAID Configuration Utility
Hot-plugging of hard disk enclosures is not supported from within the Adaptec
RAID Configuration utility. However, hot-plugging of SAS and SATA hard disk
drives (HDDs) is supported, but only within hard disk enclosures and under the
following conditions:
■

“Hot-Unplug Removal Conditions” on page 241

■

“Hot-Plug Addition Conditions” on page 241

■

“Hot-Unplug and Plug Replacement or Reinsertion Conditions” on page 241

Note – Hot-plugging of hard disk drives is NOT supported during periods when
the controller is performing actions on logical drives. These actions include building,
rebuilding, or migrating RAID volumes.
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Hot-Unplug Removal Conditions
Hot-unplug removal of HDDs is supported under the following conditions:
■

The hard disk drive to be removed must not be a part of a logical device (its
status must be ‘available’).

■

After the hard disk drive is removed from the enclosure, you must perform a bus
scan by using the Rescan Drives option from the main menu of the Array
Configuration Utility (ACU).

■

You must confirm that the Disk Utility reports the correct configuration of the
attached target devices.

Hot-Plug Addition Conditions
Hot-plug add of HDDs is supported under the following conditions:
■

After the hard disk drive is added to the enclosure, you must perform a bus scan
by using the Rescan Drives option from the main menu of the ACU.

■

You must confirm that the Disk Utility reports the correct configuration of the
attached target devices.

Hot-Unplug and Plug Replacement or Reinsertion
Conditions
Hot unplug and plug replace/reinsert of HDDs is supported under the following
conditions:
■

The hard disk drive to be removed must not be a part of a logical device (its
status must be ‘available’).

■

If a hard disk drive is to be removed and replaced either into the same slot or into
a different unused slot using the same disk drive or a new disk drive, you must
perform a bus scan between the removal and the replacement steps, as follows:
a. Remove the selected hard disk drive.
b. Complete a bus scan by using the Rescan Drives option in the ACU.
See Chapter 20 for details.
c. Confirm that the Disk Utility reports the correct configuration of attached
target devices
d. Replace and reinsert the hard disk (either a new disk or the same disk) into
the enclosure slot (either the same slot or another unused slot).
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e. Complete a bus scan by using the Rescan Drives option in the ACU.
f. Confirm that the Disk Utility reports the correct configuration of attached
target devices.
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CHAPTER

20

Using the Adaptec RAID
Configuration Utility
This chapter describes how to use the Adaptec RAID Configuration Utility (ARCU),
a BIOS-based utility used to create and manage controllers, disk drives and other
devices, and arrays on systems equipped with an Adaptec-based disk controller. It
contains the following sections:
■

“Introduction to the Adaptec RAID Configuration Utility” on page 244

■

“Running the Adaptec RAID Configuration Utility” on page 244

■

“Using the ACU to Create and Manage Arrays” on page 245

■

“Using the Select Utility to Modify Controller Settings” on page 248

■

“Using the Disk Utilities to Manage Disk Drives” on page 252

Caution – On servers equipped with an Adaptec disk controller, all drives must be
part of a volume before they can be used by the BIOS or the OS. Adaptec controllers
support single-drive volumes that can be used for drives that are not part of a RAID
array. See Chapter 21 for more information.

Note – After making a change to a volume or drive (including hot-plug actions)
while using the BIOS-based Adaptec RAID Configuration Utility (ARCU), a rescan
of the drives is necessary to see the changes. This can be done using the Rescan
Drives option or by simply navigating back to the ARCU main menu.
Many of the tasks described in this document can also be done using the Sun
StorageTek RAID Manager graphical user interface (GUI). This is described in Parts
I and II of this document.
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Introduction to the Adaptec RAID
Configuration Utility
The Adaptec RAID Configuration utility provides three tools:
■

The Array Configuration Utility (ACU)—Use this for creating and managing
arrays and initializing and rescanning disk drives. See “Using the ACU to Create
and Manage Arrays” on page 245.

■

A Select Utility—This might be called SerialSelect or SATASelect. Use it for
modifying the controller and disk drive settings, and for checking the battery
status. See “Using the Select Utility to Modify Controller Settings” on page 248.

■

Disk Utilities—Use this for formatting or verifying disk drives. See “Using the
Disk Utilities to Manage Disk Drives” on page 252.

Running the Adaptec RAID
Configuration Utility
This section describes how to start and navigate through the Adaptec RAID
Configuration utility. The section contains the following subsections:
■

“To Start the Adaptec RAID Configuration Utility” on page 244

■

“To Navigate the Adaptec RAID Configuration Utility” on page 245

▼ To Start the Adaptec RAID Configuration Utility
1. Start an RKVM session, or connect a keyboard, mouse, and video device to the
server module.
2. Power on or start the server module.
3. When prompted, press Ctrl-A.
The Adaptec RAID Controller Utility (ARCU) screen appears.
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During bootup, if your system has insufficient memory, the following message
appears.
BIOS RAID Configuration Utility will load after system
initialization. Please wait... Or press <Enter> Key to attempt
loading the utility forcibly [Generally, not recommended]

Note – The first time you power on your system after you install a new controller,
the BIOS might display a configuration that does not match the system’s
configuration. This is normal behavior.

▼ To Navigate the Adaptec RAID Configuration
Utility
●

Use the arrow keys, Enter, Esc, and other keys on your keyboard to navigate
through the utility menus.
All the tools within the Adaptec RAID Configuration utility are menu-based.
Instructions for completing tasks are displayed onscreen.

Using the ACU to Create and Manage
Arrays
You can use the ACU, a tool of the Adaptec RAID Configuration utility, to create and
manage arrays. This section contains the following subsections:
■

“To Start the ACU” on page 246

■

“To Create a New Array With the ACU” on page 246

■

“To Manage Existing Arrays With the ACU” on page 246

■

“To Make an Array Bootable With the ACU” on page 247

■

“To Initialize Disk Drives With the ACU” on page 247

■

“To Rescan Disk Drives With the ACU” on page 247

■

“To Perform a Secure Erase on Disk Drives With the ACU” on page 248

■

“To Stop a Secure Erase in Progress With the ACU” on page 248
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▼ To Start the ACU
1. Start the Adaptec RAID Configuration utility.
See “To Start the Adaptec RAID Configuration Utility” on page 244.
2. On the ARCU screen, select Array Configuration Utility and press Enter.
3. Follow the onscreen instructions to create and manage arrays, and initialize,
rescan, and erase disk drives.

▼ To Create a New Array With the ACU
Note – You can create an array with the ACU or with the Sun StorageTek RAID
Manager GUI. However, creating an array using the GUI is up to three times as fast.
For more information, see the Sun StorageTek RAID Manager Software User’s Guide.
1. Select Create Arrays from the main ACU menu.
Only disk drives that can be used in a new array are available for selection. (Disk
drives must be initialized before they can be used in an array. See “To Initialize
Disk Drives With the ACU” on page 247 for more information.)
2. Use the Array Properties menu to modify the RAID level, size, name, stripe
size, and caching settings of the array.

Note – Creating a new array might change the BIOS boot order. Check the BIOS
settings to verify the correct boot order.

▼ To Manage Existing Arrays With the ACU
1. Select Manage Arrays from the main ACU menu.
2. From the Manage Arrays menu, do any of the following:
■

View the properties of an array.

Note – Failed drives are displayed in a different text color.
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■

Make an array bootable. See “To Make an Array Bootable With the ACU” on
page 247.

■

Assign or remove hot-spares.
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■

Delete an array.

Caution – Before deleting an array, back up the data to avoid permanently losing it.

▼ To Make an Array Bootable With the ACU
Note – You might need to change the system BIOS to modify the boot order. For
more information, refer to your computer documentation.
1. Select Manage Arrays from the main ACU menu.
2. Select the array that you want to make bootable, and then press Ctrl-B.

Note – You cannot make an array bootable while it is building, verifying, or
rebuilding.
The array number changes to Array 00, which makes the array the boot array.
3. Restart the computer.

▼ To Initialize Disk Drives With the ACU
If a disk drive is grayed-out (unavailable for use in a new array), it might need to be
initialized.
●

Select Initialize Drives from the main ACU menu.

Caution – Do not initialize a disk drive that is part of an array. Initializing a disk
drive that is part of an array might make the array unusable. Back up all data from
your disk drive before you initialize it.

▼ To Rescan Disk Drives With the ACU
●

Select Rescan Drives from the main ACU menu.
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▼ To Perform a Secure Erase on Disk Drives With
the ACU
When you perform a secure erase on a disk drive, all data on that disk drive is
completely and irretrievably eradicated. Secure erase performs three distinct writing
passes to the disk drive being erased—it does not just write zeros.
Performing a secure erase takes up to six times longer than clearing (or zeroing) a
disk drive. You might want to perform a secure erase only on disk drives that
contain confidential or classified information.

Note – To save time erasing a disk drive that does not contain sensitive information,
you can format it, or clear it with the Sun StorageTek RAID Manager GUI. Both
options take less time than the secure erase option, but might not offer enough
security for highly sensitive information. See “Using the Disk Utilities to Manage
Disk Drives” on page 252) to format a disk drive.
●

Select Secure Erase from the main ACU menu, then select Y (yes).
To return to the main ACU menu after the secure erase has started, press Esc. The
selected disk drive(s) cannot be used until the erase is complete.

▼ To Stop a Secure Erase in Progress With the
ACU
1. From the main ACU window, select Secure Erase.
2. Select the disk drive being secure erased, and then press Ctrl-Q.
The secure erase stops and the ACU returns to its main window.

Using the Select Utility to Modify
Controller Settings
The ARCU includes a tool for modifying the controller settings, and for modifying
the disk drives connected to it. This utility is called either SerialSelect (SAS) or
SATASelect.
This section contains the following subsections:
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■

“To Start Using the Select Utility” on page 249

■

“To Apply Changes and Exit the Select Utility” on page 249

■

“To Modify General Settings With the Select Utility” on page 249

■

“To Modify SAS-Specific Controller Settings With the Select Utility” on page 251

▼ To Start Using the Select Utility
1. Start the Adaptec RAID Configuration utility (see “To Start the Adaptec RAID
Configuration Utility” on page 244).
The ARCU screen appears.
2. Select the Select utility and press Enter.
The utility might be named SerialSelect or SATASelect.
3. Follow the onscreen instructions to modify the settings of the controller and
connected disk drives, as required.

▼ To Apply Changes and Exit the Select Utility
1. Press Esc until you are prompted to exit.
If you modified any settings, you are prompted to save the changes before you
exit.
2. Select Yes to exit, then press any key to restart your computer.
Any changes you made take effect after the computer restarts.

▼ To Modify General Settings With the Select
Utility
●

Select Controller Configuration from the main Select utility menu and change
the settings listed in the following table.
Some options might not be available.
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Note – Default settings are shown in bold type.

TABLE 20-1
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General Settings

Option

Description

Drive’s Write Cache

When enabled, write cache is enabled on the disk drive. When
disabled, write cache is not used on the disk drive. It is
recommended that you disable write cache on the disk drive.
Caution—When write cache is enabled, there is a slight possibility
of data loss or corruption during a power failure.

Runtime BIOS

When enabled, this allows the controller to act as a bootable
device. Disabling the BIOS allows another controller to act as a
bootable device.

Automatic Failover

When enabled, the controller automatically rebuilds an array
when a failed disk drive is replaced. When disabled, the array
must be rebuilt manually.

Array Background
Consistency Check

When enabled, the controller constantly verifies a redundant
array. Note that there might be a significant performance
reduction. Default is disabled.

BBS (BIOS Boot
Sequence) Support

When enabled in systems that support BBS, the controller is
presented as a bootable device in the BIOS.

Array-Based BBS
Support

When enabled in systems that support BBS, the controller presents
attached bootable devices up to the BIOS for boot device selection.
This is relevant for logical arrays. Default is disabled.

Physical Drives
Display During
POST

When enabled, connected disk drives are displayed during system
Power On Self Test (POST). Displaying the disk drives adds a few
seconds to the overall POST time. Default is disabled.

CD-ROM Boot
Support

When enabled, the system can be booted from a bootable CD.
Note—CDs are not supported by current software.

Removable Media
Devices Boot
Support

When enabled, removable media devices, such as CD drives, are
supported.

Alarm Control

When enabled, the alarm sounds. Default is enabled.
Note—When the alarm is turned off (disabled), it automatically
turns back on after a reboot.

SATA Native
Command Queuing
(NCQ)

When enabled, NCQ is enabled. Disable this feature if you want
to attach more than 48 SATA II disk drives. Available only with
SATA II disk drives.
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▼ To Modify SAS-Specific Controller Settings With
the Select Utility
In addition to the general settings listed in “To Modify General Settings With the
Select Utility” on page 249, some controllers have SAS-specific settings that can be
modified if required.
●

Select PHY Configuration from the SerialSelect main menu and change the
settings listed in the following table.

Note – Default settings are shown in bold type.

TABLE 20-2

SAS-Specific Controller Settings

Option

Description

PHY Rate

The data transfer rate between the controller and devices. The default
setting is Auto, which allows the SAS card to adjust the data transfer rate
as required.

CRC
Checking

When enabled, determines whether the controller verifies the accuracy of
data transfer on the serial bus. Default setting is Yes (enabled). Set to No
(disabled) only if the controller is connected to a device that does not
support CRC Checking.

SAS
Address

In a situation where you want each phy on a controller to be in a different
SAS domain, this setting specifies a unique world-wide name for each phy.
Default is 0.
Note: This setting is for SAS address conflict resolution only and must
otherwise remain at its default value.

Using the Select Utility to Check Battery Status
The Select Utility has the ability to monitor the controller’s battery status.

▼ To Check the Controller Battery Status
●

Select Battery Unit Status from the Select Utility menu.
The utility displays the following information about the status of the battery.
■

Battery Status

■

Battery Temperature

■

Battery Charge %
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■

Estimated Remaining Charge
The estimated remaining charge indicates how long the battery will continue to
operate if the power fails.

Using the Disk Utilities to Manage Disk
Drives
You can use the disk utilities tool to perform low-level formatting, or to verify your
disk drives.

Note – New disk drives are low-level formatted at the factory and do not need to be
low-level formatted again.

Caution – Before you format a disk drive, back up all data. Formatting destroys all
data on a disk drive.
This section contains the following subsections:
■

“To Format or Verify a Disk Drive With the Disk Utilities” on page 252

■

“To Locate Disk Drives With the Disk Utilities” on page 253

■

“To Identify Disk Drives With the Disk Utilities” on page 253

▼ To Format or Verify a Disk Drive With the Disk
Utilities
1. Start the ARCU.
See “To Start the Adaptec RAID Configuration Utility” on page 244.
The ARCU screen appears.
2. On the ARCU screen, select Disk Utilities.
3. Select the disk drive you want, then press Enter.
4. Select Format Disk or Verify Disk Media.
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▼ To Locate Disk Drives With the Disk Utilities
Note – This feature is available only with disk drives that have an activity LED.
You can use the Identify Drive feature to physically locate a disk drive by blinking
the LED.
1. Start the ARCU.
See “To Start the Adaptec RAID Configuration Utility” on page 244.
2. Select Disk Utilities.
3. Select the disk drive you want, then press Enter.
4. Select Identify Drive, then press Enter.
5. When you have finished locating your disk drive, press any key to stop the
blinking.

▼ To Identify Disk Drives With the Disk Utilities
You can identify disk drives by viewing the list of disk drives on your system. Only
physical drives that appear during POST are shown.
1. Start the ARCU.
See “To Start the Adaptec RAID Configuration Utility” on page 244.
2. Select Disk Utilities.
The Disk Utilities view displays the following information:
TABLE 20-3

Information Provided by Disk Utilities

Location

Model

Rev#

Speed

Size

CN1=DEV1
Box0=Slot0
Exp0=phy0

The
manufacturer
information.

The revision
number of the
disk drive.

The speed of
the disk drive.

The size of the
disk drive.
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Viewing the BIOS-Based Event Log
The BIOS-based event log records all firmware events, such as configuration
changes, array creation, and boot activity.
Some events are not stored indefinitely. The event log is cleared of any nonpersistent events each time you restart your computer. Also, when the log is full,
new events overwrite old events.

▼ To View the Event Log
1. Start the BIOS RAID Configuration utility.
See ““Running the Adaptec RAID Configuration Utility” on page 244.
2. Select the controller you want, then press Enter.
The BIOS RAID Configuration utility menu appears.
3. Press Ctrl+P.
4. Select Controller Log Information, then press Enter.
The current event log opens.
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CHAPTER

21

Creating a RAID Array
This chapter describes how to use the ARCU to create a RAID array. You can also
use the procedure in this chapter to create single-drive volumes. A volume, by
definition, consists of a single drive.

Note – On servers equipped with an Adaptec disk controller, all drives must be part
of a volume before they can be used by the BIOS or the OS. Adaptec controllers
support single-drive volumes that can be used for drives that are not part of a RAID
array. This is especially important when you add drives to a system.

▼ To Create a RAID Array
Use the following procedure to create a RAID array.
1. Power-cycle your server.
2. During power up, type Ctrl-A to bring up the ARCU.
A message appears, then the ARCU opens. See FIGURE 21-1.
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FIGURE 21-1

Adaptec RAID Controller Utility (ARCU) Initial View

3. Select Array Configuration Utility.
The Array Configuration Utility appears.
FIGURE 21-2

256

Array Configuration Utility View
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4. Select Initialize Drives.
A list of drives appears.
FIGURE 21-3 shows an example of a system with multiple drives.
FIGURE 21-3

List of Drives

5. Select drives to initialize.
■

Use the arrow keys to scroll through the list.

■

Use the space bar to select a drive.

Note – You can select many drives, and initialize them all at once, even if they are
going to be in different volumes or arrays.
6. When you have selected all the drives to be initialized, press Enter.
A message warns you that initializing a drive erases array information from it.
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7. Type yes.
The utility initializes the selected drives, and the main screen appears.
FIGURE 21-4

Array Configuration Utility View

8. Select Create Array from the main menu.
A list of drives appears, as shown in FIGURE 21-5.
FIGURE 21-5
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List of Drives to Include in Array
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9. Select the drives to be included in the array or volume.
If you are going to create a volume, select the drive to be included in the volume.
If you are going to create an array, select all the drives to be included in the array.
Repeat Step 9 through Step 13 for each subsequent array or volume.
■

Use the arrow keys to scroll through the list.

■

Use the space bar to select a drive.

10. After you make your selections, press Enter.
The Array Properties view appears, as shown in FIGURE 21-6.
FIGURE 21-6

Array Properties View

11. Make the following selections:
■

Array Type – Select an array type from the drop-down list. If you selected a
single drive, the array type will be “volume.”

■

Array Label – Type in a label.

■

Stripe Size – Type in a stripe size.

■

Read Caching – Type Y or N.

■

Write Caching – Select an option from the list.

12. Press Enter or click Done to proceed.
Depending on the Write Caching selection, a number of warnings might appear:
■

If the Write Caching setting is Enable Always, and if you do not have a battery, or
if the battery is not charged sufficiently, several warnings might appear. Type Yes
to proceed, or type No to return to the Array Properties screen.
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■

If the write cache is enabled, a write cache warning appears (FIGURE 21-7).

FIGURE 21-7

Write Cache Warning

13. Click Enter to proceed.
The utility initializes the array.

Note – After making a change to a volume or drive (including hot-plug actions)
while using the BIOS-based Adaptec RAID Configuration Utility (ARCU), a rescan
of the drives is necessary to see the changes. This can be done using the Rescan
Drives option or by simply navigating back to the ARCU main menu.
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PA RT

IV Appendix, Glossary, and Index

This part contains the following:
■

“Selecting the Best RAID Level” on page A-263

■

“Glossary” on page -275

■

“Index” on page -281

APPENDIX

A

Selecting the Best RAID Level
When you create logical drives in the Sun StorageTek RAID Manager software, you
can assign a RAID level to protect your data.
Each RAID level offers a unique combination of performance and redundancy. RAID
levels also vary by the number of disk drives they support.
This chapter provides a comparison of all the RAID levels supported by the Sun
StorageTek RAID Manager software, and provides a basic overview of each to help
you select the best level of protection for your storage system.
The chapter contains the following sections:
■

“Comparing RAID Levels” on page 264

■

“Understanding Drive Segments” on page 264

■

“Nonredundant Logical Drives (RAID 0)” on page 265

■

“RAID 1 Logical Drives” on page 266

■

“RAID 1 Enhanced Logical Drives” on page 266

■

“RAID 10 Logical Drives” on page 267

■

“RAID 5 Logical Drives” on page 268

■

“RAID 5EE Logical Drives” on page 269

■

“RAID 50 Logical Drives” on page 270

■

“RAID 6 Logical Drives” on page 272

■

“RAID 60 Logical Drives” on page 273
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Comparing RAID Levels
Use this table to select the RAID levels that are most appropriate for the logical
drives on your storage space, based on the number of available disk drives and your
requirements for performance and reliability.
TABLE A-1

RAID Levels

RAID Level

Redundancy

Disk Drive Usage

Read
Performance

Write
Performance

Built-in HotSpare

Minimum
Disk Drives

RAID 0

No

100%

QQQ

QQQ

No

2

RAID 1

Yes

50%

QQ

QQ

No

2

RAID 1E

Yes

50%

QQ

QQ

No

3

RAID 10

Yes

50%

QQ

QQ

No

4

RAID 5

Yes

67% – 94%

QQQ

Q

No

3

RAID 5EE

Yes

50% – 88%

QQQ

Q

Yes

4

RAID 50

Yes

67% – 94%

QQQ

Q

No

6

RAID 6

Yes

50% – 88%

QQ

Q

No

4

RAID 60

Yes

50% – 88%

QQ

Q

No

8

Spanned Volume No

100%

QQQ

QQQ

No

2

RAID Volume

50% – 100%

QQQ

QQQ

No

4

No

Disk drive usage, read performance, and write performance depend on the number
of drives in the logical drive. In general, the more drives, the better the performance.
More information about each RAID level is available beginning with “Nonredundant
Logical Drives (RAID 0)” on page 265.

Understanding Drive Segments
A drive segment is a disk drive or portion of a disk drive that is used to create a
logical drive. A disk drive can include both RAID segments (segments that are part of
a logical drive) and available segments. Each segment can be part of only one logical
drive at a time. If a disk drive is not part of any logical drive, the entire disk is an
available segment.
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Nonredundant Logical Drives (RAID 0)
A logical drive with RAID 0 includes two or more disk drives and provides data
striping, where data is distributed evenly across the disk drives in equal-sized
sections. However, RAID 0 arrays do not maintain redundant data, so they offer no
data protection.
Compared to an equal-sized group of independent disks, a RAID 0 array provides
improved I/O performance.
Drive segment size is limited to the size of the smallest disk drive in the logical drive.
For instance, a logical drive with two 250 GB disk drives and two 400 GB disk drives
can create a RAID 0 drive segment of 250 GB, for a total of 1000 GB for the volume,
as shown in this figure.
FIGURE A-1

Nonredundant Logical Drives (RAID 0)
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RAID 1 Logical Drives
A RAID 1 logical drive is built from two disk drives, where one disk drive is a mirror
of the other (the same data is stored on each disk drive). Compared to independent
disk drives, RAID 1 logical drives provide improved performance, with twice the
read rate and an equal write rate of single disks. However, capacity is only 50 percent
of independent disk drives.
If the RAID 1 logical drive is built from different-sized disk drives, drive segment
size is the size of the smaller disk drive, as shown in this figure.
FIGURE A-2

RAID 1 Logical Drives

RAID 1 Enhanced Logical Drives
A RAID 1 Enhanced (RAID 1E) logical drive—also referred to as a striped mirror—is
similar to a RAID 1 logical drive except that data is both mirrored and striped, and
more disk drives can be included. A RAID 1E logical drive can be built from three or
more disk drives.
In this figure, the large bold numbers represent the striped data, and the smaller,
non-bold numbers represent the mirrored data stripes.
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FIGURE A-3

RAID 1 Enhanced Logical Drives

RAID 10 Logical Drives
A RAID 10 logical drive is built from two or more equal-sized RAID 1 logical drives.
Data in a RAID 10 logical drive is both striped and mirrored. Mirroring provides data
protection, and striping improves performance.
Drive segment size is limited to the size of the smallest disk drive in the logical drive.
For instance, a logical drive with two 250 GB disk drives and two 400 GB disk drives
can create two mirrored drive segments of 250 GB, for a total of 500 GB for the logical
drive, as shown in this figure.
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FIGURE A-4

RAID 10 Logical Drives

RAID 5 Logical Drives
A RAID 5 logical drive is built from a minimum of three disk drives, and uses data
striping and parity data to provide redundancy. Parity data provides data protection,
and striping improves performance.
Parity data is an error-correcting redundancy that’s used to re-create data if a disk
drive fails. In RAID 5 logical drives, parity data (represented by Ps in the next figure)
is striped evenly across the disk drives with the stored data.
Drive segment size is limited to the size of the smallest disk drive in the logical drive.
For instance, a logical drive with two 250 GB disk drives and two 400 GB disk drives
can contain 750 GB of stored data and 250 GB of parity data, as shown in this figure.
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FIGURE A-5

RAID 5 Logical Drives

RAID 5EE Logical Drives
A RAID 5EE logical drive—also referred to as a hot space—is similar to a RAID 5
logical drive except that it includes a distributed spare drive and must be built from a
minimum of four disk drives.
Unlike a hot-spare (see “Working With Hot-Spares” on page 83), a distributed spare
is striped evenly across the disk drives with the stored data and parity data, and
cannot be shared with other logical disk drives. A distributed spare improves the
speed at which the logical drive is rebuilt following a disk drive failure.
A RAID 5EE logical drive protects your data and increases read and write speeds.
However, capacity is reduced by two disk drives’ worth of space, which is for parity
data and spare data.
In this example, S represents the distributed spare, P represents the distributed parity
data.

Appendix A

Selecting the Best RAID Level

269

FIGURE A-6

RAID 5EE Logical Drives

RAID 50 Logical Drives
A RAID 50 logical drive is built from at least six disk drives configured as two or
more RAID 5 logical drives, and stripes stored data and parity data across all disk
drives in both RAID 5 logical drives. (For more information, see “RAID 5 Logical
Drives” on page 268.)
The parity data provides data protection, and striping improves performance. RAID
50 logical drives also provide high data transfer speeds.
Drive segment size is limited to the size of the smallest disk drive in the logical drive.
For example, three 250 GB disk drives and three 400 GB disk drives comprise two
equal-sized RAID 5 logical drives with 500 GB of stored data and 250 GB of parity
data. The RAID 50 logical drive can therefore contain 1000 GB (2 x 500 GB) of stored
data and 500 GB of parity data.
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FIGURE A-7

RAID 50 Logical Drives

In this example, P represents the distributed parity data.

RAID 6 Logical Drives
A RAID 6 logical drive—also referred to as dual drive failure protection—is similar to a
RAID 5 logical drive because it uses data striping and parity data to provide
redundancy. However, RAID 6 logical drives include two independent sets of parity
data instead of one. Both sets of parity data are striped separately across all disk
drives in the logical drive.
RAID 6 logical drives provide extra protection for your data because they can recover
from two simultaneous disk drive failures. However, the extra parity calculation
slows performance (compared to RAID 5 logical drives).
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RAID 6 logical drives must be built from at least four disk drives. Maximum stripe
size depends on the number of disk drives in the logical drive.
FIGURE A-8

RAID 6 Logical Drives

RAID 60 Logical Drives
Similar to a RAID 50 logical drive (see “RAID 50 Logical Drives” on page 270), a
RAID 60 logical drive—also referred to as dual drive failure protection— is built from at
least eight disk drives configured as two or more RAID 6 logical drives, and stripes
stored data and two sets of parity data across all disk drives in both RAID 6 logical
drives.
Two sets of parity data provide enhanced data protection, and striping improves
performance. RAID 60 logical drives also provide high data transfer speeds.

272

Sun Intel Adaptec RAID User’s Guide • June 2009

Appendix A

Selecting the Best RAID Level

273

274

Sun Intel Adaptec RAID User’s Guide • June 2009

Glossary

A
agent

available space

Runs in the background on your system, monitoring and managing event
notifications, tasks schedules, and other on-going processes in your storage
space. It requires no user intervention and includes no user interface.
Space on a disk drive that is not being used by a logical drive. When a
logical drive is deleted, its space becomes available.

B
background consistency
check

A HBA function that continually and automatically verifies your logical
drives once they are in use.

C
channel

Any path used for the transfer of data and the control of information
between disk drives and a RAID HBA.

controller

See HBA.

copyback

RAID HBA feature that allows data that has been moved to a hot-spare to
be returned to its original location once the controller detects that the failed
drive has been replaced.
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D
DAS
dual drive failure
protection

Direct-attached Storage. Data storage that is physically connected to a
server.
Another name for a RAID 6 or RAID 60 logical drive.

E
E-mail Notification
Manager

A utility within the Sun StorageTek RAID Manager software that E-mails
event messages to selected recipients.

E-mail notifications

Event messages about remote systems that are E-mailed to selected
recipients.

event

Activity on your storage space, such as a disk drive failure or logical drive
verification.

fault tolerance

The ability of a system to continue to perform its functions even when one
or more disk drives have failed.

firmware

A combination of hardware and software; software written onto read-only
memory (ROM).

F

G
GB
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GigaByte. 1,024 MB.
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H
HBA
host
host bus adapter (HBA)

A hardware device that interprets signals between a host and a disk drive.
Also known as an adapter or card.
A system that’s connected to a TCP/IP network.
An adapter card that includes all of the I/O logic, software, and processing
to manage the transfer of information between the host and the devices it’s
connected to.

hot space

A RAID 5EE logical drive.

hot-spare

A spare disk drive which will automatically replace a failed disk drive in a
logical drive.

hot-swap

Remove and replace a failed disk drive in a logical drive without shutting
down the server or disrupting activity on the logical drive.

I
initialize
I/O

Prepare a disk drive for reading and writing.
Input/Output. Data entering into or being extracted from a system.

L
LAN

Local Area Network. A network of interconnected workstations sharing the
resources of a single server, typically within the area of a small office
building.

LED

Light-Emitting Diode. An electronic device that lights up when powered.

local system

The computer (or system) that you are working on. In the Sun StorageTek
RAID Manager software, ‘local’ and ‘remote’ are relative terms.

logged notifications

Event messages about remote systems that appear in the Event Viewer of the
Sun StorageTek RAID Manager software.

logical drive

One or more disk drives grouped together to appear as a single device to an
OS. Also known as a logical device or array.
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M
managed system
MB
mirroring

A computer (or system) in a storage space that’s being managed by the Sun
StorageTek RAID Manager software.
MegaByte. Depending on context, 1,000,000 or 1,048,576 bytes. Also 1000 KB.
Data protection that duplicates all data from one drive onto a second drive.

N
Notification Manager

A utility within the Sun StorageTek RAID Manager software that broadcasts
event messages to selected managed systems.

P
parity

A form of data protection used by some RAID levels to re-create the data of
a failed disk drive in a logical drive.

partition
Divides the space of a disk drive into isolated sections.
port
A connection point to a disk drive, expander, enclosure, or other device.

R
RAID
rapid fault isolation
rebuild
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Redundant Array of Independent Disks. For more information on RAID and
all supported RAID levels, see “Selecting the Best RAID Level” on page 263.
The trail of yellow or red warning icons that leads from the high-level
system view to the failed or failing component.
Re-create a logical drive after a disk drive failure.
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recurring task
redundancy
remote system

ROM Update wizard

A scheduled task, such as logical drive verification, that occurs on a regular
basis.
The capability of preventing data loss if a disk drive fails.
In the Sun StorageTek RAID Manager software, all other systems in your
storage space besides your local system are remote systems. ‘Local’ and
‘remote’ are relative terms.
A program that updates the BIOS and firmware codes on the HBA.

S
SAN

Storage Area Network. A storage architecture that connects servers and disk
drives across a network for enhanced reliability, scalability, and
performance.

scheduled task

Activity, such as logical drive verification, that is set to be completed at a
specified date and time.

segment

Disk drive space that has been assigned to a logical drive. A segment can
include all or just a portion of a disk drive’s space.

SMTP

Simple Mail Transfer Protocol.

storage space

The HBA(s) and disk drives being managed with the Sun StorageTek RAID
Manager software.

stripe size

Amount of data written to one partition before the HBA moves to the next
partition in a stripe set.

striped mirror
striping

A RAID 1 Enhanced, or RAID 1E, logical drive.
A method of enhancing performance by spreading data evenly over multiple
disk drives. Provides no data protection.

T
Task Manager

TB

A utility in the Sun StorageTek RAID Manager software that allows you to
schedule a specific activity, such as expanding a logical drive, for a time
that’s convenient.
TeraByte. Approximately one million-million bytes, or 1024 GB.
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TCP/IP

Transmission Control Protocol/Internet Protocol. A set of communication
protocols used to connect hosts on the Internet.

V
verify
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Check a logical drive for inconsistent or bad data. May also fix any data
problems or parity errors.

Sun Intel Adaptec RAID User’s Guide • June 2009

Index

A
about
advanced storage space, 5
agent, 3
simple storage space, 4
software, 2
actions menu, 33
agent actions, 120
alarm, 118, 119, 120
email notifications, 110
notifications, 100
alarm actions, 118, 119, 120, 143, 144
change logical device name, 69
clear logs on all controllers, 95
configure read cache, 72
configure write cache, 71
controller-level options, 181
create dedicated hot-spare drive, 85
create snapshot
with backup, 90
without backup, 91
delete dedicated hot-spare drive, 87
delete hot-spare drive, 88
delete logical device, 82
disable email notifications, 114
disable notifications, 105
disable task scheduler, 130
disk drive-level options, 182
email notification manager options, 183
enable (disable) background consistency
check, 76
enclosure-level options, 182
expand or change logical device, 69, 70, 77, 79

initialize, 141
initialize all ready drives, 141
internal RAID branch-level options, 182
log in, 22
log out, 22
logical drive-level options, 182
notification manager options, 183
overview, 33, 180 to 183
remove dedicated hot-spare drive, 87
rescan, 144
save printable configuration, 145
save support archive, 166
send test event, 100
send test message, 110
set drive state to failed, 140
SMTP server settings, 113
system-level options, 181
task manager options, 183
update controller images, 149
verify, 75
verify with fix, 74
ACU
creating arrays, 246
creating bootable arrays, 247
initializing disk drives, 247
managing arrays, 246
rescanning disk drives, 247
secure erasing disk drives, 248
Adaptec RAID Controller Utility (ARCU), 244
Adaptec Storage Manager
operating system support, 8
system requirements, 8
adapters. See controllers

281

ADDLOCAL, 12
administrator permissions, 20
advanced settings, 43, 70
advanced storage space, 5
Agent, 3
introduction, 3
agent, 3
alarm settings, 60
broadcast event alerts, 59
customizing, 58
event log, 59
port number, 61
starting
Linux, 18
Solaris, 19
Windows, 18
alarm
changing settings, 60
controllers
disabling, 144
silencing, 143
testing, 143
disabling, 60
controller-level, 144
enclosure-level, 147
system-level, 118
duration, 60
enabling (system-level), 118
enclosures
disabling, 147
silencing, 147
testing, 146
frequency, 60
systems
disabling, 118
enabling, 118
silencing, 120
testing, 119
testing
controller-level, 143
enclosure-level, 146
system-level, 119
Alarm Control setting, 250
archive file, 165
Array Background Consistency Check setting, 250
Array Configuration Utility. See ACU
Array-based BBS Support setting, 250
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arrays
creating (ACU), 246
creating bootable arrays, 247
managing with ACU, 246
audible alarm. See alarm
Automatic Failover setting, 250
automatic verification, 73

B
background consistency check, 73, 76
background verification, 73
base port number, 61
battery status
check, 251
BBS Support setting, 250
blinking components, 138
boards. See controllers
bootable arrays
creating, 247
broadcasting event alerts, 115
build (initialize method), 72
building storage space, 35 to 50
custom configuration, 39
express configuration, 36
RAID Volumes, 46
buttons
main window, 189 to 192
notification manager, 191
rmail notification manager, 191
task manager, 192

C
cards. See controllers
CD-ROM Boot Support setting, 250
check battery status, 251
clear (initialize method), 72
components
blinking, 138
identifying, 138
viewing properties, 137
configuration event detail window, 94
configure button, 98
configuring, 35
See also building storage space
connectors, 253

continuing to grow storage space, 6
controllers
actions menu, 181
Alarm Control setting, 250
Array Background Consistency Check
setting, 250
Array-based BBS Support setting, 250
Automatic Failover setting, 250
BBS Support setting, 250
blinking, 138
CD-ROM Boot Support setting, 250
disabling alarm, 144
Drive’s Write Cache setting, 250
identifying, 138
modifying general settings, 249
modifying settings with -Select utilities, 248
Physical Drives Display During POST
setting, 250
properties, 137
registering, 142
Removable Media Devices Boot Support
setting, 250
rescanning, 144
Runtime BIOS setting, 250
saving configurations, 145
support by operating system, 49
testing alarm, 143
copyback, 88
CRC Checking setting, 251
create volume, 259
custom configuration, 39

D
daemon, 3
DAS. See internal RAID storage
dedicated hot-spares, 83
creating, 85
deleting, 86
removing, 86
deleting logical drives, 82
devices, 25
blinking, 138
direct-attached storage. See internal RAID storage
disabling alarm
enclosure-level, 147
system-level, 118
disk drive segments, 264

disk drives
actions menu, 182
available space, 27
blinking, 138
capacity, 30
conceptual graphic, 63
different sizes in same logical drive, 66
failed state, 140
failure recovery
multiple disk drives, 162
multiple logical drives, 161
RAID 0 logical drives, 162
with hot spare, 159
without hot-spare, 161
formatting, 252
identifying, 138, 253
initializing, 140, 247
properties, 137
relative capacity, 31
replacing in logical drives, 139
rescanning, 247
secure erasing, 248
segments in logical drives, 67
verifying, 252
viewing logical drives, 29
viewing status, 27
within logical drives, 41
display groups, 54
adding systems, 131
creating, 54
deleting, 135
moving systems, 133
removing systems, 134
renaming display groups, 134
system status, 132
distributed spare drives, 269
Drive’s Write Cache setting, 250

E
email event detail window, 112
email list, 111
modifying users, 111
removing users, 111
sending test emails, 110
email log, 112
clearing, 112
email notification manager, 106 to 114
actions menu, 183
Index
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buttons, 191
clearing the email log, 112
disabling, 114
email list, 111
email log, 112
email notifications, 106
failed test emails, 110
modifying settings, 113
opening, 106
re-enabling, 114
test emails, 110
email notifications, 106
changing "from" address, 113
changing SMTP server, 113
email list, 111
email log, 112
failed test emails, 110
modifying users, 111
removing users, 111
sending test emails, 110
SMTP server settings, 108
email notifications tab, 107
enclosure view, 29
enclosures
actions menu, 182
blinking, 138
disabling alarm, 147
identifying, 138
monitoring, 116
silencing alarm, 147
status icons, 32, 116
testing alarm, 146
enterprise view, 24
display options, 56
icons, 186
internal RAID vs external RAID branches, 179
sorting systems, 56
error (task status), 125
event alerts, 115
event log, 94
clearing, 95
event log (operating system), 59
event notifications, 97
adding systems, 98
event viewer, 97, 180
failed test events, 101
introduction, 97
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logged notifications, 97
modifying systems, 101
notification list, 99
notification log, 103
removing systems, 102
sending test events, 100
sources of events, 97
event viewer, 31
event notifications, 97, 180
logged notification status, 104
logged notifications, 97
sources of events, 97
status icons, 96
events, 31
sources, 97
status icons, 96, 104
events button, 94
executed (task status), 125
executed* (task status), 125
expanding logical drives, 76
express configuration, 36
RAID levels, 36
external RAID storage, 179

F
failed disk drives
multiple disk drives, 162
multiple logical drives, 161
RAID 0 logical drives, 162
without hot-spare, 161
fans status icon, 116
formatting disk drives, 252
formatting logical drives, 39
email notifications
"from" address, 108
full size capacity view, 30

G
getting started, 1
global hot-spares, 83
deleting, 87
guest permissions, 21

H
hard disk, hard disk drive, hard drive. See disk drive
HBAs. See controllers

help, 33
hot spares
distributed spare drives, 269
hot-spares, 27, 83 to ??
creating, 84
creating dedicated, 85
creating pool, 85
dedicated, defined, 83
deleting, 86
global, defined, 83
limitations, 83
removing, 86

I
icons, 186 to 188
enterprise view, 186
logical devices view, 188
physical devices view, 186
ICP Storage Manager
Agent, 3
operating system support, 8
system requirements, 8
identifying components, 138
initialize method, 72
initialize priority, 72
initializing disk drives, 140, 247
installation
Solaris OS, 14
VMWare OS, 15
INSTALLDIR, 12
installing
Linux OS, 13
on the Solaris OS, 14
on the VMWare OS, 15
silent Windows OS, 11
software, 9
Windows OS, 10
installing software, 9 to 15
Linux, 13
Solaris, 14
VMWare, 15
Windows
silent installation, 11
internal RAID storage
actions menu, 182
actions menu introduction, 33
actions menu overview, 180 to 183

comparing to external RAID, 179
introduction
agent, 3
software, 2

J
JBODs. See enclosures
jobs. See tasks

L
Linux
controller support, 49
installing, 13
SNMP support, 155
starting software, 17
starting the agent, 18
Linux OS installation, 13
local systems, 51
log files, clearing, 104, 112
logged notifications. See event notifications
logging in
permission levels, 20
logging out, 21
logical devices view, 27
icons, 188
logical devices. See logical drives
logical drives, 27, 63 to 82
actions menu, 182
advanced settings, 43, 70
automatic verification, 73
available space on disk drives, 66
background consistency check, 73
background verification, 73
building
advanced, 39
basic, 36
changing background task priority, 38
stop building, 38
changing RAID levels, 79
custom configuration, 39
defined, 63
definition, 161
deleting, 82
different-sized disk drives, 66
disabling background consistency check, 76
disk drive segments, 67, 264
distributed spare drives, 269
Index
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enabling background consistency check, 76
expanding, 76
extending partitions, 79
fine-tuning, 69 to 72
formatting, 39
increasing capacity, 76
initialize method, 72
initialize priority, 72
manual verification, 73
maximum size, 76
mirrored data, 266
non-redundant, 265
options for creating, 35
parity, 268
partitioning, 39
RAID 1, 266
RAID 10, 267
RAID 1E, 266
RAID 5, 268
RAID 50, 270
RAID 5EE, 269
RAID 6, 272
RAID 60, 273
RAID level, 28
RAID segments, 264
RAID Volumes, 46
read cache, 71
rebuilding, 160, 164
remove disk drive or segment, 77
renaming, 69
replace disk drive or segment, 77
replacing disk drives, 139
selecting disk drives, 41
selecting RAID levels, 40
setting the size, 65
size, 42
limitations, 45
stripe size, 70
striping data, 265
verifying, 73, 75
verifying and fixing, 74
verifying icon, 75
viewing disk drives, 28
viewing status, 28
write cache setting, 71

M
main window, 23
display options, 58
286

Sun Intel Adaptec RAID User’s Guide • June 2009

overview, 23
Manage, 246
manual verification, 73
mirroring, 266
monitoring
clearing event log, 95
component properties, 137
email notification manager, 106
email notifications, 106
event notifications, 97
full event log, 94
introduction, 93
notification manager, 97
status icons, 96, 104
tasks, 125

N
non-redundant logical drives, 265
notification event detail window, 104
notification list, 99
adding systems, 98
modifying systems, 101
removing systems, 102
sending test events, 100
notification log, 103
clearing, 104
status icons, 104
notification manager, 97 to ??
actions menu, 183
buttons, 191
clearing the log, 104
disabling, 105
event notifications, 97
failed test events, 101
notification list, 99
notification log, 103
opening, 98
re-enabling, 106
test events, 100
notifications, 97 to 115
email notifications, 97, 106
event alerts, 115
event notifications, 97
introduction, 97
notifications tab, 98

O
online help, 33
opening software
Linux, 17
Solaris, 17
opening the software
Windows, 16
operating system event log, 59
operating system support, 8
overview
agent, 3
software, 2

P
parity, 268
partitioning logical drives, 39
partitions, 79
permission levels, 20
Phy Rate setting, 251
physical devices view, 26
icons, 186
Physical Drives Display During POST setting, 250
pool hot-spares, 85
port number, 61
power status icon, 116
properties button, 137

Q
quick (initialize method), 72

R
RAID
distributed spare drives, 269
mirrored data, 266
non-redundant logical drives, 265
parity, 268
RAID 0, 265
RAID 1, 266
RAID 10, 267
RAID 1E, 266
RAID 5, 268
RAID 50, 270
RAID 5EE, 269
RAID 6, 272
stripe size, 71
RAID 60, 273

stripe size, 71
striping data, 265
RAID controller support, 49
RAID levels
changing, 79
custom configuration, 40
express configuration, 36
selecting, 40
RAID segments, 264
RAID Volumes, 46
RaidCfg.log file, 146
read cache, 71
REBOOT, 12
rebuilding (defined), 160, 161
rebuilding logical drives, 164
recurring tasks, 121
registering new controllers, 142
relative size capacity view, 31
remote systems, 51
logging in, 51
removing, 53
startup port number, 53
Removable Media Devices Boot Support
setting, 250
renaming logical drives, 69
rescanning controllers, 144
rescanning disk drives, 247
ROM update wizard, 148
running software
Linux, 17
Solaris, 17
Windows, 16
Runtime BIOS setting, 250

S
SAS Address setting, 251
SAS controllers
CRC Checking setting, 251
modifying with -Select utilities, 251
Phy Rate setting, 251
SAS Address setting, 251
SATASelect, 248
scheduled (task status), 125
scheduling tasks, 121
rescheduling, 128

Index
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supported tasks, 121
changing RAID level, 81
expanding logical drives, 78
modifying logical drives, 70
verifying, 75
verifying with fix, 74
See also tasks
secure erasing disk drives, 248
segments, 64, 264
-Select utilities, 248
opening, 249
-Select utilities
applying changes, 249
exiting, 249
SerialSelect, 248
server module
front panel, 256, 258, 259, 260
silencing alarm
controller-level, 143
enclosure-level, 147
system-level, 120
silent installation, 11
simple storage space, 4
single-drive volume, 259
size limitations for logical drives, 45
size of logical drives, 65
SMTP server settings, 108
snapshots
creating with backup, 90
creating without backup, 91
deleting, 91
limitations, 89
snapshot backup, 89
snapshot nobackup, 89
SNMP support
Linux, 155
Windows, 153
software, 2
actions menu, 33
actions menu overview, 180 to 183
agent port number, 61
display options, 56, 58
icons, 186 to 188
installing, 9
Linux, 13
Solaris, 14
VMWare, 15
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Windows silent installation, 11
logging into remote systems, 53
main window, 23
main window overview, 23
notification manager, 98
remote systems, 51
standard unit of measure, 57
task manager, 123
software versus agent, 179
Solaris
installing software, 14
starting the agent, 19
starting the software, 17
Solaris OS
installing, 14
spares. See hot-spares
stand-alone application, 16
standard unit of measure, 57
starting software
agent only, 17
Linux, 17
Windows, 16
starting the software
Solaris, 17
startup port number, 53
status
components, 137
disk drives, 27, 28
display group systems, 132
enclosures, 32, 116, 188
event viewer, 31
event viewer icons, 96
notification log icons, 104
task events, 125
tasks, 125
view buttons, 29
status icons
enclosures, 116
event viewer, 96
notification log, 104
task manager, 125
storage space, 4
advanced, 5
continuing to grow, 6
examples, 4
growing with the software, 4
simple, 4

stripe size, 70
striping, 265
Sun StorageTek RAID Manager
Agent, 3
introduction, 2
support archive file, 165
system groups. See display groups
system requirements, 8
systems
actions menu, 181
enabling alarm, 118
local systems, 51
properties, 137
remote systems, 51
sorting in enterprise view, 56
testing alarm, 119

T
task event viewer, 125
task list, 125
Task Manager
scheduling tasks
task manager
actions menu, 183
buttons, 192
deleting tasks, 129
disabling, 129
missed start times, 128
modifying tasks, 126
monitoring tasks, 125
opening, 123
re-enabling, 130
supported tasks, 184
task event viewer, 125
task list, 125
Task Scheduler. See Task Manager
tasks
deleting, 129
event status, 125
getting started, 1
growing storage space, 4
missed start times, 128
modifying, 126
monitoring, 125
recurring, 121
scheduling, 121
status, 125

supported tasks, 184
tasks tab, 124
TCP/IP port number (default), 98
temperature status icon, 116
terminology, xxv
test events
email notifications, 110
event notifications, 100
failed email messages, 110
failed event notifications, 101
logged notifications, 100
testing alarm
controller-level, 143
enclosure-level, 146
system-level, 119
text description view, 29
tool bar buttons, 189 to 192

U
user permissions, 20

V
verifying and fixing logical drives, 74
verifying disk drives, 252
verifying logical drives, 73, 75
automatic verification, 73
background verification, 73
icon, 75
manual verification, 73
view buttons, 29
views
enclosures, 29
full size capacity, 30
relative size capacity, 31
text description, 29
VMWare
installing software, 15
VMWare OS installation, 15
volume, 259

W
Windows
controller support, 49
installing
silent installation, 11
installing software

Index
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silent installation, 11
SNMP support, 153
starting the agent, 18
starting the software, 16
Windows OS
installing, 10
write cache, 71
write-back, 71
write-through, 71
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